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1 RigPi Introduction

MFJ-1234D

RigPi™ Station Server v 4.0

RigPi is a product developed by MFJ Enterprises, a

company specializing in amateur radio equipment. RigPi is

a remote control system designed to allow remote

operation and control of amateur radio stations. It consists

of hardware and software components that enable remote

access to your radio equipment from a computer, tablet, or

smart phone.

 The core of RigPi is a Raspberry Pi computer, which acts

as a central control unit. It connects to your radio

equipment and provides a web-based interface for remote

control and monitoring. The software includes features

such as virtual control panels, audio streaming, logging

capabilities, and integration with popular logging and

digital mode software.

 RigPi allows amateur radio operators to operate their

stations from a remote location, enabling them to access

and control their equipment over the internet. This can be

especially useful for operators who want to operate their

stations while away from home or for those who wish to

share their equipment with others.

--chatGPT
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RSS  Block Diagram

Account Controlled Radio Controlled By

Account 1 Radio 1 iPad and iPhone

Account 2 Radio 1 through Account 1 Google Nexus

Account 3 Radio 3 iPhone using CommCat Mobile (now

discontinued)

Account 4 Not used None

RigPi is a Trademark of Howard Nurse, W6HN

1.1 Welcome to RSS

Welcome to RigPi Station Server!

RigPi Station Server (RSS) is an easy-to-use multi-operator, multi-radio (MOMR) amateur radio

control, logging, CW keying, spot management and call lookup system.
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Raspberry Pi 3 B+

Raspberry Pi 4 B

RSS is based on a Raspberry Pi computer running Linux plus RigPi CW Keyer and RigPi Audio

boards. RigPi Keyer uses the popular K1EL WinKeyer chip for keyboard or paddle input. RigPi

Audio is used for Voice-Over IP (VoIP) and remote operations, or for digital modes and I/Q

spectral display (panadapter).

The MFJ-1234 uses the Raspberry Pi 3B+ while the MFJ-1234B/C uses the 4B.  The RigPi 4

image runs on either, but NOT a Raspberry Pi 5.  The Raspberry Pi is a small computer

providing processing, 2-8 GB RAM, four USB ports, Ethernet port, Wi-Fi and Bluetooth. The

RigPi Keyer and RigPi Audio boards are connected through Raspberry Pi GPIO connectors.

MFJ no longer manufactures RigPi although they continue to provide software downloads as

of August 2025. 

 

RigPi's may be available on secondary markets such as QRZ.com and eBay.  

The RSS user interface is browser based. Radio control is through a browser, no other apps are

required for control.  It can be used with any Internet browser including those on Windows,

Mac, Chromebook, Android, iOS and Linux computers, laptops, and phones. You can open RSS
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web pages on several devices at once. Because RSS is multi-radio, one browser can control one

radio and a second browser can control the same or another radio.

Many Windows logging programs can control RigPi using a free Windows program called

RigPi Hub.

One RigPi can connect to a second RigPi through the Internet.  The second RigPi is ideal for

portable use.

RSS radio control uses Hamlib, a library of over 200 radio models and 30 rotors. As new radios

and rotors are added you can update the Hamlib library to keep current.

Other programs are provided with RSS for ham radio and general use. Fldigi and WSJT-X

provide a wide range of digital modes. TQSL prepares and uploads log files to ARRL LoTW.

Additional software can be added to replace programs on a desktop PC, including an email

client, and Office software including word processing, paint, spreadsheet, and database

programs. You can even play games on RSS!

RSS uses open source HTML5, PHP7, jQuery and Ajax, and MySQL (MariaDB). The Tuner

graphics panels: frequency; s-meter; LED display; and tuning knob, were created using

proprietary tools and are provided as closed source under a distribution license. RSS uses

Twitter Bootstrap to create responsive web pages. You can easily view and modify RSS

programs to make changes or add your own features. No specialized software coding tools are

required.

Remote or Local?

When RigPi is used for remote operations, there is a question of which is the remote and which

is the local site.  RigPi uses the convention that the transmitter (home) site is local and the

operator site is remote.

1.2 Quick Start Guide

What is Needed

1. RigPi Station Server (RSS)

a. A Raspberry Pi 3B+ or Raspberry Pi 4B*

b. 5.1-volt, 3-amp Power Supply with a microUSB connector if using a Raspberry Pi 3B+ or

a USB-C connector if using a Raspberry Pi 4B.

c. An Ethernet cable or Wi-Fi Internet connection to your router

https://rigpi.net/downloads.html
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d. Another computer or mobile device on the same network, or

e. A monitor with an HDMI connector for the Raspberry Pi 3B+ or a micro HDMI connector

for a Raspberry Pi 4B.  USB keyboard and USB mouse

f. For remote operations, a browser and Mumble VoIP client on your mobile device

2.   Ham Radio Transceiver

a. CAT connection for computer control

b. CAT USB interface cable (or serial-to-USB adapter)

c. Audio cables for VoIP or digital mode software (or a radio with internal audio CODECs),

CW and PTT keying cables.

*Note: the MFJ-1234 cabinet for the Raspberry Pi 3B+ is not compatible with the Raspberry Pi

4B because of connector locations.

Connecting RSS to the Internet (Ethernet Connection)

The drawings below are for the MFJ-1234 which uses a Raspberry Pi3B+ board.  The MFJ-

1234B/C have a slightly different design to accommodate the connectors on a Raspberry Pi

4B.

1. Connect an Ethernet cable from your router to RigPi Station Server.
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2. Plug in the RSS 5.1-volt power supply. 

The two lights below the RSS KEY jack indicate power (red) and activity (green).

The green light blinks as RigPi boots.  The red light should not blink ecept once

during booting.  If it does, your power supply may be underrated or faulty.

3. On another computer or mobile device connected to the same network, open a

browser window. Navigate to rigpi4.local.

Apple Bonjour is required on Windows computers to find rigpi4.local.  See the

Technical topic in Help for more information on Bonjour.

Without Bonjour, you can use the RigPi IP address instead. Log in to your

router and look at connected devices. You will see the Raspberry Pi listed there

along with its IP address.

4. The RSS Login screen appears after RSS has completed the boot process. (See below.)

Connecting RSS to the Internet (Wi-Fi Connection)

RSS has built-in Wi-Fi if an Ethernet cable isn't convenient.  If you need to connect using Wi-Fi

rather than using an Ethernet connection, a monitor/keyboard/mouse must be connected to

RSS to set it up.

1.  Connect a computer monitor having an HDMI input (micro HDMI input if using a

Raspberry Pi 4B), USB keyboard and USB mouse to RSS.

2. Plug in the RSS 5.1-volt power supply.

The two lights below the RSS KEY jack indicate power (red) and activity (green).

The green light blinks as RigPi boots.  The red light should not blink except

once during boot.  If it does, the power supply may be underrated or faulty.

3. The Raspbian PIXEL Desktop appears after RSS has completed the boot process.

4. In the upper-right corner of the Desktop click the Network icon (Up/Down arrow).

5. Select Turn on Wi-Fi, then click the Network button again.
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6. Select the network you wish to join from the list.

7. In the Pre Shared Key box enter your Wi-Fi password, then click OK.

8. While the Desktop is open, click the Raspberry Menu icon and navigate to

Preferences>Raspberry Pi Configuration>Localization.

9. Enter the Locale, Timezone, Keyboard and Wi-Fi Country for your location.

10. Click the RSS icon (a Pi symbol) to start RSS.  The RSS Login screen appears.

Set Screen Resolution (for VNC connection to desktop)

To change the VNC desktop to a higher or lower resolution, a Screen Configuration program is

provided with Bullseye. Open the Application menu on the desktop and go to

Preferences>Screen Configuration.  In the Configuration window go to Configure-

>Screens>HDMI-1>Resolution and select the resolution you wish to use.  Go to Configure-

>Apply to set the resolution.

Set Screen Resolution (for HDMI connection to desktop)

To set the HDMI resolution on a Raspberry Pi running the Bullseye distribution, follow these

steps:

1. Open the terminal on your Raspberry Pi or connect to it remotely using SSH.

2. Edit the configuration file for the HDMI settings using the following command:

   sudo nano /boot/config.txt

3. Look for the lines related to HDMI settings. Scroll down or use the arrow keys to navigate.

You should see lines starting with `hdmi_group` and `hdmi_mode`.

4. Uncomment the desired `hdmi_group` and `hdmi_mode` lines by removing the '#' character

at the beginning of each line. Refer to the official Raspberry Pi documentation for the available

HDMI modes and their corresponding values.

5. Once you have uncommented the desired lines, save the changes by pressing Ctrl + X, then

Y, and finally Enter to confirm.

6. Reboot the Raspberry Pi for the changes to take effect. You can reboot by running the

following command:

   sudo reboot
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After the reboot, the HDMI resolution should be set according to the values you specified in

the `config.txt` file.

Connecting your Radio

RigPi controls the frequency and mode of your radio through a CAT (Computer Aided Tuning)

connection to a USB port.  Most modern radios provide a USB connection which require a USB

A-B cable.  Older radios have a variety of connection requirements, although each

manufacturer is usually consistent from one radio to another.  Check the manual for your radio

for specifics on what type of cable is required.

Manufacturer Older Model CAT Connection

Kenwood DB9 Serial, requires serial-to-USB adapter

Icom CI-V 3.5mm, requires CI-V-to-USB adapter

Yaesu DB9 Serial, requires serial-to-USB adapter.

Older Yaesu radios also require a level

converter.

 Audio connections to your radio are covered later in this manual.  CW Keying requires either a

cable between the KEY jack on RSS and your radio's keying input (more later), or CAT control.

Accessing RigPi

RigPi 4 is accessed by entering rigpi4.local in a browser's navigation bar.  If your browser can't

find rigpi4.local, it may be necessary to install Bonjour on your computer.  See Bonjour Help

elsewhere in this manual for details.  Alternatively you can use the IP address of RigPi 4 as

found in the list of connected devices in your router.

Exploring RSS, Startup Windows

The RigPi Login screen is shown below. If you have set up a schedule for rig use, additional

information will be shown on the Login window.

179
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1. RSS is shipped with Username 'admin' and no (blank) Password.  

2. Enter admin in the Username box.

3. Press Enter (leaving the Password field blank).

4. The RigPi Express User Settings window appears

RSS Express Settings have two windows designed to get you going rapidly.  Express User

Settings has fields for your Call, location, and optional QRZ XML subscription credentials. You

must enter your call before proceeding.
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Click Fill Below from Callbook to enter your name, state and grid square.  If you haven't

specified QRZ credentials, RigPi uses the onboard FCC database to fill in the information.  This

only works for US calls.
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Express Radio Settings is originally configured with the Hamlib simulated radio, Dummy.  You

can set up your own radio or  continue to use Dummy by skipping the Express Radio Settings.

Note: RigPi uses the default Baud rate for your radio in the Express Radio Settings window.  If

you have  changed the radio's Baud rate you must use that Baud rate in RigPi.  Skip the

Express Radio Settings window and enter the Baud rate in SETTINGS->Advanced Radio.

Back Up Your Memory Card

Memory cards have a limited lifetime, so it is good practice to back up your card as insurance.

 For details on how to make a backup copy please refer to the System topic  in the

Troubleshooting section of Help.

Shutting Down

Never disconnect the RigPi Station Server power supply without shutting down the

RigPi Raspberry Pi first. Disrupting the power before shutting down can corrupt the

microSD memory card.

1. Go to SETTINGS>System.

2. Click the Shutdown button.

232
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3. Wait for the green activity light on the Raspberry Pi to stop blinking.

4. Disconnect the power.

Enjoy RigPi! Additional Help is available

· RSS Toolbar Help

· Online forum: RigPi Forum

· RigPi online help: Online Help

· PDF Help file: Help PDF

1.3 What's New

This topic will contain information about new features as they are added, bug fixes and other

improvements.

4.0 changes 8/1/2025

§ Shortcut keys  added for easier navigation from keyboard

§ Shortcut keys for list control  added to Spot List.

§ Access level 10  for PTT-only control of radio

§ RigPi Lite  mode for low-cpu utilization (remote ops)

§ Calendar/scheduler  for club radio use planning and event display

§ <ip>:<port> can be used to link 2 RigPi's  (CW keying, radios and rotors)

§ Reworked and improved  CW element mode keying

§ Support for CWMorse  USB-to-keying adapter

§ Connect to the Keyer  from a second RigPi

§ Support for K1EL RigPi Keyer (fan control and keyer selection for SO2R)

§ Auto Power On  and/or Auto Power Off (selectable)

§ Latest release versions of Hamlib, WSJT-X, Fldigi

§ Latest Mumble version (1.6)

§ Macros to mute  rig audio on one radio when 2 rigs are being used

§ Macro to switch audio input on Icom radios from Mic to USB

§ New ROTATE macro  that allows setting to a specific bearing (examples in Macro Bank

4)

§ Show present rotor bearing on ROTATE macro buttons

§ Macros to select  the Winkeyer pot or RigPi for CW speed control

74

94

36

78

94

60

220

221

214

111

140

141

137

https://rigpi.groups.io
https://rigpi.net/help
https://rigpi.net/help/RigPi.pdf
https://k1elsystems.com
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§ Option  in Keyer Settings to use Winkeyer speed pot or RigPi for CW speed control

§ Improved PTT delay  function to prevent transmit noise burst

§ Additional Flic  commands

§ Support for TourBox  controller.

§ Easy Mumble audio connections to 2 radios

§ Log fields lengthened to allow for longer data

§ Bullseye Raspberry Pi 32-bit Operating System (requires a Raspberry Pi 4 or 3, will not

run on a Raspberry Pi 5)

§ RigPi 4  License changed to MIT

§ HTTP server moved from Apache to Nginx (Nginx is faster)

§ ADIF Program ID added

§ UFW  (Firewall) added

§ ZeroTier  client added for remote connections without port forwarding

§ Band and Mode buttons  show current settings by highlighting

§ Set passband in TUNE TO dialog  (example in Macro Bank 1)

§ Sub VFO assumes Main mode when entering split or changing modes while in split

§ Status bar shows current passband

§ VFO Buttons are disabled  except when in split mode

§ Cooling Fan  support

§ Grig , a lightweight radio control program added to Ham Radio menu.

§ User Interface improvements and bug fixes

§ Updated RigPi Hub 2.4.1 included with this release

§ Help updates

3.0 changes 11/1/2021 (MFJ-1234C)

· Latest Mumble  client, 1.4 Release Candidate

· New bands added: 1.25m, 70cm, 23cm

· New Modes added: RTTY, RTTY-R, PKTUSB (USB-D)

· Remote character-based CW  (in addition to currently supported element-based,

requires RigPi Hub 2.0.1 for Windows)

· iOS shortcuts  to control RigPi

· "Tune To" macro  for setting frequency, mode and passband

· Set max level for sliders  or disable them

· Assign macros to F-keys  (F1-F12)

· Latching macros  for toggling commands

· Assign colors  to latching macros

· Disable/enable band buttons  in Tuner window

· Continent setting in User Editor now a drop-down

· WSJT-X logged QSO's now properly transfer to RigPi (fix)

· Bank buttons on Tuner window separated, lock button moved

· Macro, Open web page  (such as QRZ.com) to current DX call

126

114

168

77

186

191

69

148

72

165

173

179

214

168

134

133

134

134

134

131

134



21

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

RigPi Introduction

· Macro, Open web page  (such as DXSummit.fi) to current DX call or current

band/mode

· Macro, set CW speed

· Last used macro bank is shown in Tuner and Keyer windows.

· Additional Flic commands : send CW message; send arbitrary radio command; tune to

band; start radio

· Latest amateur radio program updates

· Web view uses map resource  that doesn't require intermediate server

· RigPi Hub updated to support element CW keying

· Added BleachBit as System Utility for cleaning disk

· Select PTT Toggle or PTT Momentary

2.0 changes 10/1/2020 (MFJ-1234B)

· Raspbian Buster operating system, compatible with Raspberry Pi 4 Model B and earlier.

· New settings for hardware, CAT and custom PTT control.

· Tap PTT or space bar to transmit, tap again to receive.

· Auto repeat for Tuning Knob +/- buttons.

· Lock Tuning Knob button.

· "Connect Radio" on Tuner turns on radio (supported radios only).

· Now use long ID name  for devices, better than USB ID for ambiguous connections.

· Remote CW Keyer .

· Delete text using backspace key when in CW HOLD mode.

· Settable PTT delay to remove noise at the beginning of a transmission.

· Macro stacking  (more than one macro in each definition) fixed.

· Save/Restore Macros , Macro sharing.

· Over 27 new radios and numerous fixes added with updated Hamlib 4.0.

· Security improvements, including addition of Fail2ban.

· Auto update Raspbian files.

· Auto expand image to fill SD card.

· Bug fixes when adding more than 3-4 users, rotor control and METER setting for

transmit meter.

· Hardware PTT for WSJT-X when radio requires it to switch audio paths.

· New PTT On and PTT Off macros for controlling a power switch.

· Access level 4 added that prevents transmitting (PTT and Keyer).

· Support for Flic  remote switch (PTT, Power On/Off, Relay control)

· Slave port, using Kenwood CAT commands, for controlling SteppIR antennas, compatible

power amplifiers and Kenwood radios.

· Control the Ameritron RCS-12  Automatic Antenna Switch or other antenna switches

(requires special cable).

· Control 8 on/off devices with macros (requires special cable).

· Control 8 on/off relays  with macros or LED graphics.

· Detailed radio, rotor and RigPi access logging.

134

134

168

99

111

111

214

134

134

168

111

185
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· 128 Macros, 4 banks of 32.

· New easy-access Macro button layout.

· RigPi Video  to watch your radio when operating remotely.

· Support for Contour ShuttleXpress  multimedia controller to control RigPi frequency

and PTT.

· Improved operation with CommCat Mobile  for iOS including direct radio macros.

· Sliders for AF, RF, Power and Mic levels in Tuner and Keyer windows (only for radios that

support changing these levels by CAT).*

· Slider for setting CW speed in Keyer window.

· Additional meter readings for transmit.

· Updated Help.

*If you find your radio is not responding correctly to sliders, analog level reading for that radio may not be fully

implemented.  In addition, some radios only support several fixed levels for a slider rather than a continuous range.  Please

post a note on the RigPi Forum to let us know of any problems you encounter.

1.05 Bug fixes 6/21/2019

· Power On for Elecraft KX3 operates only when that radio is selected for the current

account.

· Adds information  in Help for a new overlay for RigPi Audio to fix several issues.

· Improved security in several modules.

· Addition of Security Topic  to Help

1.04 Bug fixes 6/12/2019

· Split for Icom radios when Split Polling is disabled is now working.

· KEYPAD double entry using smaller iPhones fixed.

· Improvements in TCP connections for RigPi Hub.

1.03 Bug fixes 5/29/2019

· Fixed Power On/Off for some radios that support it.

· Password issues fixed.

· Icom CI-V instructions in Help fixed.

1.02  Bug fixes 5/13/2019

· Disconnect radio from Tuner to permit manual entry of frequencies and mode for new

contacts in Log Editor.

1.01  Bug fixes 5/11/2019

· Log Editor for new contact, TX and RX frequencies are equal when in simplex mode.

175

161

160

206

30
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· Express User Settings, change to Username doesn't require a new login.

· Help updates

1.0  Initial release (MFJ-1234)

1.4 Raspberry Pi Desktop

-

The Raspberry Pi Desktop is similar to many graphics desktops. The Raspberry Menu button on

the left end of the Task Bar is similar to a Windows File menu. Most buttons and icons have a

right-mouse menu for additional options.  You can access the Desktop by connecting an HDMI

monitor to RSS, or by using VNC Viewer to access it from another computer.

The position of the Task Bar can be set to top, bottom, or a.  To change the position (shown at

the top, above), right-click over the Task Bar and select Panel Settings.  In the Panel

Preferences window, select the Edge Position you prefer.

Functio

n

Description

1 Raspberry Applications Menu

2 Terminal Shell access to RSS
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Functio

n

Description

3 File

Explorer

Navigate file system

4 Chromium

Browser

Surf

5 VNC VNC Server, use VNC Client at remote end to interact with desktop

6 Clipboard Raspberry Pi Cut/Paste Clipboard

7 Bluetooth Bluetooth Status

8 Wi-

Fi/Ethernet

Internet Connection

9 Speaker Audio status and output selections

10 Microphon

e

Audio In status and input selections

11 Clock Digital clock showing local time

12 RigPi Lite Start RigPi Lite

13 RigPi Start RigPi in Chromium browser. It is best to connect to RigPi using

an external browser, not the Raspberry Pi browser.  By using an

external browser the limited resources of the Raspberry Pi can be

helped by sharing the load with another computer.

14 Mumble

Superuser

Open Mumble as Superuser to make Mumble changes.  No audio.

15 Mumble Radio 2 Client

16 Mumble Radio 1 Client

17 Trash Deleted files
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Setting up the Raspberry Pi

When you first start RSS you must make changes to the Raspberry Pi to adjust to your needs

and location.  These settings are done through the Applications Menu (1)

>Preferences>Raspberry Pi Configuration menu item.  

The Configuration window has four tabs at the top: System, Interfaces, Performance, and

Localisation (sic).  

In the Display tab, click the Headless Resolution drop-down list. Select the resolution

appropriate for your monitor. Note this affects the screen resolution when the Desktop is

viewed through the VNC interface.

In Localisation settings change: Locale, Timezone, Keyboard and Wi-Fi Country.

Change the font/icon size relative to the screen using the Appearance Settings in the

Preferences menu. Defaults are provided for large, medium and small screens.

Finally, if you want to enable Wi-Fi, click the up/down arrow button (7) on the right side of the

Desktop menu bar.  Left-click, then click Turn On Wi-Fi and follow the instructions.

1.5 Universal Functions

Each RigPi window has functions that are present on all RigPi windows.

Function Where is it Description

RigPi Logo Red "Pi" logo at

left end of the

RigPi Menu bar

Click to open the RigPi web site: https://rigpi.net

RigPi Menu Bar Top of RigPi

window

A menu bar is provided to open RigPi windows.

Several menu items have drop-down lists showing

additional options. The Access Level you set in the

User Editor window determines which menu items

may be hidden.  The SETTINGS menu is shown in

full for ADMIN users, access level 1. Hide the

SETTINGS menu by using a higher access level.

The Users and System options are not shown for

access level 2. The SETTINGS menu is not shown

https://rigpi.net
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Function Where is it Description

at all for access level 3. The Keyer is not shown for

access level 4. Use level 10 for PTT-only.

Callsign Lookup Right end of RigPi

Menu bar

Look up callsigns using the RigPi FCC Database,

or the optional QRZ XML subscription database.

Type a call and press Enter on your keyboard or

click the magnifying glass button, to look up a

call. The focus call is carried from window-to-

window, and restored the next time you start

RigPi. (QRZ XML access requires an Internet

connection and a paid subscription.)

Log Out Right end of RigPi

Menu bar

Log out from the current RigPi account.

Radio Status

Bar

Bottom of RigPi

window

The radio status bar at the bottom of each RigPi

window shows Main frequency, Sub frequency (if

Split is turned on), mode, passband, the current

user and user name, and the current UTC time.

Callsign Lookup

The Callsign Lookup panel shows detailed information for the entered call.  The information

comes from the onboard FCC database, or if enabled with a username and QRZ password,

from the QRZ XML subscription service. At the bottom of the panel you can control your rotor

by clicking Rotate or Stop.  Set up you rotor in SETTINGS>Rotor.  Note RSS comes with the

Hamlib Dummy rotor installed for you.
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Note: The distances and bearings are relative to your location.  If you have not entered your

location accurately in SETTINGS>Accounts->User Editor, the bearings and distances will not be

correct.
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1.6 RSS on Mobile Devices

RigPi can be used on any mobile device that provides an Internet browser. Since RigPi uses a

browser, no app is required (other than Mumble for audio).  Here are several samples of how

the Tuner window appears on mobile devices.

iPad Pro

Single connection to one radio, landscape mode

iPhone
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One connection to RigPi, one radio, Tuner, portrait mode
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One connection to RigPi, one radio, Tuner, landscape mode

1.7 Security

One of the primary uses for RigPi is to allow you to control your station when you are away

from home.  Remote control requires that you open paths through your router to allow

incoming data to establish a connection with RigPi.  Without further safeguards RigPi's

password/account system is open to malicious attack that could render your RigPi useless.

While RigPi is technically capable to operate remotely across public networks like the Internet,

it's design and development to date has been focused on use within trusted private networks

(home and/or VPN.)  

RigPi was tested with the Joval vulnerability scanner and no vulnerabilities were found.

https://jovalcm.com/topics/open-source-oval-scanner/

OpenVPN

A technology called OpenVPN is one way to increase protection since it uses an encrypted key

at both ends of a connection to prevent others who don't have the key from invading your

system.

https://jovalcm.com/topics/open-source-oval-scanner/


31

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

RigPi Introduction

Two links to sites that show simple ways to install OpenVPN on the RigPi server are listed

below:

http://www.pivpn.io/

https://www.youtube.com/watch?v=04EmeXSZo_0

The two approaches are similar, use either one.

Fail2ban

Fail2ban is installed on RigPi to help prevent intrusions.  Fail2ban attempts to alleviate attacks

by providing an automated way of not only identifying possible break-in attempts, but acting

upon them quickly and easily in a user-definable manner.  Please Google Fail2ban for more

details.

The maximum number of failed attempts and the length of time an associated IP is blocked

can be set in Fail2ban.  RigPi allows three failed attempts after which the IP is blocked for one

hour.  When one hour has lapsed the block is removed.  Fail2ban protects five services in RigPi:

RigPi Web access

Mumble

PhpMyadmin

Web bots

SSH access

Real VNC provides its own intrusion protection so it is not necessary to use Fali2ban for this

purpose.

UFW

The UFW firewall is included with RigPi as an added security measure.  It can be enabled or

disabled. See the UFW topic  in Other Programs for further details.

UFW stands for Uncomplicated Firewall. It is a user-friendly command-line tool used to

manage firewall rules on Linux systems. UFW provides a simple interface for configuring and

managing the net filter firewall, which is built into the Linux kernel. It is designed to make the

process of setting up a firewall easier for users who may not be familiar with complex firewall

concepts.

Raspberry Pi Updates

It is critical to keep Raspberry Pi files up-to-date for security reasons.  When vulnerabilities are

present your system can be hacked.  RigPi 4 shows when updates are available on the

Raspberry Pi desktop in the upper right corner.  Click the update icon to start the process.

186

http://www.pivpn.io/
https://www.youtube.com/watch?v=04EmeXSZo_0
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Remote RigPi Without Port Forwarding

RigPi normally requires ports to be opened on your router because that is the only way for

remote browsers to connect to the RigPi server.  RigPi uses a web server for radio control and

a VoIP server for Mumble.  By using a remote server you can forget about opening ports, port

forwarding, and the security downsides to running a server on the Internet.

Real VNC (realvnc.com) provides the VNC software for the Raspberry Pi.  A VNC server is

installed that allows you to use VNC Viewer to access the Raspberry Pi desktop.  Real VNC also

provides a free way to use their server using a Home account limited to 3 computers.  You

must set up an account with Real VNC, but once that is done, you can connect the server on

your Raspberry Pi and any viewers to their server.  To establish the necessary connections

simplified port forwarding with no knowledge of your Internet IP required.

In VNC Viewer you can connect to the Raspberry Pi desktop.  From there you can run RigPi or

any of the digital mode programs.

You can find full instructions for using VNC on the Real VNC web site.

The other server running on RigPi that requires port forwarding is the Mumble server for two-

way audio.  Murmur servers are also available on the Internet for little or no cost.  Rather than

connect to the server on RigPi, by using a remote server you will not need port forwarding.

One popular Mumble server service is Mumble.com.  If you sign up for a 2-year account the

cost is under $4 per month.  There are many other servers available (over 55 in the US alone),

just check the list in Mumble>Public Servers.

ZeroTier (https://zerotier.com) is a secure service that eliminates the need for port forwarding

in your router.  ZeroTier is installed on RigPi.

1.8 Passwords

Using custom passwords is critical to the security of your RSS if you intend to connect to and

control your station through the Internet. There are a number of passwords used in RSS. Here

is a list with the default values and the procedures for changing them.

Name Username Default Password Default

RigPi and RigPi Lite

Login

admin blank (none)

https://realvnc.com
https://mumble.com
https://zerotier.com
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Name Username Default Password Default

VNC pi 7388

Raspberry Pi Login pi 7388

PhpMyAdmin mysql-user 7388

VoIP Server password to

join server

Use your own unique username

for each connection/device

7388

Name How to Change Notes

RigPi and RigPi Lite Login SETTINGS > Accounts >

Edit

Once you enter a password you

can change it but not set it back

to blank. Usernames and

passwords can be any

combination of upper and

lowercase characters but no

spaces are allowed.

VNC VNC > Options > Security Uses the Raspberry Pi

credentials. Use VNC Viewer on

a remote computer to connect

to the RSS Desktop.

Raspberry Pi Login Raspberry Pi

Desktop>Applications

Menu>Preferences>

Raspberry Pi

Configuration > System >

Change Password

The Username can't be changed

in Raspberry Pi Configuration.

PhpMyAdmin PhpMyAdmin> User

accounts > Change

Privileges > Change

Password

PhpMyAdmin is used to access

and edit RSS databases.

VoIP Server password to

join server

From RSS Terminal: sudo

nano /etc/mumble-

The Mumble server runs on the

Raspberry Pi. You can also use
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Name How to Change Notes

server.ini then look

for serverpassword

remote Mumble servers. Users

logging into the server for the

first time must be told this

password.

1.9 Accounts

RigPi accommodates multiple user accounts. Each account must have a

unique username and can control one radio. Accounts can have the same

callsign as other accounts. Two accounts can control two radios. The

maximum number of accounts/radios is limited by the computing

resources of the Raspberry Pi. Tests have shown this limit to be 4 or 5

accounts/radios active at one time.

 

Each account is like a separate logging/control program. Accounts have

the following independent functions:

 

?Log in and Out

?Allow multiple users to access that account

?Personal call sign

?Assigned security level to limit access

?Control a single radio

?Control a single rotor

?Programmable set of macros

?Frequency/mode band memories

?Key CW for the radio for that account

?Maintain a log

?Receive spots from a unique source

?Search call books and display results

?Provide PTT-only access

 

Log In and Out
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The user name and password are entered in the Log In window to access

an RSS account. (Usernames can be any combination of upper and lower

case characters, but no space characters are allowed.) Click the Log Out

button in the top right corner of any RSS window to log out. Once

logged out you can then log back in to the same account or a different

account using the username and password (if any) for that new account.

 

When you create an account a password is not required. This is useful if

you will not be accessing RSS from outside your local network. Once you

create a password for an account you can edit but not remove a

password through the Account Settings window.

 

Access Level Assignment

 

Access levels are assigned for each account.  If you change the Access

Level, RigPi asks if you want to reboot.  Rebooting is recommended.

 

Access Level Access

1 The most permissive, level 1 (admin) accounts can create new and edit

existing accounts and assign a security level, user name and password

for all accounts.  Account 1 is always an Admin account.

2 Account and System Settings menu items in SETTINGS are hidden

3 All settings are hidden

4 Transmission is not allowed. PTT is disabled and the Keyer window is

not available.

10 Provides PTT-only access (intended for VHF/UHF FM radios)

 

 

Allow Multiple Users to Access that Account

 

By sharing the account username and password, multiple users can log in

and use that account. This is useful if you want to access your account

through multiple devices or have multiple RigPi windows open at the

same time. All users signed in to an account control the same radio,
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rotor, CW Keyer and call book database.  (It is also possible to share a

radio from different accounts.)

 

Personal Call Sign

 

Each account has an assigned call sign. The call sign is used in CW Keyer

macros and Telnet Spot access. An account can have the same or

different call sign from that used in other accounts.

 

Control a Single Radio per Account

 

One radio can be controlled in each account. If you have more than one

radio, set up an equal number of accounts, one for each radio. RSS uses

the Hamlib library to provide a wide selection of manufacturers and radio

models. A particular radio may not be fully supported by Hamlib even

though it is listed. See the Technical Help Topic to learn more about

determining what radio features are supported.

 

Each account and external programs can share an account's radio using a

Hamlib radio called NET rigctl. See the Technical Help Topic for

information on sharing radios.

 

PTT Access

 

There are situations where the only radio control required is PTT.  This

access level is handy for simplified operation such as controlling an FM

radio for repeaters.  All other controls and windows are hidden.

 

To set up the hidden controls, change the access level to 1 for that

account.  Set up the radio and PTT options using the Settings windows. 

Once the radio is working as you would like, change the access level to

10.  Log out from RigPi.  When you log back in, the menu will be hidden

and only a PTT button shows.  Some shortcut keys are available.  Press ?

on your keyboard to see a list.
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1.10 Remote Operations: Legal Concerns

You can connect to RigPi from any location where the Internet is available.  Remote operations

are permitted in the United States, but not all countries allow it.  Here is a summary:

US Stations 

· FCC Rules: Part 97.109 Station control …“Any station may be remotely controlled.” 

· FCC Rules Part 97.213 Telecommand of an amateur station:  …has some simple

requirements, including a 3 minute time-out on the transmitter in the event of malfunction. 

US Stations, with Operator outside of US

· Operator must have a US License, bilateral, reciprocal, IARP agreement or CEPT T/R 61-01. 

· The call sign used must always indicate the location of the transmitter.

Stations outside of the US

· Countries have different regulations for whether remote is legal, and whether CEPT T/R 61-

01 is accepted.  

· In general, both the station and the operator must be licensed for that country.

· Confirm that the rules for your country allow for remote operations.
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2 RSS Connections

The Raspberry Pi provides a number of connections. Here is a list:

· USB 2.0 (4), or 2-USB 2.0/2-USB 3.0 for the Raspberry Pi 4.

· Gigabit Ethernet

· 802.11ac/n wireless LAN (2.4 and 5 GHz Wi-Fi)

· Bluetooth 4.2 Bluetooth Low Energy (BLE)

· HDMI (micro HDMI for Raspberry Pi 4B) video/audio

· 3.5 mm audio out

· Micro USB (USB-C for Raspberry Pi 4B) power

The RigPi Audio and RigPi Keyer have their own connections described in the following topics.

 The drawings below are for the original RigPi.  The RigPi 2 Keyer by Steve, K1EL, and later

have a modified design to accommodate connector positions.
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2.1 Radio Control

RigPi controls each radio through one of the four USB connectors on the Raspberry Pi.  If your

radio has a classic serial port, a serial-to-USB adapter is required.  Older Icom radios provide

CAT through a CI-V system.  A CI-V to USB adapter is required.  Most newer radios use a USB

connection for CAT control so no adapter is needed.

If you are using ADMIN as your callsign (default when starting RigPi for the first time), use the

Express Radio Settings window to configure the radio connection. Normally you will use

SETTINGS>Radio>Basic or SETTINGS>Radio>Advanced.  Advanced settings may be necessary

if you have changed any of the default settings on your radio.

In Basic settings, select the Manufacturer, Model and Port from the drop-down menu lists.   If

the radio USB cable is the only one plugged in, the port will usually be /dev/ttyUSB0.  You will

also see the long name starting with /dev/serial/by-id...  Select the long name, then click the

Connect Radio button.
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If the radio doesn't connect, please see the Radio>Advanced topic in the Settings section of

this Help for troubleshooting support.

Power On/Off

Most radios can be powered on and off by means of CAT commands.  Use the PWR ON/PWR

OFF macros to turn your radio on and off.  The power on cycle can take up to 40 seconds for

some radios.  RigPi can turn the radio on and/or off automatically by using the options in

Advanced Settings->Pwr Ctrl.

Connecting to a Radio through a TCP port

It is possible to connect to a radio that supports TCP through an Internet connection rather

than through a USB port.  For example, your radio may accept an Ethernet connection for CAT

control, or you may be using a serial-to-Ethernet or serial-to-Wi-Fi adapter.

For an Ethernet connection, enter the IP and port in the Port box in Radio Settings.  If I had a

radio connected to 192.168.1.80, port 30073, type the following in the Port box:

192.168.1.80:30073

You must type this information into the box, it does not appear in the drop-down list for Port

options.  When you save the Radio settings, the <IP>:<Port> value is saved.

2.2 Rotor Control

Important

RigPi uses your location and the location of a remote station to predict

the correct bearing.  You must enter your location's latitude and longitude

in SETTINGS>Accounts>Account Editor for this to work.

RSS controls each rotor through one of the four USB connectors.  If your rotor controller has a

classic serial port, a serial-to-USB adapter is required.

Use SETTINGS>Rotor to configure your rotor.

In Rotor settings, select the Manufacturer, Model and Port from the drop-down menu lists.   If

the rotor USB cable is the only one plugged in, the port will usually be /dev/ttyUSB0 plus a

long name for the same port.  Save the new settings and restart the Radio connection.  The

Rotor is initialized with the radio at the same time.



43

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

RSS Connections

For rotors that connect via a USB cable, the long name for the connection may appear in the

port drop down list.  Select the long name to provide persistence after a reboot.

2.3 RigPi Audio

Audio to and from your radio is used for two-way audio (VoIP) for remote operation or for

digital mode programs.  Audio can be routed through the RigPi Audio board, an external USB

audio soundcard, or through audio CODECs in many newer radios.

The default audio device for RigPi is selected from the device list shown by right-clicking the

speaker icon on the Raspberry PI desktop.  The RigPi Audio board uses the device named

snd_rpi_proto, while most radio CODECs are designated as USB Audio CODEC.  Choose the

one you want to use.

The instructions below assume you will be using the RigPi Audio board and not an external

CODEC. Instructions for using CODECs are provided later in this manual.

RigPi Audio can be used with VoIP or digital mode and spectrum analyzer programs. RigPi

Audio is connected to RSS through the Raspberry Pi GPIO header, it does not connect via USB.

Right-click the Speaker icon on the top right end of the RSS Desktop menu bar to confirm that

the RigPi Audio driver, snd_rpi_proto, is listed and selected. See the Alsamixer Help Topic if you

need to troubleshoot.

If you are using an early RigPi and see an entry for audioinjector-pi-soundcard you will need to

follow a simple procedure to manually update RigPi.  The instructions for making the change

are in the RigPi Audio Update topic, Technical section, of this Help..

RX IN

Connect the audio out from your radio to the RX IN 3.5mm jack. The tip and sleeve

connections are isolated through a transformer to reduce hum.

RX IN can be set up to provide a line or microphone input. The default is line input with a

maximum of 2-volts peak-to-peak. To accommodate lower level audio sources, the RX IN
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input can be switched to a microphone level input. This is done using a program called

Alsamixer. See the Alsamixer topic in Other Programs to learn how to use Alsamixer.

TX OUT

Connect TX OUT to your radio audio input. The tip and sleeve connections are isolated

through a transformer to reduce hum. The TX OUT ring connection has several purposes.

Normally it is used to control the PTT connection on your transmitter. 

The easiest way to connect audio to a radio is through a rsadio's rear-panel accessory (Data)

input jack. Most radios that provide this connection also require PTT at that jack to switch

audio input from the front-panel microphone jack to the accessory jack. The PTT connection

on the ring of the TX OUT connector can be used for this purpose.

I/Q IN

The I/Q input connection provides a way to connect the IQ signal from many radios such as

SDR and the Elecraft KX3 to perform spectral analysis. Similar to "Panadapters" that were used

years ago, an I/Q display shows a graph of signal level vs frequency over a wide bandwidth.

The bandwidth in RSS is limited to 96 kHz as determined by the sampling rate of the audio

chip used on the RigPi Audio board.

The I/Q input uses the left and right stereo inputs to the audio chip. The signals are not

transformer isolated. Use Alsamixer to make sure RigPi Audio is in the Line Input mode.

RigPi Audio with Mumble VoIP

Mumble provides 2-way audio between your radio and a remote device, such as an iPhone or

Android mobile phone.  A Mumble server (named Murmur) is installed on RSS and always runs

in the background.  Mumble clients connect to Murmur for passing audio.  One Mumble client

is installed on RSS and is normally started on the Raspberry Pi desktop when RSS boots. 

Mumble clients on other devices connect to the same Murmur server where input and output

audio is heard by all connected clients.

The Mumble client in RSS connects to your radio.  Receive audio is fed to the Mumble client

input and Mumble client output is fed to the radio mic input.  The radio audio is provided to

and from Mumble through the RigPi Audio board or a CODEC built in to the radio.  If your

radio has a built in CODEC for audio, the RigPi Audio board is not used.  In this case, audio to

and from the radio is carried over the USB CAT control cable.

Setting up the MFJ RigPi Audio Board for VoIP
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RigPi Audio can accept audio through a microphone or line input source.  If your radio has

high output level (no more than 2-volts peak-to-peak) you should use the line input.  If your

radio audio output is low (no more than 200-mV peak-to-peak), use the microphone input.

RSS initially uses the microphone audio input. If you want to use line input, the input selection

is made through a program called Alsamixer.

Use the RX IN connector for audio from the radio and TX OUT for audio to the radio.  The

cable connects to the RJ-45 connector on the USB/Ethernet end of the RSS cabinet.  The left

channel is used for input and output audio.  These connections are transformer-isolated.  If

you are using an RJ-45 cable, you must also use a jumper header in RigPi to complete the

connections.  MFJ cables come with a prewired header for the radio you have specified.  A

jumper header is installed on the RJ-45 daughter board, as shown below.

RigPi Audio does not have any onboard adjustments.  RigPi Audio levels can be set through a

program called Alsamixer or from the desktop icons for speaker and microphone.

Start Alsamixer from the Terminal window on RSS Desktop.  Open Terminal and type:

alsamixer<return>

Here is the alsamixer view for the RigPi Audio board:
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...and for a CODEC:

Note the following Alsamixer controls:

Use left/right arrow keys to move between settings

Playback options (F3)

1. Card: snd_rpi_proto (RigPi Audio), use F6 to select



47

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

RSS Connections

2. Master gain set high, use up and down arrow keys to adjust

3. Mic Boost set high, use up and down arrow keys to adjust

4. ADC High Pass On, use M key to toggle

5. Input Mux Mic, use up/down arrow keys to adjust

6. Output Mixer On (OO, use M key to toggle

Capture options (F4)

1. Line [Off, Off], use Space bar to toggle

2. Mic On, use Space bar to toggle

3. Mic Boost (high), up/down arrow keys adjust

4. Capture (high), up/down arrow keys adjust

Setting up CODEC audio for VoIP

Please see the Mumble topic  for details on using radio CODECs for audio.

Mumble Clients

On Windows, Macintosh and iOS, use the client named Mumble.  One client for Android

devices is named Plumble.  They all operate in the same way.  Start Mumble (or Plumble) and

open the Favorite Servers settings.  Click the + button to add a new Favorite.

Complete the Description, Address, Port, Username and Password settings.  The Address holds

the IP for the Murmur server, the Port defaults to 64738, Username can be your call, and

password 7388 (unless you have changed it).  The Username MUST be unique.  If you have a

tablet and phone, both running Mumble, one can use <your call> as Username and the other

must use something like <your call>-1.  You can also use phone as a username and tablet as

the second username.

Radio Quirks

Most radios provide audio connections that are straightforward.  Some radios, notably

Kenwood models, provide audio connections through a Data connection on the rear panel. 

You will find many more details on the RigPi forum.  Use the Search function to look for

information in Topics.  There are also a number of documents in the Files section that deal with

specific radio connections and setups.

Kenwood radios with a Data connector

Since the radio normally expects audio to come through the microphone connector, a

switch signal must be provided to the Data connector.  The switch signal is normally PTT.

179
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 This means that you must make three connections if you are using the rear panel Data

connector: audio in, audio out, and PTT.

Yaesu (HF models)

Some Yaesu radios only pass audio when in digital/PSK mode, such as the last

generation of HF radios (FT-817(ND), FT-818ND, FT-857(D), FT-897(D)).  For full

functionality, a microphone interface is needed.

Audio routing determined by menu settings

It may be necessary to change menu settings in your radio to provide an audio path

through a rear panel connector.  Some radios, such as the Yaesu FT-950, only allow

transmit audio to pass through the Data connector using the PSK mode.

Mumble Settings

See the Mumble topic in Other Programs for the necessary settings.

2.4 RigPi Keyer

RigPi Keyer is a versatile Morse code generator based on the popular K1EL WinKeyer3 IC. It

connects to the Raspberry Pi through the GPIO header and uses the onboard serial port, ttyS0.

 The image below shows the MFJ RigPi connector configuration.  See also the K1EL RigPi

Keyer  topic.

Keyer Connections

Connection Use Note

PTT Pull-down

when in

transmit

Can be

reconfigured

as a general

50
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purpose

switch.

PADDLE Connect a

paddle to

control the

keyer using

tip, ring and

ground

You can also

use a straight

key connected

between tip

and ground.

KEY Connect to

you

transmitter

keying input.

RigPi Keyer can be used with a paddle or straight key plugged into the PADDLE jack with or

without a radio connected.  The KEYER SPEED control works when the keyer is not under RigPi

control and when using any of the main RigPi windows.

RigPi Keyer has a PTT switching circuit that normally follows PTT commands from RigPi.  You

can also use the WinKeyer3 PTT circuit independently through commands. Independent

control means that you can use the RigPi Keyer PTT for remote control purposes, such as

controlling a power switch. See the Technical RigPi Keyer PTT topic of Help to learn more

about extended uses of RigPi Keyer PTT.

Settings

The RigPi Keyer settings are located in SETTINGS>Keyer. Morse can be sent by typing on a

keyboard, through a custom Macro, or by means of a keying paddle. It is possible to use a

straight key as well as a paddle.

If you are using an external Winkeyer, when RigPi boots the keyer is in the command mode the

memory buttons play back any recorded messages.  After starting RigPi (and thus initializing

the Winkeyer) the Winkeyer is in the Host mode and the memory buttons do not operate.

The WinKeyer3 IC has an extensive set of programming commands, many of which are used in

RigPi. You can also create Macros using these commands for special purposes.

Remote Keying

When away from home you can use your favorite hand key to send CW via your home station.

 A second RigPi, external Winkeyer/Raspberry Pi, or RigPi Hub with a Windows program that
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can key RTS or DTR is required.  RigPi does not have to have an Audio board.  You can use a

paddle, bug, or straight key.  Please see the RigPi Remote Keyer topic  for details.

2.5 K1EL RigPi Keyer and Box

The K1EL RigPi Keyer is software-compatible with the MFJ Keyer board, but is physically

different. The K1EL RigPi Keyer board supports a fan for cooling.  The enclosure has cutouts for

the fan.  It also supports SO2R (single-operator, two-radio) keying which is controlled by RigPi.

Steve has created a new RigPi enclosure which you can 3-D print.  Many local libraries provide

this service.  The K1EL RigPi Keyer schematics and files for printing can be found at the K1EL

web site:  

k1elsystems.com

The K1EL enclosure does not support the MFJ audio board.  You can use CODECs in your radio

(if available) or an external USB dongle for audio.

214

https://www.k1elsystems.com
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The schematics for the K1EL RigPi Keyer board are included below:
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2.6 Internet Connections

RSS is designed to operate without Internet access. This feature makes it convenient when

taking RSS away from your home for portable or mobile operation. Several non-critical

features that do rely on Internet access are listed below:

1. QRZ XML Call look up service (Callbook)

2. World map (Web)

3. Update FCC Database (System settings)

4. Spots (Spots and Spots settings)

5. LoTW downloads and submissions

6. Time updating

Even if you do not have an Internet connection you can use RSS WI-Fi to connect to other

computers. It is easy to set up an ad hoc network so other computers or mobile devices can

communicate. Wi-Fi can also be used in lieu of an Ethernet cable to connect to a router.

Here is a link to several messages on Stack Exchange that give instructions for setting up Wi-Fi

ad hoc networks on the Raspberry Pi and for making the Raspberry Pi IP static so it doesn't

change when you reboot.
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Click to see Static Instructions

2.7 Remote Connections

Internet Access to your Raspberry Pi

Port Forwarding

The following instructions apply to a Netgear R8500 Router. The steps for your router will be

different.

Netgear routers do port forwarding by assigning port numbers to a "service" that is associated

with the application you want to run.

To open the ports for RSS:

1. Type the router's address in an Internet browser's address bar. (By default the router's

address is 192.168.0.1 or 192.168.1.1). The Setup Wizard appears

2. Enter the router's username and password

3. Under Advanced, click Advanced Setup, then Port Forwarding on the left menu bar (varies

slightly by Router)

A Port Forwarding Screen appears 

4. Click Add Custom Service. The Custom Services window opens

5. Enter RSS for the service name

6. Select TCP in the Service Type drop-down

7. Enter 7488 in the External Starting Port box

8. Enter 7488 in the External Ending Port box

9. Remove the check for Use the same port range for Internal Port

10. Enter 80 in Internal Starting Port

11. Enter 80 in Internal Ending Port

12. Enter the LAN IP for RSS in the Internal IP address

13. Click Apply

14. To add Port Forwarding for Mumble, click Add Custom Service and follow the same

steps

15. Use Mumble for the name. TCP/UDP for the type and 64638 in the External Port boxes

16. Enter 64738 in the Internal Port boxes

17. Enter the LAN IP for RSS in the Internal IP address

18. Click Apply

19.To add remote VNC viewer access to open RSS Desktop, click Add Custom Service and

follow the same steps

20.Use VNC for the name. TCP for the type and 5900 in the External Port boxes

https://raspberrypi.stackexchange.com/questions/37920/how-do-i-set-up-networking-wifi-static-ip-address/37921#37921
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21.Enter 5900 in the Internal Port boxes

22.Enter the LAN IP for RSS in the Internal IP address

23.Click apply

24.To add access to the RigPi Video Camera, click Add Custom Service and follow the same

steps

25.Use VideoCamera for the name. TCP for the type and 8081 in the External Port boxes

26.Enter 8081 in the Internal Port boxes

27.Enter the LAN IP for RSS in the Internal IP Address

28.Click Apply

29. Click Logout to exit from router settings

With RSS running, open canyouseeme.org with your browser and confirm that ports

5900, 7488, 8081 and 64638 are open.

To connect to RSS using a browser when away from home, enter the WAN IP (from

SETTINGS>System) followed by a colon and 7488:

97.222.46.198:7488

The WAN IP above is fictitious, use your own. Now you can log in and control your

radio from anywhere Internet access is available.

To connect Mumble on your remote client, open the Edit window for the rigpi server

connection and change the port to 64638.

Important Port Forwarding Note

Some Internet Service Providers supply a Modem that contains a single-port router. If you use

an external router with such a device, port forwarding will not work without extra settings.

Here is an article on the web that explains the 2-router problem. If port forwarding doesn't

appear to work for you, please read this a

Click to Go to PortForwarding.com

Note: Port Forward is an excellent resource for help if you run into trouble with port

forwarding. They also sell programs to aid with the process. Most port forwarding issues can

be solved without the need for other programs.

ZeroTier

ZeroTier is a software-defined networking (SDN) solution that allows you to create and

manage virtual private networks (VPNs) easily. It enables devices across the internet to

https://portforward.com/help/doublerouterportforwarding.htm
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communicate securely as if they were on the same local network. By using ZeroTier you do not

need to set up Port Forwarding through your router. ZeroTier is installed on RigPPi.

Here’s a more detailed overview of what ZeroTier is and its key features:

· Key Features of ZeroTier

1. Peer-to-Peer Networking: ZeroTier creates direct peer-to-peer connections between

devices, reducing latency and improving performance compared to traditional VPN

solutions that route all traffic through a central server.

2. Cross-Platform Support: ZeroTier runs on a wide range of operating systems, including

Windows, macOS, Linux, iOS, Android, and various embedded systems like Raspberry Pi.

3. Ease of Use: Setting up a ZeroTier network is straightforward. You can create and join

networks with just a few commands or clicks, and management is done through a web-

based interface called ZeroTier Central.

4. Security: ZeroTier uses end-to-end encryption to secure all data transmitted between

devices on the network. This ensures privacy and security, even over untrusted networks like

the internet.

5. Flexibility: You can configure ZeroTier networks to behave like traditional LANs, with

support for custom IP addressing, multicast, and broadcast traffic. This makes it suitable for

a wide range of use cases, from simple remote access to complex network topologies.

6. Scalability: ZeroTier networks can scale from small personal networks to large enterprise

deployments. The system is designed to handle a large number of nodes with minimal

configuration effort.

7. Open Source: The core of ZeroTier is open source, which means you can review the code,

contribute to its development, and even deploy your own ZeroTier controllers if desired.

· How ZeroTier Works

1. Network Creation: You create a network in the ZeroTier Central web interface. This network

gets a unique network ID.

2. Joining a Network: Devices (nodes) join the network using the ZeroTier client software and

the network ID. Once a node joins, it appears in the ZeroTier Central interface.
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3. Authorization: Each new node must be authorized in the ZeroTier Central interface before it

can fully participate in the network. This step ensures that only approved devices can

connect.

4. Communication: Once authorized, nodes establish direct peer-to-peer connections with

each other, and all traffic between them is encrypted.

5. Management: Network settings, such as IP address assignments, access rules, and routing

policies, are managed through ZeroTier Central.

Setting up ZeroTier on a Raspberry Pi is a straightforward process that allows you to create a

virtual network for secure, private connections over the internet. Here’s a step-by-step guide

to get you started:

·  Prerequisites

1. A Raspberry Pi running a recent version (Bullseye) of Raspberry Pi OS

2. An internet connection

3. A ZeroTier account (you can create one for free on the ZeroTier website: 

https://www.zerotier.com/

· The ZeroTier client is already installed on RigPi 4

· Join a ZeroTier Network**

Replace `<network_id>` with your actual ZeroTier network ID using Terminal:

 

  sudo zerotier-cli join <network_id>

· Authorize the Device

Go to the ZeroTier Central (https://my.zerotier.com/) web console, log in with your ZeroTier

account, and find your network. You should see your Raspberry Pi listed as a member with a

unique ID. You need to authorize this device by checking the box next to its entry.

· Verify the Connection

   To check if your Raspberry Pi is connected to the ZeroTier network, run:

   sudo zerotier-cli listnetworks

 

   You should see your network listed with a status indicating it is `OK`.

· Additional Tips

https://www.zerotier.com/
https://my.zerotier.com/
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Persistent Network Configuration: Ensure your ZeroTier service starts on boot by enabling

the service:

sudo systemctl enable zerotier-one

· Firewall and Security: Ensure that your Raspberry Pi’s firewall allows ZeroTier traffic. If using

`ufw` (Uncomplicated Firewall), you can allow ZeroTier traffic with:

sudo ufw allow 9993/udp

· Check ZeroTier Status: To check the status of ZeroTier service:

sudo systemctl status zerotier-one

· Troubleshooting: If you encounter any issues, check the ZeroTier logs for clues:

sudo journalctl -u zerotier-one

 

By following these steps, your Raspberry Pi should be successfully connected to your ZeroTier

network, allowing you to securely access it from anywhere as if it were on a local network.

Remote RigPi Clients

RSS can be accessed from anywhere via the Internet. Access is made available through RSS and

router settings. All user accounts should be password protected before you allow any access.

RigPi provides 4 ways for remote access. 

1. Browser: Any browser (desktop, phone, tablet) can be used to access RigPi from a remote

location. Audio is provided through a separate Mumble Clients running at the RSS station

and remote locations.

2. RealVNC: This option provides access to the Raspberry Pi desktop.  You can use the desktop

browser to control your radio.  

3. RigPi Hub on a Windows computer: The Hub connects to RigPi using port 30001.  With

RigPi Hub you can use your favorite logging program to control RigPi.

4. Link another RigPi: Use a second RigPi at the remote location to connect to your home

RigPi.

All connection options require port forwarding unless you are using ZeroTier. Up to six ports

must be opened: 1) browser; 2) audio VoIP; 3) VNC viewer 4) Video Camera (optional); 5) RigPi

Hub/Linked RigPi port; 6) Remote CW.  By using a service such as ZeroTier, it is not necessary

to open any ports on your router. ZeroTier  is installed on RigPi but must be configured.191
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Service Normal Port Protocol

RSS Browser access 80 TCP

Mumble (VoIP) 64738 TCP/UDP

VNC 5900 TCP

Video Camera 8081 TCP

Remote CW 30040 UDP

Browsers, by default, connect to port 80 on a server. This access port must not be blocked by a

router or firewall. Your router's advanced settings provides a way to forward connections from

the outside to a specific LAN IP and port.  Firewall configuration is avaialble through the

operating system settings.

The LAN IP for RSS can be found on the System settings page (SETTINGS>System). It will be an

address like 192.168.1.20. The RSS browser, Mumble, VNC and Video Camera ports must be

able to transverse your router to get to these ports, otherwise they are blocked. This is called

Port Forwarding.

Many routers provide a way to translate an incoming port to a different port. This translation

provides a slightly higher level of security than simply forwarding port 80. Set the External

Starting and Ending port to something like 7488. Set the Internal Starting and Ending ports to

80. Your router will now accept an incoming connection on port 7488 and forward it to port

80 on rigpi4.local. When away from home you would instruct your browser to connect to port

7488. If your router does not provide port translation, open port 80 instead and you will

connect to the default browser port, 80.

The default Mumble port is 64738. This port must be forwarded through your router. You can

use the same translation trick as with browser connections, but you must also tell the mumble

client which port to use if not the default.  Mumble data are encrypted.

VNC Viewer gives you access to the RSS Desktop from any device.  VNC Viewer clients are

available for most operating systems and devices.  To use VNC Viewer from a remote location

you must forward the port used by VNC.  The default port for VNC viewer is 5900.

Password Protection

Since RSS is now open to the Internet, add passwords to all accounts before proceeding.

RigPi Remote Linked Connections
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Use the Link capabilities of RigPi to connect a second RigPi or another program such as WSJT-

X to your Home RigPi.

Rather than using a remote computer or device to connect to (Home) RigPi, you can use a

second (Remote) RigPi.  Set up Home to control your radio, rotor and keyer.  Set up Remote

using the Home IP and Port in the Remote->Advanced Radio->R Port and Remote->Keyer-

>Port boxes. Use the Hamlib Home->Advanced Settings->Manuf and Net rigctl in Model.  For

Rotor, use Hamlib for Home->Rotor->Manuf and Net rotctl Rotor in Remote.  

if Remote is using the same LAN as Remote, the Home IP  is found in Home->System

Settings->LAN IP 1.  If connecting from another location, use Home->System Settings->WAN

IP.  Use Home->System Settings->Rigctl Port for the Remote port.  Use the same IP and Port

+ 1 in Rotor Settings.

If Remote is at another location, you must forward the port you are using at home.  For

example, if you are using Account 1, the radio control port is 4532.  Port 4532 must be

forwarded through your Home router.  If you want to use audio, the Mumble port must be

forwarded, as well as the VNC port if desired.  It is not necessary to forward port 80 in your

Home router if you are using a Remote RigPi using port 4532.

Same Network

Remote RigPi

My Living Room
—LAN—

Home RigPi

My Shack

Separate Networks

Remote RigPi

My Vacation Home
—Internet—

Home RigPi

My Shack

Connection Home

RigPi

Remote RigPi

on same LAN

network

Remote

RigPi on

separate

network

Notes

Radio Control

Port

USB to

radio

<Home LAN ip>:80 <WAN ip>:80 Browsers can connect

using port 80 or WAN

<ip>* to any RigPi. Port

80 must be forwarded in

your Home router when

accessing RigPi from a

remote location.
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Connection Home

RigPi

Remote RigPi

on same LAN

network

Remote

RigPi on

separate

network

Notes

Remote RigPi USB to

Radio

<Home LAN

ip>:4532

<WAN ip>:4532 Connect a Remote RigPi

direct, not through a

browser. Port 4532 must

be forwarded in your

router.

RigPi Keyer /dev/ttyS0 <Home LAN

ip>:3000<n>

<WAN

ip>:3000<n>

<n> is the account

number for the Home

RigPi.  If your radio is

connected to the first

account, use <LAN

ip>:30001 or <WAN

ip>:30001. The port

must be forwarded.

RigPi CAT CW

Keyer

Select CAT

plus

<port>

Select CAT plus

<Home LAN

ip>:<port>

Select CAT plus

<WAN

ip>:<port>

<port> is the radio

control port for Home. 

Your radio must support

CW keying via CAT.

<port> must be

forwarded.

RigPi Rotor USB to

rotor

<Home LAN

ip>:<n>

<WAN ip>:<n> The rotor control port

<n> is always the radio

4531 + 2 * account

number. This port must

be forwarded.

Mumble rigpi4.local rigpi4.local <ip>

i.e.,

207.55.33.22

<ip> = IP address of

Home WAN* on port

64738. This port must be

forwarded.

*Port Forwarding in your Router is required for WAN <port>

For further trouble-shooting help, see here .

2.8 Using a Dynamic DNS Service

Your Internet IP can change from time-to-time, especially if you reboot your Internet modem.

If you are away when this happens, you won't be able to access RSS remotely until you know

242
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the new WAN IP. One way to solve this problem is to use a dynamic DNS service. One such

service is available from 

https:///www.dyn.com.

The Dyn product, Dynamic DNS Pro, costs from $55/year up to $220 for 5 years. You can also

find free services. With Dynamic DNS you can choose a domain, such as w1aw.dyndns.org.

When you connect from a remote location you use this URL. If your Internet IP happens to

change, the domain stays the same.

https:///www.dyn.com


This page is intentionally left blank.
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3 Views

A view is a web page viewed through any browser. Each view has common elements, a

navigation bar at the top and a status bar at the bottom.

Navigation Bar

· Navigate to https://www.rigpi.net by clicking the RigPi logo or RigPi name

· TUNER...WEB: opens window

· SETTINGS: contains a list of settings windows, click the down-arrow.

· Search box: enter call to look up in the FCC database or option QRZ XML online

service. Press enter or click the magnifying glass to look up

· Exit RigPi (connections to radios are preserved)

Status Bar

· Main frequency (shows red when no radio connected)

· Split frequency (shows when radio is in the split mode)

· Mode and Bandwidth

· User, user's call and account username

· UTC Time

https://www.rigpi.net
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3.1 Tuner

1: Navigation Bar

· Navigate to https://www.rigpi.net by clicking the RigPi logo or RigPi name.

· TUNER...WEB: opens window.

· SETTINGS: contains a list of settings windows, click the down-arrow.

· HELP: sources of help for RigPi.

· Search box: enter call to look up in the FCC database or optional QRZ XML online

service. Press enter or click the magnifying glass to look up.

· Exit RigPi.

2: Tuning Knob

https://www.rigpi.net
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· Tap/click the detent and rotate knob to tune higher/lower in frequency. The tuning

scale is determined by the underlined digit in the frequency readout of the Frequency

Panel.

· Tap/click/hold the plus or minus button to move up or down in frequency. Hold tunes

in the same direction at the rate of 2 steps per second.

· Tap/click/ the PTT button to engage the RSS PTT function The PTT button can be

configured as a toggle or momentary switch. 

· L is a Tuning knob frequency lock button.  Tap to lock the frequency.

When using the Macro Decimal mode to control external relays, a row of LED lights

appears below the Tuning Knob.  Tap/click a light to turn on an associated relay,

tap/click again to turn it off.  One slave connection is available for all accounts.  If you

attempt to connect more than one RigPi will show an alert telling which account is



69

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Views

already using the slave connection.  A radio must be connected before relays can be

controlled.

3: Macro Bank

· 128 macros with 4 banks of 32 programmable macro buttons (SETTINGS>Macros).

Macros can be used to send CW, control the radio through Hamlib commands, control

the radio through Hamlib "w" commands unique to the selected radio, control relays,

look up web information, and send system commands (the system command option is

disabled by default).  Change the Macro Bank using the a Macro Bank button (10) or a

custom macro.

4: Status Bar

· Main frequency (shows red when no radio connected)

· Split frequency (shows when radio is in the split mode)

· Mode

· Passband (BW)

· User, user's call and account username

· UTC Time

· Only the Main Frequency is displayed in narrow screens

5: Sliders

· Sliders are hidden if your radio doesn't support changing levels by CAT.

· 4 sliders are provided: AF (AF Level); RF (RF Gain); PWR (Power Output Level); MIC (Mic

Level).*  The sliders adjust the radio front panel controls, not the CODECs (if

appropriate for your radio) or Mumble.

· Sliders can be set with a maximum level or disabled (SETTINGS->Slider Overrides)

*If you find your radio is not responding correctly to sliders, analog level reading for that radio may not be fully

implemented.  In addition, some radios only support several fixed levels for a slider rather than a continuous range.  Please

post a note on the RigPi Forum to let us know of any problems you encounter.

6: Band and Mode

· Tap a Band button to change bands or a Mode button to change modes. Each band

has a memory for the frequency and mode last used on that band. The selected Mode

and Band buttons are highlighted.

· Band buttons can be disabled (SETTINGS->Band Filter) Modes that are not supported

by the radio are disabled.
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· RigPi relies on the Radio to remember the desired bandwidth for each mode. If a radio

(such as Hamlib Dummy) doesn't support this requirement, you can use the TUNE TO

macro to set the bandwidth.

7: Radio Connection and VFO

· Optionally turn on radio power and Connect Radio (Green: connected; Red: not

connected; Rotating Arrows: connecting).  See Advanced Radio Settings.

· Disconnect Radio and optionally turn off Radio power.  See Advanced Radio Settings.

· VFO/Memory operations (memory options enabled when split is on)

· See below for details

8: Frequency Panel

When screens are wide enough to display the RSS S-meter, the frequency panel, above, is

used.

For narrow screens, where the S-meter is hidden, this format is used.
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· Displays the Main and Sub VFO frequencies, band, the current UTC time, operating

mode and receive/transmit status. 

· A keypad is included to set the frequency of selected digits. See below for all tuning

options.

· The Main and Sub frequencies have bars above and below each digit. When a digit is

selected the bars above and below the digit are bold. Tap/Click a digit to select it. The

selected digit sets the tuning resolution for the Knob and typed digits. Click the lower

half of a digit after selection to tune down and the upper half to tune up.

· Change the color theme of the Frequency Panel using Account Settings

(SETTINGS>Accounts>Edit). Four options are provided: Orange, Night, LCD, and High

Contrast. This setting also affects the S-Meter.

Callout Use

1 Information for Main VFO

2 Current band

3 Time (GMT)

4 Main frequency

5 Mode and transmit/receive status

6 Sub VFO information

7 Keypad for entering digits

8 Sub label and radio name

9 Tap to open keypad

10 S-meter

9: S-Meter

· Shows signal strength when in receive and an optional reading when in transmit. There

is no way to adjust the calibration of the S-meter. Some radios may not support S-

meter and/or optional transmit queries through CAT. The S-meter is not shown on
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narrow screens. See the Advanced Radio settings (SETTINGS>Radio>Advanced) for

more information on the optional transmit readings.

· Change the color theme of the S-meter using Account Settings

(SETTINGS>Accounts>Edit). Four options are provided: Orange, Night, LCD, and High

Contrast. This setting also applies to the Frequency Panel.

10: Macro Bank

· Macro Bank to change the displayed bank

Radio Connection and VFO Buttons

The VFO frequency Swap buttons operate when in Split mode.

Button Function

Connect Radio Connect the radio for this account. You must set the radio up the first

time in SETTINGS>Radio. Green: connected; Red: not connected;

Rotating Arrow: connecting.  The control will turn on radio power

before connecting if the radio is off (supported radios only).

Disconnect

Radio

Disconnect the radio and turn off power (supported radios only) for this

account.

A>B Copy the Main frequency to the Sub frequency (memory functions are

enabled when in split mode).

A>M Copy the Main frequency to the RSS frequency memory. This function

does not use the memory in the radio.
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Button Function

M>A Copy the frequency in the RSS memory to the Main VFO

A<>B Swap the Main and Sub VFO frequencies.

SPLIT Turn on split for the radio. The Main VFO is used for receiving and the

Sub VFO is used for transmitting. Some Hamlib radios do not support

split operation. Others cause readout flicker when reading or setting

split frequency (especially Icom radios). Split polling can be turned off in

Radio settings (SETTINGS>Radio>Advanced).

Frequency Tuning

Tuning options allow you to tune both Main and Sub VFO's in many ways.

Option Operation

Mobile

Device

Support

Knob Rotate to tune frequency up or down. Click a digit to

set tuning resolution.

Yes

Knob + Tune up one step, determine resolution by clicking a

digit.

Yes

Knob - Tune down one step, determine resolution by

clicking a digit.

Yes

Click digit Click digit to select, then click upper half to tune up

or lower half to tune down.

Yes

Mouse wheel

(or

Shift+Mouse

wheel)

Rotate to tune up or down, click digit to set

resolution.

No

Keyboard > Move selection to next digit to right. No
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Option Operation

Mobile

Device

Support

Keyboard < Move selection to next digit to left. No

Keyboard ^ Tune selected digit up. No

Keyboard ˅ Tune selected digit down. No

Keyboard [ Down one band No

Keyboard ] Up one band No

Click frequency

buttons

Available for wide screens. Select starting digit, then

click a value and the selection moves to the next

digit.

No

Type frequency

(via Keypad)

Availaboe for narrow screens, such as phones. 

Tap/click starting digit, then tap/click numbers in the

keypad. Each time you change a digit, the selected

digit moves to the right where you can enter a new

digit.

Yes

Shortcut Keys

Shortcut keys on the Tuner window provide quick access to many functions.  The table below

describes these keys.  These keys include the Frequency Tuning keys, above. To see a list  of all

shortcut keys, use ? on your  keyboard.

Shortcut Function

Alt+T Tuner

Alt+K Keyer

Alt+L Log

Alt+A Calendar
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Shortcut Function

Alt+W Web

Alt+E Settings

Alt+H Help

Alt+X Log Out

/ Lookup Call

? Shortcut List

Alt+C Connect Radio

Alt+D Disconnect Radio

Alt+1 Macro Bank 1

Alt+2 Macro Bank 2

Alt+3 Macro Bank 3

Alt+4 Macro Bank 4

+ Frequency Up

- Frequency Down

Up Arrow Frequency Up

Down Arrow Frequency Down

Spacebar Transmit

Left Arrow Frequency Select Digit

Left

Right Arrow Frequency Select Digit

Right
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Shortcut Function

ESC Close Popup

[ Band Down

] Band Up

Ctrl+1 160M

Ctrl+2 80M

Ctrl+3 60M

Ctrl+4 40M

Ctrl+5 30M

Ctrl+6 20M

Ctrl+7 17M

Ctrl+8 15M

Ctrl+9 12M

Ctrl+A 10M

Ctrl+B 6M

Ctrl+C 2M

Ctrl+D 1.25M

Ctrl+E 70cm

Ctrl+L LSB

Ctrl+W CW

Ctrl+F FM
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Shortcut Function

Ctrl+U USB

Ctrl+R CWR

Ctrl+M AM

Ctrl+S USBD

Ctrl+T RTTY

Ctrl+Y RTTYR

The Shortcut Keys are useful for external controllers, such as the TourBox. There is a sample

RigPi Configuration file for TourBox.  You can download it from RigPi TourBox.

Push-to-Talk

Several ways to engage Push-to-Talk (PTT) are provided. PTT uses CAT (software) and solid

state switches (hardware) on the RigPi Keyer and RigPi Audio boards. See

SETTINGS>Radio>Advanced for PTT options. See also Keyer settings for alternative ways to

use the RigPi Keyer board PTT.

https://www.amazon.com/Elite-Bluetooth-Controller-Photoshop-Illustrator/dp/B0B5XCMFQD/?_encoding=UTF8&pd_rd_w=sVc5S&content-id=amzn1.sym.35cab78c-35e3-4fc1-aab0-27eaa6c86063%3Aamzn1.symc.e5c80209-769f-4ade-a325-2eaec14b8e0e&pf_rd_p=35cab78c-35e3-4fc1-aab0-27eaa6c86063&pf_rd_r=NP83JAZQDW10VC3WFH3E&pd_rd_wg=4W0Zd&pd_rd_r=1d03155d-d1e8-4ef1-888b-8b1a94ac352c&ref_=pd_gw_ci_mcx_mr_hp_atf_m
https://rigpi.net/downloads/RigPiTourBox.zip
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PTT can be Latching (tap to transmit, tap again to receive) or Momentary (hold to transmit,

release to receive).

Option Operation

Mobile

Device

Support

PTT to right of

Tuning Knob

Latch or Momentary PTT Yes

T/R Macro

button

Latch PTT Yes

Space bar Latch or Momentary PTT No

3.2 RigPi Lite

RigPi Lite provides a low cpu-utilization connection for other programs that use Hamlib to

control radios and rotors.  Examples include RigPi, WSJT-X and Fldigi.
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RigPi normally uses 25-30% of a Raspberry Pi CPU resources.  RigPi Lite uses less than 1%.

Starting RigPi Lite

RigPi Lite uses the same login credentials as RigPi and connects through port 80.  Set up the

account you want to use for RigPi Lite using the RigPi Account, Advanced Settings and Rotor

Settings.  Once you are done, check that RigPi controls the radio and rotor correctly. 

Disconnect the radio in RigPi, then start RigPi Lite. In your browser navigation bar, use the URL:

rigpi4.local/lite

or the LAN/WAN shown in the Lite window.

If you are operating through a router and have redirected port 80, you must take that into

account when configuring RigPi.  For example, if your router forwards port 8008 to port 80,

start RIgPi Lite by specifying the port.

rigpi4.local:8008/lite

A start-up icon for RigPi Lite is located on the Raspberry Pi Desktop and in the Chromium App

menu.
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1. Enter the Username for the account you want to use, for example, 'admin.' The

Username is case-insensitive.

2. If you have assigned a Password, enter it in the Password box.

3. Click Login (or press Enter).

Lite Window

in the Lite window, click Connect or press Enter to connect.

The Lite window shows the current Main frequency, mode, bandwidth, UTC time, and Transmit

status.  The display is updated every 2 seconds.

Other helpful information is provided below the buttons.

1. The radio name and Username

2. The LAN and WAN <IP>:<port> for the connection.
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If you want WSJT-X to use the RigPi Lite connection, and you are using the same LAN, use the

LAN data.  If connecting from another location, use the WAN data.  To use the WAN

connection, be sure to forward the appropriate port in your router.  In the image above, you

would forward port 4532 in your router.  To use your rotor, forward the port one higher, or

4533.

The RigPi Lite window does not use proprietary widgets, but uses the HTML5 canvas.  RigPi

Lite takes the first step to replacing the proprietary widgets in RigPi.

Connecting to RigPi Lite

Using a second RigPi:

Use the <IP>:<port> shown on the RigPi Lite window.  In Advanced Settings, use Hamlib Net

Rigctl, and R Port 172.16.0.43:4534.  This will connect to RigPi account 2.  Replace the IP with

your IP.  Take into account router redirection if you are connecting from a remote location.

WSJT-X:

If WSJT-X is running on the same RigPi as RigPi Lite, use 127.0.0.1:4534 in the WSJT-X Radio-

>Network Server box to connect to the radio for account 2.  If WSJT-X is running at a remote

location, use he WAN IP and port shown in the Lite window.  WSJT-X connects through the

specified port, so you must port forward that port in your router. 

Rotor control:

In RigPi, set the Rotor to Hamlib Net rotctl.

Use the LAN or WAN on the RigPi Lite window to connect to the RigPi Lite rotor control.  The

port in RigPi Rotor Settings is one higher than the port shown in the Lite window.  If you are

using port 4534 for the radio, use port 4535 for the rotor.

RigPi Lite limitations

1. No radio or rotor control, control comes from another program.  RigPi Lite is display-

only.

2. Only CAT CW is supported, your radio must support CW by CAT.

3. No logging to or from other programs.

4. Auto power on and auto power off are determined from your selections in RigPi

Advanced Radio Settings.
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3.3 Keyer

1: Sent CW

· Displays CW already sent to transmitter. Only RigPi Keyer and WinKeyer support this

function.

· Clear the sent data by clicking/tapping CLEAR LEFT.

· In HOLD mode, use backspace to delete text you don't want to send.

2: Typed CW

· CW characters sent to the Transmitter or waiting to be sent. All keyers support this

function.

· Clear by click/tap CLEAR RIGHT.

3: CW Keyboard special characters

· See below

Button Function

HOLD Allow type-ahead without transmitting.
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Button Function

REPEAT Repeat characters in 'to be sent' panel.

CLEAR LEFT Clear all text from the left panel.

CLEAR RIGHT Clear all text from the right panel.

WPM Slider to increase/decrease the current speed.

SK Send SK prosign.

KN Send KN prosign.

AR Send AR prosign.

BT Send BT prosign.

BK Send BK prosign.

@ Send @ sign.

Band and Mode

· Tap a Band button to change bands or a Mode button to change modes. Each band

has a memory for the frequency and mode last used on that band. The active Mode

and Band buttons are highlighted.

· Band buttons can be disabled (SETTINGS->Band Filter)

· If the current radio doesn't support a mode (i.e. USB-D) that mode button is disabled.

Shortcut Keys

Shortcut keys on the Keyer window provide quick access to many functions.  The table below

describes these keys. Note this list is not available by using the ? key, but is provided below for

reference.

Shortcut Function

Alt+1 SK
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Shortcut Function

Alt+2 KN

Alt+3 AR

Alt+4 BT

Alt+5 BK

Alt+6 @

Alt+T Tuner

Alt+K Keyer

Alt+L Log

Alt+A Calendar

Alt+W Web

Alt+E Settings

Alt+H Help

Ctrl+2 80M

Ctrl+3 60M

Ctrl+4 40M

Ctrl+5 30M

Ctrl+6 20M

Ctrl+7 17M

Ctrl+8 15M

Ctrl+9 12M
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Shortcut Function

Ctrl+A 10M

Ctrl+B 6M

Ctrl+C 2M

Ctrl+D 1.25M

Ctrl+E 70cm

Ctrl+L LSB

Ctrl+W CW

Ctrl+F FM

Ctrl+U USB

Ctrl+R CWR

Ctrl+M AM

Ctrl+S USBD

Ctrl+T RTTY

Ctrl+Y RTTYR

Alt+X Exit to Login Screen
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3.4 Log

1: Navigating

Use the Log navigation bar at the top left of the log under the RSS navigation bar to move

from page-to-page. Up to 25 QSOs are shown on each page. Navigate to any page in your log

using the drop-down page list.

2: Log Name and Log style

Each log has a name and a style. By using distinct names you can maintain separate logs, using

styles for contests or different accounts.

The name and style are shown at the center of the Log navigation bar. The number after the

style shows the number of contacts for that log.

Each log has its own style appropriate for its use. A log can be designed for any purpose, such

as Field Day, a DX contest, or for general use. Use the Log Designer (SETTINGS>Log Designer)

to design or modify the fields and field order that appear in each log.

The log style can be changed to a different style from the Style (book icon) button. The Log

can be selected from the Log (folder icon) button.



87

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Views

Log styles are created and edited in the Log Designer window. Accounts can share logs and

log styles.

3: Add a new Contact

Click the + (plus) button to add a contact to the current Log. The Log Editor window opens

where you can add details for the contact and load information from the Callbook Lookup. See

the Log Editor topic for details.

4: Filtering QSO's

Click the filter (funnel icon) button to show contacts matching the call in the Callbook lookup

box in the top right of the RSS navigation bar. Click the filter button again to show all contacts.

5: Export/Import ADIF

Amateur Data Interchange Format (ADIF) is the data import/export standard for amateur radio

logs. It allows logbook data to be easily transferred from one program to another. ADIF is also

the basis for submission of logs to the ARRL Logbook of the World (LoTW) and other online

logging systems. All downloads compress the ADIF file to the ZIP format. Export transfers the

ADIF from RSS to the local downloads folder usually on another computer. Import transfers an

ADIF file to RSS.

Export to Downloads Folder

Download all QSO's in the current log to the Downloads folder. If using RigPi from the RSS

Desktop, the Downloads folder is the one for RSS. If connecting to RSS from a remote

computer, the Downloads folder for that computer is used.

The file is given a name like rigpi<YOURCALL><Logname>-<n>.zip. For example, a file

containing my Mobile log would be named rigpiW6HNMobile.zip (first download) or

rigpiW6HNMobile-1.zip (second download).

To download all QSO's from all logs, select the ALL Logs option from the Log list (folder icon).

Export Selected Q's

Download the selected QSO's. To select QSO's the Select column must appear in the Log. The

Select column can be added using the Log Designer opened from SETTINGS>Log Designer.

Export for LoTW
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Download all QSO's in the current log with a subset of fields appropriate for LoTW.

Export Selected Q's for LoTW

Download selected QSO's in the current log using a subset of fields appropriate for LoTW.

Import

Upload files must not be compressed and have an extension .adi. For example, my upload file

might be named W6HN-11-12-2018.adi. RigPi asks you to identify the file you wish to upload.

RigPi then proceeds to import the adi file into the currently open logbook.

6: Editing an Existing Contact

Click the Edit button on the left end of a logged contact to open the Log Editor for that

contact. See the Log Editor topic for details.

7: Delete Contacts

Click the Delete button on the right end of a QSO line to delete that contact.

Entire Log

In the drop-down menu, deletes all contacts from the currently open log. If ALL Logs is

selected, all QSO's are deleted from all logs.

Selected Q's

In the drop-down menu, deletes the selected QSO's from the currently open log. To select

QSO's the Select column must appear in the Log. The Select column can be added using the

Log Designer opened from SETTINGS>Log Designer.

Sorting Contacts

Click the Up/Down arrowhead in a column header to sort the log by that column. Click again

to sort in the opposite direction. To return to date order, click the Start header.



89

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Views

3.4.1 Log Editor

Use the Log Editor to add new or edit existing contacts. The Log Editor is opened by clicking

an Edit button on the Log window, or by clicking the + button at the top to start a new

contact.

The Log Designer (SETTINGS>Log Designer) sets the fields, field order, and label for each edit

box. You can also set defaults for each field and select the contents you want to appear in a

drop-down list.

Fill fields from the callbook for the call in the Call field by clicking the down-arrow at the top.

The onboard FCC database is used unless you have enabled the online QRZ XML (subscription)

option.

The Rcv Freq, TX Freq, Band and Mode boxes are filled automatically from the radio when you

create a new contact.  If you wish to manually enter the data for these boxes, disconnect the

radio from RigPi using the Tuner or Radio settings window.

Cancel any changes by clicking the stop button at the top.
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Save the contact by clicking the cloud up-arrow at the top.

By putting a check in the Stay in Editor After Saving option, the Log Editor will stay open so

you can continue to add new contacts.

Information coming from a default setting in the Log Designer is designated by the label for

that field given a green color. If a field has been designated as "no edit," such as a record

number, the value is shown in red.

3.5 Spots

The RigPi spots shows DX spots provided by one of a large number of DX Cluster Telnet sites.

The site you wish to use is selected in SETTINGS>Spots. See the Settings Spots window topic

for details. Click a spot to tune instantly to the frequency and operating mode reported for

that spot.  The selected spot background is red.  Double-click a spot to queue that spot. 

Queued spots serve as placeholders and the rig remains tuned to the red spot.  To convert a

yellow spot to a red spot, click the yellow spot.

A band map centered on the Tuner frequency shows all nearby spots. Click a spot to tune to

the reported frequency and mode for that spot.  The spot in the spot list has a red

background.

1: Spot Source

· RigPi is connected to this Telnet spot source.

2: Connect/Disconnect/Delete
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· Connect to specified Telnet site, or disconnect.  Select the spot server you want to use

in SETTINGS->Spots.  If the connection is successful after clicking Connect, a dialog

confirms that the connect is good. If the connection fails, the dialog tells you so and

the button turns red.  Failure to connect can be due to the spot server not being

active.  Try another server. 

· Delete All removes all spots.  You must be connected to a spot server for this to work.

3: Spot Filter and Spot Color

· Spots are filtered by the Band and Mode options selected in the Filter (funnel icon)

drop-down list.

· Spots are colored depending on the color rule selected in the Color (paintbrush icon)

drop-down list.

4: Color Rule

· Spots are colored depending on the color rule selected in the Color (paintbrush icon)

drop-down list.

· Call fields are colored by call rules.

· Entity fields are colored by entity rules.

Color Rule

None No color used

Teal Call worked before (logged)

Green Call confirmed

Orange Call worked before on this band

(logged)

Red Call confirmed on this band

Teal Entity worked before (logged)

Green Entity confirmed

Orange Entity worked before on this band

(logged)
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Color Rule

Red Entity confirmed on this band

5: Spot Filter

· Spots are filter based on Band and Mode by selections in this drop-down list.

Filter Rule

Band All Spots: all spots (no band filter)

Band Follow Me: spots on same band as Tuner

Band HF: HF spots

Band Low Bands: low band spots

Band High Bands: high band spots

Band WARC: spots on WARC bands

Band VHF/UHF: VHF/UHF spots

Band 160

Band 80

Band 60

Band 40

Band 30

Band 20

Band 17

Band 15
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Filter Rule

Band 12

Band 10

Band 6

Band 2

Mode Show All: all spots (no mode filter)

Mode Follow Me: spots using same mode as Tuner

Mode Only CW: only CW spots

Mode Only Phone: only phone spots

Mode Only Digital: only digital spots

6: Frequency

· Current operating frequency

7: Band Map

· Spots near operating frequency

8: Spots

· Click spot to tune to spot frequency and mode.

9: Spot List

· Spots from current DX Cluster Telnet site.

· Sort the list by clicking the header, again to show the opposite order.

· With the mouse pointer over a spot row the Filter, number of minutes since spotted,

and spotter are displayed in a tool tip.

· RigPi checks the reported mode against the modes the current radio supports.  For

example, the Hamlib Dummy radio does not support USB-D, so USB is used instead.  If
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the spot is on a normal FT-8 frequency or 'FT8' is found in the note, USB-D is used for

the  mode unless the radio doesn't support USB-D.

10: Selected Spot

· Click spot to tune to spot frequency and mode.

Lock list

Alt+C Connect to cluster

Alt+i Disconnect from cluster

Alt+D Delete all spots

Ctrl+home Lock list to top

Ctrl+h Lock list to top

Ctrl+end Lock list to end

Ctrl+e Lock list to end

Ctrl+delete Find yellow spot

Ctrl+y Find yellow spot

Ctrl+insert Find red spot

Ctrl+r Find red spot

Alt+S Reload to refresh spot

list and remove selection

3.6 Calendar

RigPi Calendar is the calendar display for RigPi users. Set up events for Calendar in the

Scheduler settings window .  Calendar events include reservations for rig use and custom

events such as club meetings or skeds. You can overlay the Calendar with event lists from

external sources, such as operating contest schedules.

150
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Hold the mouse pointer over an event to see a tooltip with more details. The day with a yellow

background is today's date.

The Calendar Week view shows all events for the selected week.
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RigPi Calendar Day view
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Drag the event line to change the event start time in the Event Scheduler.  Drag the bottom

edge of an event to adjust the end time for that event in Event Scheduler.
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Radios found on RigPi are shown on the login  screen, plus any upcoming reservations.
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3.7 Web

Web page for W1AW obtained from FCC data

Web page for W1AW obtained from QRZ XML data
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Callbook data for the Web page is obtained from the FCC database installed on RSS (US calls),

entity databases installed on RSS (US and other calls), or QRZ data obtained through the

QRZ.com XML subscription service. When the QRZ service is used, more information is

included, especially for non-US calls. This extra information can be additional station details,

the primary photo, and biographical text (which can also include additional photographs).

FCC Data

The FCC amateur radio database is provided with RSS. An update function is provided in

System settings (SETTINGS>System) that can be used periodically to update the data.

1: Contact Information

2: Entity Flag

3: World Map

· Centered on approximate coordinates 

· Zip code is used for US calls.

· Country center is used for non-US calls.

4: Additional Info

· RSS Entity databases provide this information.

QRZ Data

QRZ data is available on QRZ.com through a subscription service. More information on their

subscription plans can be found on the QRZ.com site. RSS requires a QRZ username and QRZ

password to utilize this service. If you do not have a QRZ XML subscription, the included FCC

database is used for US calls.

1: Contact Information

2: Entity Flag

3: Primary Photo

· This photo is the image shown when you look up a call on QRZ.
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4: World Map

· The map is centered on coordinates from the QRZ database. 

5: Biographical Info

· The text is taken from the Biography in the QRZ database for this call.

· The text may include images and animated gifs.
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4 Settings

RSS is customized using settings windows. The settings, except for System, are unique for each

account.

Many settings get their data from drop down lists.  It is not possible to directly edit the

contents of the text boxes associated with these lists so the text box contents have a gray

background as a reminder.

4.1 Account

All accounts having access to RSS are listed in the Account settings list (SETTINGS>Accounts).

The list shows whether or not the account is in use, the access security level for that account

plus more. Account Settings is only available for Access level 1 accounts.

Editing User Accounts

Edit any user account by clicking the green Edit button at the right end of each list line.

Deleting User Accounts

The primary account, ADMIN at first, can't be deleted. Accounts added after the primary

account can be deleted by clicking the red Delete button at the right end of each row in the

Account list.
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Creating new User Accounts

In the Account Settings window, click Add (plus button at top) to add a new account. Use the

guidelines above to complete the form. Once the account is saved by clicking the Up Arrow at

the top, the Login window appears so you can test the new account or return to another

account.

See the table below for information about each column in the Account Settings list.

Function Name Note

User connected On Y if that user is connected, otherwise N

Callsign Call Call for the account user

Access Security Access 1-5, and 10.  1 = Admin account with full

privileges, 2 or higher = Guest account with no

access to settings. Level 4 is a guest account with

no Transmit capabilities.  Level 10 is a PTT-only

account.

Account Username Username Username for that account

First name First First name for user

Last name Last Last name for user

User location QTH Location of user

Last time on Last Visit Date and time the account last accessed

4.1.1 Account Editor

The Account Settings window shows a list of all RSS accounts. When you start RSS the first

time, a single account named admin with callsign ADMIN is the only account in the User list.

Open the Account window from the SETTING Menu.

Personalizing the ADMIN Account
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The ADMIN account cannot be deleted, but it can be reassigned. You must edit the ADMIN

account to make it your own. Click the green Edit button on the right end of the ADMIN line to

open the Account Editor. Three fields are critical and should be changed: Call, Username, and

password.

Call Enter your callsign, replacing ADMIN. Your own call must be entered

to connect to spot clusters.

Username Use any Username you wish. Usernames must be unique and are

used to identify accounts. The Username is not case sensitive and

there are no length restrictions except it must be at least one

character.

This Username is used when logging in to RigPi, both in the 'normal'

RigPi mode (http://rigpi4.local) and RigPi Lite mode

(http://rigpi4.local/lite).

RigPi PWD Passwords are optional. If you will be opening RSS to the Internet to

operate remote, a password is essential. The password for ADMIN is

blank so you can easily sign in the first time without a password.

http://rigpi4.local
http://rigpi4.local/lite
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Once you enter a password you will be required to use that (or a

modified) password from then on.

This password is used when logging in to RigPi, both in the 'normal'

RigPi mode (http://rigpi.local) and RigPi Lite mode

(http://rigpi.local/lite).

Other optional special fields:

Access ADMIN has an access level of 1. The first account must be an Admin

account.  

All RSS settings can be accessed through an account with the Access

set to 1 for that account.   If you have set up a level that does not

provide access to settings, temporarily set that account to Admin so

you can make changes.

If the Access is set to 2, the account does not have access to Account

or System settings. 

Access 3 blocks all settings. 

Access 4 prevents the account from transmitting.  

Access 10 provides only a PTT button. 

A guest account can be set up with any Access level from 1 to 10. 

When you save the account info, if you have changed the access

level, RigPi asks if you want to reboot.  It is important to proceed

with the reboot.

Latitude/Longitu

de

Callsign lookup uses your latitude and longitude to compute the

distance to a DX station.  Longitudes west of 0 are negative numbers.

Latitudes south of the Equator are negative numbers.

Sync WSJTX Log Contacts logged in WSJT-X are automatically transferred to the

selected log for this account. See the WSJT-X Help topic for details.

http://rigpi.local


108

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Settings

Sync Fldigi Log Contacts logged in Fldigi are automatically transferred to the

selected log for this account. See the Fldigi Help topic for details.

Deadman Limits transmit time to the number of minutes entered in the text

box.  This  prevents unwanted transmitting if remote control is lost

while in transmit.  Set Deadman to 0 to override this function.  If

transmit is blocked, reconnect the radio to reset the Deadman timer.

Inactivity Number of seconds for radio inactivity before automatically closing

RigPi. Enter 0 to bypass this function.  If you are using a mobile

device that takes over the screen with another app (such as VNC), set

the Inactivity value to 0.

Theme Select the Theme for the Tuner window. Four themes are provided:

Orange, Night, LCD, and High Contrast. Note: since this box can only

be filled from the drop down list it has a gray background.

QRZ User If you wish to use the QRZ XML subscription service to look up calls,

you must enter your QRZ username and QRZ password. QRZ XML is

a subscription service. If you do not have a QRZ account, RSS uses

the FCC database in RSS to look up info for US callsigns, and an RSS

entity database to find information about non-US callsigns.

QRZ Password Password for QRZ XML service.

The remainder of the Account fields are self-explanatory and are optional.

Click the cancel (Stop icon) to reset any changes you have made. Click save (cloud up-arrow

button) to save the changes.

4.2 Basic Radio

Two Radio Settings options are provided in the RigPi SETTINGS Menu. Basic Radio settings

take advantage of the Hamlib default settings for each radio. If you have made changes to the

radio default Baud rate, stop bits, or RTS/DTR settings in your setup, use Advanced Radio

settings. Advanced Radio settings also provide additional troubleshooting aids.
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Most settings options use a drop-down list of options. Click the down arrow on the right end

of an option that uses a list from which to choose. Click the option you wish to set and that

option appears in the settings box.  Boxes that are filled from drop down lists are gray since

they cannot be filled manually.

To save changes, click the cloud up arrow at the top of the window. Use Disconnect Radio

followed by Connect Radio to apply changes.  Connect Radio also saves changes before

applying them.

Function Label Notes

Radio

Manufacturer

Manuf Select the company that manufactured your radio. A special

"Hamlib" manufacturer can be used for special purposes,

see the Technical>Sharing Radios, Rotors and Keyers topic.

Radio Model Radio Once you have selected a Manufacturer, the Model list

shows all supported models from that manufacturer.

Radio Name Name Enter the name you want to use for this radio. This radio

name appears in the Tuner window, in many alert dialogs,

and in your log. The Model name is added to the Name box

automatically, but you can change it. For example, the

model MARK-V FT-1000MP appears in the Yaesu list. You

can change the Radio Name to MV 1000MP, to shorten the

name.
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Radio Port R Port The Port drop-down list shows all active ports connected to

serial devices through a USB port. If you have a single radio

connected to RigPi, there will be one long and one short

entry in the list. With more than one radio or serial device,

pull the radio USB connector out, refresh the page, and see

what port is missing.  Rebooting RSS can cause the short

port names to change. so use the equivalent long name

which does not change.  The short ttyUSB ports are listed

along with long names.  The long 'by-id' name for all serial

ports is included as shown in the screen shot for Advanced

Radio, above.

The port can be directed to another RigPi which is

controlling the radio.  See Radio Advanced Settings.  

CW Keyer Keyer Select RigPi Keyer, via CAT, WinKeyer, External CTS, or None

from the drop-down list. RigPi Keyer is available for one

account but can be shared. Other accounts can share an

assigned RigPi Keyer, or choose one of the other options.

The WinKeyer option is used for a standalone K1EL

WinKeyer connected through a USB port. See the Keyer

Settings  topic  for more information about Rig, Pi Keyer

and WinKeyer. 

K(eyer) Port CW Port RigPi Keyer uses /dev/ttyS0 for control. Via CAT does not

require a separate port, it uses the radio port. WinKeyer and

CTS External  require a separate USB port. The CW Port can

be redirected to another RigPi, see Radio Advanced

Settings.

Transmitter

Power

TX Pwr The default power level used by your transmitter. This value

is used in logging.

Connect

Radio

Connect

Radio

Connect the defined radio and keyer to RigPi. The Connect

Radio button also saves any changes you have made in

settings.  If you change to another radio or different

settings, Connect Radio disconnects the current radio and

connects the specified radio.

121



111

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Settings

Function Label Notes

Disconnect

Radio

Disconnect

Radio

Disconnects the defined radio and keyer.

4.3 Advanced Radio

Two Radio Settings options are provided in the RigPi SETTINGS Menu. Basic Radio settings

take advantage of Hamlib default settings for each radio. If you have made changes to the

radio default Baud rate, stop bits, or RTS/DTR settings in your setup, use Advanced Radio

settings. Advanced Radio settings also provide additional troubleshooting aids.

Most settings options use a drop-down list of options. Click the down arrow on the right end

of an option that uses a list from which to choose. Click the option you wish to set and that

option appears in the settings box.  Boxes that are filled from drop down lists are gray since

they cannot be filled manually.

To save changes, click the cloud up arrow at the top of the window. Use Disconnect Radio

followed by Connect Radio to apply changes.  Connect Radio also saves changes before

applying them.
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Radio

Manufacturer

Manual Select the company that manufactured your radio. A

special "Hamlib" manufacturer can be used for special

purposes, see the Technical>Sharing Radios, Rotors and

Keyer topic.

Radio Model Radio Once you have selected a Manufacturer, the Model list

shows all supported models from that manufacturer.

Radio Name Name Enter the name you want to use for this radio. This radio

name appears in the Tuner window, in many alert dialogs,

and in your log. The Model name is added to the Name

box automatically, but you can change it. For example, the

model  KX3 appears in the Elecraft list. You can change

the Radio Name to something like 'KX3@home' or

'KX3@remote', depending on your use.  If the name is too

long it will overflow the allowed space in the Tuner panel,

so you may have to abbreviate it. If the account is for

remote access, use 'Hamlib/Net rigctl for the radio. 

Change the Name to the exact name for the station RigPi

radio.  Doing so lets the remote RigPi know what physical

radio is being used so it can looks up info such as

available bandpasses.

Radio Port R Port The Port drop-down list shows all active ports connected

to serial devices through a USB port. If you have a single

USB device  connected to RigPi, there will be one long and

one short entry in the list. With more than one radio or

serial device, pull the radio USB connector out, refresh the

page, and see what port is missing.  Rebooting RSS can

cause the port numbers to change. Short tty USB ports are

listed along with long port names provided by the USB

device driver (by-id).  The 'by-id' names do not change

when you reboot, so choose a by-id device if possible.  In

addition to a USB port, RigPi can connect to another RigPi.

located on the same LAN or at a distant location over the

Internet.  See this reference.

Radio Port

Baud Rate

Baud The Baud rate for the selected radio. Hamlib defaults to

the highest Baud rate permitted by the radio. You can

change the radio Baud rate in the radio menu. Leave the

60
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RSS Baud rate set to default if you are using the fastest

Baud rate possible in your radio. (Not used for

Hamlib/Net rigctl Remote connection.)

Radio Port

Stop Bits

Stop The stop bits for the selected radio. Leave this set to

default if you have not changed the stop bits from the

factory settings.

Icom CI-V

number

CI-V Icom radios are identified by a number unique to each

radio.  To use the Hamlib CI-V default number, enter

default.  You can use a hex number in the format 0xnn

where nan is the hex identifier, or in decimal format nan. 

Decimal radio 23 would simply show the number 23.  This

identifier number only changes if you modify it from the

radio's menu.

Radio Port

DTR

R DTR Determines the DTR state of the radio port. The options

are: default, high, and low. To use the Hamlib default for

the radio, select default.

Radio Port

RTS

R RTS Determines the RTS state of the radio port. The options

are: default, high, and low. To use the Hamlib default for

the radio, select default. (Not used for Remote

connection.)

CAT PTT

Command

PTT Cmdr Select the CAT command to be sent to the radio for PTT

On.  The options are: default, w TX1;, and Custom. Some

radios require TX1; to be sent to tell the radio to use the

rear panel Data connector for audio input.  If your radio

requires a special command, use the Custom option to

enter a Hamlib or custom radio command.  Custom radio

commands use the native CAT PTT command.  Precede

the command with a w<space>.

Hardware PTT H/W PTT Determines how the hardware PTT circuits respond. The

options are: None, ON when transmitting (default),Hamlib

GPIO, and ON when radio connected. This option controls

both Audio PTT and Keyer PTT outputs.  See the Keyer

Settings topic for more control over Keyer PTT operation. 

The Hamlib GPIO option is designed for external
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programs, such as WSJT-X, that do not support GPIO pin

control for PTT, and radios that do not support CAT PTT. 

With this option the RigPi hardware PTT switch can be

used to control PTT through an ACCT connector on the

radio.  RigPi CAT PTT is not available when Hamlib GPIO is

selected so the CAT PTT selection is ignored.

CAT PTT CAT PTT Determines how the CAT PTT responds. The options are:

None, ON when transmitting (default), and ON when

radio connected.  The CAT PTT selection is ignored when

you use the Hardware PTT GPIO option.

PTT Delay PTT Delay Enter the number of milliseconds delay from when the PTT

button is toggled on the Tuner window to when transmit

is started.  The USB AF Gain is reduced when the PTT

button is pressed to stop audio,  This delay prevents the

transmission of receive audio fed back from the remote

device but also delays a voice transmission. The noise

burst usually requires a delay of 100-200 ms. 

Not all audio interfaces allow audio to be muted, check

using Alsamixer which shows the available settings.  The

RigPi Audio Board is supported.  To test, open Mumble-

>Configure->Settings->Audio Input and set Transmit to

Voice Activity. The Transmission bar graph shows input

audio level.  In RigPi->Settings->Advanced Radio, set PTT

Delay to 3000 (3 seconds).  While watching the Mumble

bar graph, click PTT on RigPi.  The bar graph will go down

immediately followed by Transmit in 3 seconds.  Be sure

to set PTT Delay band to it normal value after running this

test.

PTT Latch PTT Latches PTT mode selections include 'PTT Latches' (tap PTT button

to turn transmit on continuously) and PTT Momentary

(press PTT button to transmit).

Transmit

Meter

Tr Mtr Select the parameter you want displayed by the Tuner S-

Meter when in transmit. The options include Output

Power, Output Power Default, SWR, ALC, Voltage, Current,

Mic Gain, and Meter. The readings supported by Hamlib
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with your radio can be found in the capabilities list shown

when you click Radio Capabilities. Look in the Get Level

list. None, one, or all options may be supported. Output

Power Default shows the static setting for maximum

power output set in your radio. See Mtr Cal, below, for

calibrating the meter.

Meter

Calibration

Mtr Cal The value reported by the radio for the reading you have

chosen can be calibrated with this option. If your

transmitter has a maximum power output of 100 watts,

you have selected Output Power Default, setting the Mtr

Cal to 100 gives a full scale indication of 100. If you have

set the maximum power output to 50 watts, setting Mtr

Cal to 500 gives a reading of 10 on the meter. See below.

Each Tr Mtr selection has its own calibration level.

Power Control Pwr Ctrl RigPi can turn the radio on when it first connects and off

when it disconnects.  The Power Control drop-down

provides options for Power On and Power Off.  Use

Manual if you don't want RigPi to control power.  The

Manual option should be used when connecting to a RigPi

using Hamlib Net rigctl or another copy of the same radio

if you don't want that second connection to control

power..

Serial Defaults

button

Serial

Defaults

Click to show the defaults used in Hamlib for connecting

to the specified radio.

Radio

Capabilities

button

Radio

Capabilities

Provides a list of all set and read capabilities for the

selected radio.

Disable Split

Polling check

box

Disable Split

Polling

Some radios, such as many made by Icom, do not provide

a way to directly read the split VFO frequency. Instead, the

frequency is read by swapping VFO's. This causes flickering

on the split frequency readout. While the flickering doesn't

cause changes in frequency, it can be disconcerting. Put a

check in the Disable Split Polling option to prevent the

reading of the split frequency VFO to stop the flickering.

Keep in mind that any manual changes to the split
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frequency made on the radio will not known by RigPi. Split

reading for some radios is not supported by Hamlib even

though the radio provides a means of doing so. Use Radio

Capabilities to determine if your radio fits into this

category.

Morse Keyer Keyer Select RigPi Keyer, via CAT, WinKeyer, CTS External, or

None from the drop-down list. RigPi Keyer is available for

one account. (The K1EL RigPi Keyer provides two-radio

support, SO2R). Other accounts can choose one of the

other options. The WinKeyer option is used for a

standalone K1EL WinKeyer connected through a USB port.

See the Keyer Settings  topic for more information

about RigPi Keyer and WinKeyer. 

Transmitter

Power

Tx Pwr The default power level used by your transmitter. This

value is used in logging.

Video

Position

Selection

Video One camera is supported by RigPi, but each account has

access to the video from that camera.  The options include

None (no video), Video -> S-meter (video replaces S-

meter panel), Video -> Frequency Panel (video replaces

Frequency panel).  See the Motion  topic in Other

Programs to learn more about using video with RigPi.

CW Keyer

Port

Keyer Port RigPi Keyer uses /dev/ttyS0 for control. Enter the IP of

another RigPi to connect to the second Keyer board.  Via

CAT does not require a separate port, it uses the radio

port. The CW Port parameters are not adjustable. The

WinKeyer3 IC and WinKeyer devices use 1200 Baud with

one stop bit. If using element keying from RigPi Hub, set

the port to 30039 + n where n is the account number.  For

example, set the Keyer port to 30040 for account 1.

Slave Port Slave Port Port used for slave connection.  See text below for more

information on the slave command. Note the port used

disappears from the port list once you have connected, it

still exists for the driver.  To restore the list, pull out the

FTDI cable and reinsert.  Refresh the Advanced Settings

window.

121
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Slave Baud Slv Baud Baud rate used for slave connections.

Slave

Command

Slv Cmnd Command format sent by RigPi when there is a frequency

change.  The Kenwood IF command sends 38 characters

including current frequency.  The Kenwood FA command

sends 14 characters containing only frequency. Band BCD

is used for devices that are controlled by BCD Band data,

such as the Ameritron RCS-12 Automatic Antenna Switch.

 A special cable is required, see below. Macro Decimal is

used for controlling the on/off state of up to 8 devices.  A

special cable is required, see below.

Connect

Radio button

Connect

Radio

Connect the specified radio and keyer to RigPi. The

Connect Radio button also saves any changes you have

made in settings.

Test Radio

button

Test Radio Attempts to connect to the radio using the settings values

and creates a report that is displayed. The report can give

helpful information when the radio isn't connecting.  To

share the report, select all the text, copy, then paste it to a

destination, such as an email. An comprehensive log can

be found in /var/log with the name rigpi-radio.log.

Disconnect

Radio button

Disconnect

Radio

Disconnects the radio

Tr Mtr Example

Here is a list of the readings are supported by Hamlib for the TS-570S.  This list is extracted

from the Radio Capabilities button in Radio>Advanced.

PREAMP(0..0/0) ATT(0..0/0) AF(0..0/0) RF(0..0/0) SQL(0..0/0) RFPOWER(0..0/0) MICGAIN(0..0/0)

KEYSPD(0..0/0) AGC(0..0/0) SLOPE_LOW(0..0/0) SLOPE_HIGH(0..0/0) STRENGTH(0..0/0) 

The only two readings that appear to apply to the TS-570S in transmit are RFPOWER and

MICGAIN.  The best option is the “Output Power Default” selection in Radio>Advanced>Tr Mtr

which is RFPOWER in the list above.  That is a static reading, it reads the max level the radio is

set to, not what is being transmitted.  The Mtr Cal sets the max level calibration of the meter. 

So if you enter 200 for Mtr Cal and you have your transmitter set to 100 watts max, the

bottom digit scale on the meter should be 50 when in transmit.
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RigPi supports a single slave connection per account.  

The RigPi Slave Command sends one of two CAT commands when there is a frequency change

in the connected radio, BCD Band data when the radio band is changed, or manually triggered

decimal commands.  The commands can be used with devices, such as the SteppIR antenna

controllers, a compatible power amplifier, or a Kenwood radio.  For example, you may have an

Icom IC-7300 as your radio, but you also have a Kenwood TS-2000.  The Kenwood frequency

tracks any changes in the Icom's frequency as you tune.

The Band BCD option sends Band BCD data through a special cable to tell external devices

what band the radio is currently using. The special cable is an FTDI C232HM (C232HM-EDHSL-

0). This cable has 10 wires that can be used for interfacing to other devices.  The FTDI cable can

be purchased from Mouser Electronics.  The 5th line in Band BCD mode goes low when the

radio is transmitting.

 

The Macro Decimal option is used for Macros or a row of LED indicator lights below the tuning

knob.  Up to 8 external devices can be controlled using a Macro command !SWn-m, where n is

1-8 and m is 0 (off) or 1 (on). Macro Decimal switch macros can be stacked, so !SW1-1!SW3-1

turns devices 1 and 3 on.

 

Band BCD C232HM-EDHSL-0 wiring

Wire Signal Ameritron

RCS-12

Elecraft KPA-500 Elecraft KPA-1500

Red VCC 

Orange BIT/PIN 0 BCDA (pin 2) Band 0 (pin 13) Band 0 (pin 13)

Yellow BIT/PIN 1 BCDB (pin 1) Band 1 (pin 3) Band 1 (pin 3)

Green BIT/PIN 2 BCDC (pin 9) Band 2 (pin 9) Band 2 (pin 9)

Brown BIT/PIN 3 BCDD (pin 8) Band 3 (pin 14) Band 3 (pin 14)

Grey BIT/PIN 4 PTT (pin 7) PTT (pin 10) PTT (pin 10)

Purple BIT/PIN 5 

White BIT/PIN 6 

Blue BIT/PIN 7 

Black GND Ground (pin 6) Ground (pin 5) Ground (pin 5)
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Use this table to determine the port numbers to use if connecting from a second RigPi to the

radio RigPi.  The ports in accounts 1 and 2 have been opened in the RigPi Firewall.  If using

account 3 or higher, you must modify the firewall.

Here is how to modify the Firewall to enable account 3:

1. Open Terminal on the Raspberry Pi Desktop for the radio RigPi.

2. Enter 'sudo su'.

3. Enter 'ufw allow 4536/tcp'

4. Enter 'ufw allow 4537/tcp'

5. Enter 'ufw allow 30003/tcp'

6. Enter 'ufw allow 4536/tcp'

7. Enter 'ufw allow 40042/udp'

Account Radio Rotor CW (CCM

Port)

Manual CW Notes

1 4532 tcp 4533 tcp 30001 tcp 40040 udp

2 4534 tcp 4535 tcp 30002 tcp 40041 udp

3 4536 tcp 4537 tcp 30003 tcp 40042 udp Ports must be opened in

Firewall

4 4538 tcp 4539 tcp 30004 tcp 40043 udp Ports must be opened in

Firewall

Open any ports you want to access in your home router.  For example, open 4536 if you are

using account 3 on the station RigPi and only want radio control.

4.4 Rotor

One rotor can be assigned to and controlled through each account. 30 Rotor models are

supported by Hamlib from 21 manufacturers. The screen shot shows the rotor configured for

the Hamlib Dummy rotor which provides a rotor simulation.
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Most settings options use a drop-down list of options. Click the down arrow on the right end

of an option that uses a list from which to choose. Click the option you wish to set and that

option appears in the settings box.  Boxes that are filled from drop down lists are gray since

they cannot be filled manually.

To save changes, click the cloud up arrow at the top of the window.  If you make changes to

Rotor Settings while a radio is running, restart the radio in the Tuner, Radio Basic or Radio

Advanced windows.

Function Label Notes

Rotor

Manufacturer

Manuf Select the company that manufactured your rotor. A special

"Hamlib" manufacturer can be used for special purposes,

see the Technical>Sharing Radios, Rotors and Keyers topic.

Rotor Model Rotor Once you have selected a Manufacturer, the Model list

shows all supported models from that manufacturer.

Rotor Port Port The Port drop-down list shows all active ports connected to

serial devices through a USB port. If you have a single radio

connected to RigPi, there will be one entry in the list plus

the rotor. With more than one serial device, pull the rotor

USB connector out, refresh the page, and see what port is

missing.  
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Use the USB long name to always connect to that device.

For the Hamlib Dummy rotor use the value for Rigctl Port in

System Settings plus 1.  For example, to use Hamlib

Dummy, set the Man to Hamlib, the Rotor to Dummy, and

the Port to 4533.  

To share a rotor, use the Rigctl Port for that radio plus 1. 

For example, to share a rotor assigned to radio port 4534,

use port 4535 for the rotor, and Net rotctl for the Rotor.

Connect to a remote RigPi by using NET Rotctl and

<IP>:<port> in the port box.

Rotor Baud Baud Baud rate for the serial connection to the rotor.

Stop Bits Stop Number of Stop bits used by the rotor serial connection.

4.5 Keyer

The CW Keyer Settings window is used for the RigPi Keyer, or external K1EL WinKeyer. These

settings do not affect keying via CAT except for Speed. Once you have entered new settings

you can test the keyer by clicking the Test Keyer button.  This causes the Winkeyer to go into

the host mode, leaving the command mode.

Up through RigPi 3 the Keyer board was provided by MFJ.  After MFJ ceased production, K1EL

designed a board for RigPi.  The K1EL board is the same as the MFJ board except for several

changes.

1. The K1EL Keyer supports two keyer outputs (which can be switched through a macro) with

a single input.  The two keyers can't be accessed at the same time, but the switching is ideal

for SO2R (Single-operator, 2-radio) operations.

2. The internal speaker output can be muted through software control.

3. A Raspberry Pi fan can be controlled for temperature regulation.

The RigPi Keyer can be assigned to one account. Additional accounts can use keying via CAT or

WinKeyer. There are no limits to the use of the via CAT option or to the number of external

WinKeyers.
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Remote Keyer provides a way to key your radio from a remote location using a paddle, bug, or

straight key. RigPi CW Keyer boards are required at both ends.  The Remote CW Keyer board

provides speed control and sidetone.  CW characters are sent by UDP data packets.  Each

packet contains the start or end time for a CW element.  The timing is used to reconstruct the

CW elements at the Radio RigPi to key your transmitter.

Most settings options use a drop-down list of options. Click the down arrow on the right end

of an option that uses a list from which to choose. Click the option you wish to set and that

option appears in the settings box.  Boxes that are filled from drop down lists are gray since

they cannot be filled manually.

RigPi Keyer and WinKeyer options

The Notes below are adapted from K1EL's WinKeyer3 IC data sheet.

Click to see WinKeyer Data Sheet

http://k1el.tripod.com/files/WK3_Datasheet_v1.pdf
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Function Label Notes

Keyer Speed (WPM) Speed

Paddle Keying Mode Paddle Md RigPi Keyer supports iambic A, B, Ultimatic, and Bug

keying modes. In iambic mode, RigPi Keyer sends

dits and dahs automatically based on which paddle

you press. In bug mode RigPi Keyer sends the dits

and you manually send the dahs. You also can use

bug mode to operate in straight key mode or if you

want to key through RigPi Keyer with a different

keyer, simply set bug mode and use the dah input

to key RigPi Keyer.

Keyer Sidetone (Hz) Sidetone The sidetone frequency is continuously adjustable

between 500 and 4000Hz

Keyer Weight Weight A value of 50 selects no weighting adjustment.

Values less than 50 reduce weighting and values

greater than 50 increase weighting. Note that

weighting does not affect sending speed because

any increase in keyed time is subtracted from

spacing time. Reduction in weighting results in a

thinner sounding keying while increased weighting

results in a heavier sound. Since weighting tracks

speed, a given weighting will sound the same at all

speeds.

Keyer PTT Lead-In

Time

Leadin RigPi Keyer provides a transmitter PTT output for

each key output that can be used to switch a

transmitter or linear amplifier over to transmit

mode in advance of actual CW keying. You have

control over the time delay between when PTT is

asserted and when CW keying starts, this is lead-in.

You also have control over how long the transmitter

will stay in transmit after keying has stopped. The

Tail setting determines the delay used for CW sent

by an internal message or CW sent by RigPi. Restart

the radio connect to apply any changes.

Keyer PTT Tail Time Tail See Keyer PTT Lead-IN Time, above
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Function Label Notes

Speed Pot minimum

WPM

Min WPM Min WPM and WPM Range set the limits for the

speed pot. Min WPM sets the lowest value returned;

WPM Range indirectly specifies the maximum value

returned. For example if Min WPM=10 and WPM

Range=15, the full pot swing values, min to max,

would be 10 to 25 WPM. Note that the max value is

Min WPM+WPM Range.

Speed Pot WPM

range

WPM Rng See Min WPM, above

Keyer Keying

Compensation

Comp Keying Compensation allows a fixed amount to be

added to the length of all dits and dahs. QSK keying

on modern transceivers can cause shortening of dit

and dah elements which is especially noticeable at

high speeds. RigPi Keyer can compensate for the

shortening by adding a uniform length to each dit

and dah element. The adjustments are made in

one-millisecond steps and the maximum

adjustment allowed is 250 m Secs. Key

compensation is very similar to Weighting in that an

adjustment added to a dit or dah is then subtracted

from the spacing between them so the overall

speed is not changed. The difference between

weighting and compensation is that compensation

is independent of speed, so if 10 m sec of key

compensation is selected, 10 m sec will be always

be added regardless of speed. Be aware that at high

speeds, large values of key compensation can

reduce inter-element space to zero.

Slow CW Farnsworth

maximum speed

Farns Farnsworth spacing is useful for CW practice

because it encourages you to learn characters by

sound not individual dits and dahs. When

Farnsworth is enabled, letters are sent at a fixed rate

of nn WPM while spacing between characters is

determined by the sending WPM rate. When the

WPM rate is set above the Farnsworth WPM,

Farnsworth is automatically disabled.
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Function Label Notes

Paddle timing Paddle This setting controls when RigPi Keyer will start

looking for a new paddle press after sensing the

current one. If there is not enough delay, the keyer

could send unwanted dits or dahs. If there is too

much delay, the operator is held back because they

can't paddle ahead. The default value is one dit

time (50) and is adjustable in percent of a dit time.

Faster operators report a setting somewhat less

than default is optimal. If the paddle sensitivity is

set to zero, dit and dah paddle memory is disabled.

Dot/Dash ratio Ratio Modifies the ratio of dit time to dah time. The

standard ratio is 1:3 (dit:dah) when ratio = 50. The

formula to determine dah/dit ratio is: DAH/DIT =

would select 1:2, and a value of 66 would select 1:4.

This causes an intentional distortion of the Morse

waveform. Some ops use this option to make their

CW sound less “machine like” but a little goes a

long way!

Turn sidetone on/off Enable

Sidetone

Enable the RigPi Keyer sidetone for paddle and

RigPi keying.

Keyer PTT mode Enable

Keyer PTT

Keyer PTT is turned on when the WinKeyer IC sends

CW. To re purpose the WinKeyer IC PTT so it can set

PTT independently (through programmable

Macros), remove the Enable Keyer PTT check.

Left/right paddle

swap

Swap

Paddles

Reverse the dit/dah paddle control. Useful for left

handed operation.

Keyer sending

autospace

AutoSpace Autospace works in the following way: If you pause

for more than one dit time between a dit or dah,

RigPi Keyer will interpret this as a letter-space and

will not send the next dit or dah until the full letter-

space time has been met. The normal letter-space is

3 dit spaces. RigPi Keyer has a paddle event

memory so that you can enter dits or dahs during

the inter-letter space and RigPi Keyer will send
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Function Label Notes

them as they were entered. With a little practice,

autospace will help you to send near perfect Morse.

Contest spacing CT Space Shortens the time between characters by one dit

space.

Control Keyer

Watchdog

Disable

Watchdog

RigPi Keyer has a paddle watchdog counter that

disables the key output after 128 consecutive dits or

dahs. RigPi Keyer assumes that this is an unintended

condition and keying outputs are turned off.

Sidetone remains on to alert the user. Paddle

watchdog is on by default but it can be turned off

by setting this mode bit.

Speed Control

source

Use Pot for

speed

control

When checked, use the speed pot on the Winkeyer

for speed control.  When not checked, use the

speed slider for speed control.

Use PTT for other

applications

PTT ON

when Radio

Connected

Forces PTT to turn on when a radio is connected

and under control. This is useful for antenna bypass

switches and similar applications. Restart radio

connection to apply any changes. See below.

Reset Defaults Reset

Defaults

Restores the original RigPi Keyer default values.

Test Keyer Test Keyer Sends two 'V' characters.

Remote Keyer

Function

Keyer Fn Selects Keyer mode. Options are Normal, Radio

Keyer, Remote Keyer and External CTS. 

Normal: Keyer as defined in Advanced Settings .

Radio Keyer: With two RigPi's for remote operation,

select Radio Keyer for the RigPi controlling your

radio.

Remote Keyer:   With two RigPi's for remote

operation, select Remote Keyer for the RigPi at the

remote location

116
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Function Label Notes

External CTS: When using a USB-to-serial adapter

for keying the radio.

Remote Keyer Port Port When using 'Normal' mode, enter the Port (30001)

and IP of a RigPi whose Keyer you want to use.  If

you entered the port as '/dev/ttyS0' in Advanced

Settings, both RigPi Keyer sidetones are operational.

For Manual (element) keying enter the UDP port

used by the Radio RigPi to listen for a connection

from Remote Keyer. The default port is 30040.  The

Remote Keyer option also provides a setting for the

Radio Keyer IP.

Remote Keyer Radio

RigPi IP

IP The IP for the Radio RigPi when using Remote

Keyer. This setting only appears for the Remote

Keyer RigPi.

Invert Remote

Keying

Invert

Keying

Inverts the keying when using direct keying using a

GPIO pin to send CW.  

Keyer PTT

RSS has “Normal PTT” and “Keyer PTT.” Normal PTT is what you expect when you tap PTT on

the Tuner window, push-to-talk. Keyer PTT, which originates on the Keyer board, can be used

for other purposes.

Normal PTT from the Tuner PTT or macro switches does two things. It sends the CAT PTT

command, if enabled, to the radio and simultaneously controls the hardware switches on the

Keyer and Audio boards, if H/W PTT is enabled. The Keyer PTT switch goes from tip to sleeve

(grounded) on the Keyer PTT connector while on the Audio board it goes from ring to sleeve

(not grounded).

There is an alternate way to control Keyer PTT on the Keyer board. This alternate PTT is

controlled by the K1EL WinKeyer3 IC. When PTT is “enabled” in Keyer settings, this PTT

operates whenever there is outgoing CW. You can set the lead-in delay and tail delay to take

care of amplifier switching in Keyer Settings. When PTT is “disabled” in Keyer settings by

removing the check in the Enable Keyer PTT check box, you can control the WinKeyer3 IC PTT
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through software. This latter control can be is used by a macro and by the “PTT ON when radio

connected” option in Keyer settings.

Keyer PTT and RigPi PTT always engage the PTT on the Keyer board. Since RSS doesn’t know

when the CW Keyer is sending CW, the “Enable Keyer PTT” option is the only way to control

the radio or amplifier if switching is necessary. If that switching isn’t necessary, The “disabled--

no check” Keyer PTT can be used for other purposes.

Remote Keyer Connections

If using a RigPi Keyer board, a paddle, bug or straight key is connected to Remote Keyer

through the PADDLE connector.  If using a bug or straight key, the Remote Keyer Paddle Mode

(Paddle Md) must be changed to Vibrobug.  The tip of the PADDLE connector is shorted to

ground to key Remote Keyer which is then sent to the Radio RigPi.

See RigPi Remote Keyer  for more details.

4.6 Log Designer

The Log Designer provides a drag-and-drop way to modify existing log styles, or to design

new ones. A log style is assigned to each log, but you can change the assigned style by making

a selection through a drop-down list in the RSS Log window.

The top three boxes include one to select a style you wish to edit, a second to start a new style,

and a third to save a style with a different name.  If you add a new style, or save as an existing

214
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style, press Enter to save or click OK.  Boxes that are filled from drop down lists are gray since

they cannot be filled manually.

The three lists include a master list of log fields (white, center), fields assigned to the current

style for the log (yellow, left) and finally a list to show the fields assigned to the log editor

(yellow, right). Items in the yellow lists can be dragged up or down to change their order, or

removed from that list by deleting. Items in the master list can be dragged and inserted into

either yellow list.

The fields at the bottom are for labeling and setting defaults for the selected field.

Function Label Notes

Field Label Label Appears in the column

headers for the Log, and at

the left end of the field for

the Log Editor.

Optional default for the

selected field

Default Add a default for this field.

The default is always added

to the field where it can be

edited.

Field attribute Attr The Field Attribute

determines how the field is

used. See below.

List of options for drop-

down lists

List Determines a default list for

a list field, such as for Mode.

See below.

Field prompt Prompt Appears in each field as a

place holder unless there is

a default.

Field notes Note Description of the field

Field Attribute

Each filed is assigned an attribute depending on how the list is used.
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Attribute How it appears Note

None Field has label and text

box

No attributes assigned to this field.

Set Time Field has clock icon on the

right, click to set the

current time

Click the clock icon to enter the current time

into the field. The time may be edited.

Drop-Down

List

Drop-down list, click list

icon on left

Contents of drop-down list. Use the List field

to enter a comma-delimited list. For example,

CW,PHONE,DIGITAL for modes. If a Drop-

down list is not defined for modes, all modes

will be in the list.

No Edit Field is disabled Do not allow editing of this field. Used for

record numbers or for any field that should

not be changed.

Caps Field converted to capital

letters

Use for callsign fields or any field that should

be in upper case.

Add periods Adds two periods to

frequencies

10 meter CW example: 28.027.123

4.7 Spots

The Spots function connects to a Telnet spot cluster using your callsign.  Enter your callsign in

SETTINGS>Accounts>Account Editor.

Spot Settings list contains an extensive list of known DX Cluster Telnet sites. Click a site to use

it as a source for spots in the Spots window. Retain Time is the number of minutes before

spots are deleted from the Spots window list.

If you wish to use a site close to your location, the Spot Site Filter (Funnel) has selections for All

Clusters, Closest to Me, and My US State. Closest to me uses the Grid Square value entered for

the current account in Account Settings. The US two-letter abbreviation is also taken from

Account Settings.
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1.

Notes:

2. Spot clusters are not shown that 1) do not list a port number or 2) include a

reference to CW Skimmer spots.

3. Filter "Closest to me" uses the first two characters of the Grid Sq entered in

Account settings for the current account.

4. Filter "My US State" uses the 2-character state entered in Account settings for the

current account.

4.8 Band Filter

The Band Filter settings window provides a way to disable band selections in the Tuner and

Keyer windows.  For example, a KX3 with a 2-meter accessory board cannot operate on 6, 1.25,

70 or 23.  Select the bands you don't want activated.  In the Tuner and Keyer windows the

disabled bands are shown with a gray background.
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Click Enable All to enable all bands.

4.9 Mode Filter

The Mode Filter settings window provides a way to disable mode selections in the Tuner and

Keyer windows.  For example, you may not want to use the RTTYR mode.  Select the modes

you don't want activated.  In the Tuner and Keyer windows the disabled modes are shown with

a gray background.

Click Enable All to enable all modes.
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4.10 Slider Overrides

Depending on the capabilities of your radio, up to four sliders are shown on the Tuner window.

 The Slider Override settings can be used to set the maximum level for each slider, or disable

one or more completely.  The settings above indicate that the AF Gain can be set to a

maximum of 21% and the Pwr output can be set to 12 watts maximum.

Set a slider to 0 to disable it.  Set the slider to 100 to provide the full range.
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4.11 Macros

RSS provides 128 programmable macro keys in 4 banks of 32 each. The keys are available in

the Tuner and CW Keyer windows. Each macro has a space to enter a button caption and a

command.  The total length of all macros is 2000 characters per bank per account. Macros can

be used in a number of ways:

· CW messages

· Hamlib Commands

· Direct radio commands

· Open web pages

· Special commands

Macro Save/Restore

Each bank of macros can be saved and restored.  Use the "hamburger" icon button (upper

right) to save the current macro bank to the downloads folder or to restore a saved macro

bank.  The downloads folder is determined by the device or computer you are using to

connect to RigPi.  If you are using a desktop PC to connect to RigPi, macro banks are sent to

the downloads folder on the PC.  Select the Restore button to display a file explorer window to

find the macro bank file you want to restore.

Macro banks are downloaded as text (.txt) files.  You can modify macros in the .txt file using

any text editor.  The edited macro text file can then be uploaded to replace the current set.
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The last-used Macro Bank in the Tuner and Keyer windows are restored when you reopen

either window.
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CW Messages

CW Messages start with a $ character. The message can consist of ASCII printable characters,

special control characters, or a combination of both. RigPi Keyer and External WinKeyer share

the same control characters. The control characters are defined in the WinKeyer3 data sheet.

Click to see WinKeyer Programming Data

For example, one WinKeyer3 control character, 1bH, is used to combine consecutive characters

to create a prosign. The prosign BK is formed by the CW command $<1b>BK. This is a

combined ASCII printable and control character CW message.

A printable ASCII message might be $5NN TU for the signal report plus "Thank You."

Special CW keying characters that can be used in a RigPi Keyer or WinKeyer3 macro (prefaced

by $):

Character Result

'* Your call sign (apostrophe + asterisk)

'X DX call

<1b>AR AR

<1b>AA AA

<1b>BK BK

<1b>BT BT

<1b>CL CL

<1b>HH ERROR (........)

http://k1el.tripod.com/files/WK3_Datasheet_v1.pdf
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Character Result

<1b>KN KN

<1b>SK SK

<1b>AS AS (Wait)

<02>number

Set CW speed to 'number.'  To set the speed to 30 wpm, the command is

<02>30.  Use a value of 0 to set the speed to the last used speed in a

stacked speed macro.  

{<02>30}<02>20  sets the speed to 30 when a stacked speed macro

starts and 20 when the second part of the stacked macro is sent.

{<02>30}<02>0 sets the speed back to what it was before the macro was

started.

<18><00> Switch CW Keyer PTT off when PTT option is disabled in Keyer Settings.

<18><01> Switch CW Keyer PTT on when PTT option is disabled in Keyer Settings.

!ESC Stops a CW message that is being transmitted or stops the tune mode

!TUNE Key down (tap Tune again, or use ESC or CANCEL macro to stop)

<F1> Select K1EL Winkeyer output 1

<F2> Select K1EL Winkeyer output 2

<03> Enable Winkeyer Speed Pot for CW speed control

<04> Enable RigPi slider for CW speed control
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Hamlib Commands

RSS uses the Hamlib library to control radios and rotors. The library is documented online on

the Hamlib developer's web site.

Click to see Hamlib Rigctl commands

The rigctld utility is used for radio commands while the rotctld is used for rotor commands.

Preface rigctld and rotctld command with * (asterisk). For example, to create a macro to set the

main VFO frequency to 14.222.220 MHz, use the macro *F 14222220. Note the space between

the F and 1. Many commands return a value from the radio.  For example, the macro *f returns

the current main frequency from the radio.  Return values are shown in a modal alert box. If an

invalid command is used in a macro and error message is displayed.

Direct Radio Commands

A special Hamlib rigctld command, w, is used to send commands to radios when there is no

rigctld native command. For example, to set the squelch on an Elecraft KX3 to 50, use the

command *0w SQ050. The w command is prefaced by an asterisk and the number 0 or 1.

Some radio commands elicit a response, others don't. Use 0 for commands for which the radio

doesn't respond and 1 if a response is expected. The command shown in the Macro screen

shot sets the frequency of a Kenwood or Elecraft radio to 15 meters. *0w FA00021025000; 

Commands that return values from the radio show the resulting data in a modal dialog box. 

For example, *1w FA; returns the current main frequency from Kenwood and Elecraft radios.  If

an invalid command is used in a w custom command an error message is shown.

Some radios, such as Icom and many Yaesu radios, require the use of hex numbers in w

commands.  Use the notation \0xNN (NN=a valid hex number) for these radios.  Return values

will also be hex numbers and may not display in a meaningful way.

Stacking Macros

More than one macro can be inserted in a single macro slot.  For example, you can add a

mode macro to a frequency set macro. Hamlib and Direct Radio Commands (0w/1w) can be

stacked and mixed.

To add a second or additional macros to an existing macro, simply add the command and any

command prefixes.  Using Hamlib commands to set frequency, mode and passband, use this

format:

*F 14222220*M USB 3000

http://hamlib.sourceforge.net/html/rigctl.1.html
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This macro sets the radio frequency to 14.222220 MHz, the Mode to USB and the passband to

30000 Hz.  Here are some examples using Hamlib commands:

Command What Happens Note

*F 14055444*M CW 250 Tune radio to 14.055.444

CW with a passband of 250

Hz

Uses Hamlib commands

*S 1 VFOB*I 14058222 Set radio to split mode,

transmit on 14058222

Uses Hamlib commands

Latching Macros

Many radio commands set a state such as on and off, or you may wish to program a button

that toggles between two frequencies.  RigPi Macros use a special format to determine the

command for each state and the color used for a button that has been clicked.

{command1}command2+btn-color

The command in '{}' is the first command executed when the button is clicked.  This starts a

stacked command.

The color determines the color of the button when first clicked.

If you don't provide a color, "Info" is the default color.

Here are several samples of how to use a Latching Macro. 

Note that the button labels are for your reference only and are not use by RigPi.  For example,

the HAMLIB TEST (F) label could be HT-F or any other label of your choosing.  The Commands

must be precisely as shown.

Button label Command Notes

PWR ON/OFF {*PS1;}*PS0;+btn-danger Button is red ('danger') when power is

on.

HAMLIB TEST (F) {*F 21005000*M CW 250}*F

28074000*M PKTUSB 3000+btn-

Button is yellow ('warning') when

frequency is set to 21.025.000
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warning

SPEED {$<02>30}$<02>ZZ+btn-warning Set the base CW speed using the

Keyer window slider.  The base speed

replaces 'ZZ'.

Mic<>USB Icom {*0w

\0xFE\0xFE\0x94\0xE0\0x1A\0x05\0x

00\0x66\0x03\0xFD}*0w

\0xFE\0xFE\0x94\0xE0\0x1A\0x05\0x

00\0x66\0x00\0xFD+btn-danger

Icom radios, enable front panel mic

connector or rear panel USB connector

for audio.

RADIO AF MUTE {*L AF 0}*L AF XX+btn-danger Mute audio for this radio. The active

AF level replaces 'XX'.

RADIO USB MUTE {*L USB_AF 0;}*L USB_AF YY;+btn-

danger

Mute USB Audio for this radio. The

active USB AF level replaces 'YY'.

Web Commands

Macros can be created to open web sites in a new browser window.  Web commands start

with the slash character ("/").  The DX Call, band and mode can be embedded in the command.

 This is useful for opening QRZ.com to the DX Call, or opening DX Summit filtering on call,

band and mode.  You can create your own web commands for other sites.

Button label Command Notes

QRZ DX CALL /https://qrz.com/db/<dxcall> Look up 'dxcall' on QRZ

DXS BAND &

MODE

/http://dxsummit.fi/#/?

include=<band>&include_modes=<mode>

Look up all spots on DX

Summit for the current

band and mode

DXS DXCALL /http://dxsummit.fi/#/?dx_calls=<dxcall> Look up all spots on DX

Summit for the current

DX call

Function Key Shortcuts

Assign macros to F-keys for quick access from your keyboard.  Use a prefix of Fn: to assign F-

key n.  F2-F12 can be used. F1 is often used by browsers to open Help.  For example,

F3:$5NN TU
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assigns F3 to a CW macro that sends 5NN TU.

System Commands

System command macros are disabled by default since they can be a serious security risk. If

you aren't careful, you can issue commands that will damage important RSS files. If you wish to

experiment, uncomment the exec line in programs/systemExec.php. Be careful! Do NOT

enable this function  for security reasons if your RSS is accessible from the Internet.

Preface system commands with #. For example, to program a macro to reboot RSS, use the

command #sudo reboot.

Other Special Commands

Special '!' commands that can be sent using a macro key include the following:

Command What Happens

!BANK

Changes Macro Bank to the next higher bank.  Starts

over after bank 4.  Current bank is shown by selected

Macro Band button.

!T/R
Toggles Transmit/Receive (uses PTT Latch mode even

if PTT is set for Momentary)

!ROTATE

Turn your station rotor to the DX bearing. Add a

space+bearing to set to that bearing with no

interaction.  (Example: !ROTATE 33 sets bearing to 33

degrees.)

!RTR STOP Stop rotor immediately

{!ROTATE 180}!RTR STOP+btn-

danger

Latching macro that rotates the rotor to 180 (or any

other specified bearing), tap again to stop the rotor.
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Command What Happens

!PTTON

Turns on RigPi Keyer and Audio board PTT.  A radio

does not have to be connected.  If using this to

control an external power switch, turn off hardware

PTT in Advanced Radio settings>H/W PTT.

!PTTOFF

Turns off RigPi Keyer and Audio board PTT.  A radio

does not have to be connected. If using this to control

an external power switch, turn off hardware PTT in

Advanced Radio settings>H/W PTT.

!SWn

The the !SWn command, macros can control on and

off to up to 8 external devices through a special cable

(see below). (Use !SW0 to reset all 8 lines.)

!TUNER Engage internal tuner in radio.

!TUNETO
A dialog allows you to set a frequency, mode and

passband (bandwidth). See below.

Switching External Devices

Using the !SWn macro RigPi can control up to 8 external devices that can be turned on or off

with 5-volt signals.  For example, !SW1 can be used to turn on and off device 1. The macro

latches the current value, so successive taps turn the device on and off.  Use !SW0 to reset all

eight outputs.

This function requires a special USB cable:

FTDI C232HM (C232HM-EDHSL-0). This cable has 10 wires that can be used for interfacing to

other devices.  The FTDI cable can be purchased from Mouser Electronics.

 

Wire Signal 

Red VCC 



143

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Settings

Wire Signal 

Orange BIT/PIN 0 

Yellow BIT/PIN 1 

Green BIT/PIN 2 

Brown BIT/PIN 3 

Grey BIT/PIN 4 

Purple BIT/PIN 5 

White BIT/PIN 6 

Blue BIT/PIN 7 

Black GND 

IC-7610/IC-7300 Macros (tnx KK5VG)

Macro HEX COMMANDS

IC-7610 ON *1w \0xFE\0xFE\0x98\0xE0\0x18\0x01\0xFD

IC-7610 OFF *1w \0xFE\0xFE\0x98\0xE0\0x18\0x00\0xFD

NOISE REDUCTION ON *1w \0xFE\0xFE\0x98\0xE0\0x16\0x40\0x01\0xFD

NOISE REDUCTION OFF *1w \0xFE\0xFE\0x98\0xE0\0x16\0x40\0x00\0xFD

NOISE REDUCTION LEVEL 2 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x06\0x40\0xFD

NOISE REDUCTION LEVEL 6 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x06\0x1\0x10\0xFD

ROTOR

ROTOR STOP

NOTCH ON *1w \0xFE\0xFE\0x98\0xE0\0x016\0x41\0x01\0xFD

NOTCH OFF *1w \0xFE\0xFE\0x98\0xE0\0x016\0x41\0x00\0xFD

COMPRESSION ON *1w \0xFE\0xFE\0x98\0xE0\0x016\0x44\0x01\0xFD

COMPRESSION OFF *1w \0xFE\0xFE\0x98\0xE0\0x016\0x44\0x00\0xFD

PREAMP OFF *1w \0xFE\0xFE\0x98\0xE0\0x016\0x02\0x00\0xFD 

PREAMP 10 *1w \0xFE\0xFE\0x98\0xE0\0x016\0x02\0x01\0xFD

PREAMP 20 *1w \0xFE\0xFE\0x98\0xE0\0x016\0x02\0x02\0xFD

CHANGE MAIN / SUB *1w \0xFE\0xFE\0x98\0xE0\0x07\0xB0\0xFD
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ATTENUATOR OFF *1w \0xFE\0xFE\0x98\0xE0\0x11\0x00\0xFD

ATTENUATOR 6 DB *1w \0xFE\0xFE\0x98\0xE0\0x11\0x06\0xFD

ATTENUATOR 12 DB *1w \0xFE\0xFE\0x98\0xE0\0x11\0x12\0xFD

ATTENUATOR 18 DB *1w \0xFE\0xFE\0x98\0xE0\0x11\0x18\0xFD

VFO *1w \0xFE\0xFE\0x98\0xE0\0x07\0xFD

MEMORY *1w \0xFE\0xFE\0x98\0xE0\0x08\0xFD

ANTENNA 1 *1w \0xFE\0xFE\0x98\0xE0\0x12\0x0000\0xFD

ANTENNA 2 *1w \0xFE\0xFE\0x98\0xE0\0x12\0x0001\0xFD

RF -30%****************** *1w \0xFE\0xFE\0x98\0xE0\0x14\0x02\0x2\0x20\0xFD (???)

RF -50%****************** *1w \0xFE\0xFE\0x98\0xE0\0x14\0x02\0x1\0x90\0xFD (???)

RF 100%****************** *1w \0xFE\0xFE\0x98\0xE0\0x14\0x02\0x2\0x55\0xFD (???)

14.300 Mhz *F 14300000

50.525 Mhz *F 50525000

MONITOR ON *1w \0xFE\0xFE\0x98\0xE0\0x16\0x45\0X01\0xFD

MONITOR OFF *1w \0xFE\0xFE\0x98\0xE0\0x16\0x45\0X00\0xFD

RESET

NOISE BLANKER ON *1w \0xFE\0xFE\0x98\0xE0\0x16\0x22\0x01\0xFD

NOISE BLANKER OFF *1w \0xFE\0xFE\0x98\0xE0\0x16\0x22\0x00\0xFD

DUAL WATCH ON *1w \0xFE\0xFE\0x98\0xE0\0x7\0xC1\0xFD

DUAL WATCH OFF *1w \0xFE\0xFE\0x98\0xE0\0x7\0xC0\0xFD

PBT IN +150 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x08\0x01\0x55\0xFD

PBT OUT -150 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x08\0x1\0x00\0xFD

PBT IN .0 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x07\0x01\0x30\0xFD

PBT OUT .0 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x08\0x01\0x30\0xFD

COMPRESSION LEVEL 3 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0E\0X00\0x0270\0xFD

COMPRESSION LEVEL 5 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0E\0X01\0x0220\0xFD
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COMPRESSION LEVEL 7 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0E\0X01\0x0265\0xFD

COMPRESSION LEVEL 10 *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0E\0X02\0x055\0xFD

RF POWER 8W *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0A\0x00\0x21\0xFD

RF POWER 25W *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0A\0x00\0x65\0xFD

RF POWER 50W *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0A\0x01\0x30\0xFD

RF POWER 75W *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0A\0x01\0x93\0xFD

RF POWER 100W *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0A\0x02\0x55\0xFD

MIC GAIN 25% *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0B\0x00\0x0165\0xFD

MIC GAIN 50% *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0B\0x01\0x0230\0xFD

MIC GAIN 75% *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0B\0x01\0x0193\0xFD

MIC GAIN 100% *1w \0xFE\0xFE\0x98\0xE0\0x14\0x0B\0x02\0x0055\0xFD

AGC SLOW *1w \0xFE\0xFE\0x98\0xE0\0x16\0x12\0x03\0xFD

AGC MID *1w \0xFE\0xFE\0x98\0xE0\0x16\0x12\0x02\0xFD

AGC FAST *1w \0xFE\0xFE\0x98\0xE0\0x16\0x12\0x01\0xFD

MANUAL NOTCH - ON *1w \0xFE\0xFE\0x98\0xE0\0x16\0x48\0x01\0xFD

MANUAL NOTCH - OFF *1w \0xFE\0xFE\0x98\0xE0\0x16\0x48\0x00\0xFD

MANUAL NOTCH WIDTH - WID *1w \0xFE\0xFE\0x98\0xE0\0x16\0x57\0x00\0xFD

MANUAL NOTCH WIDTH - MID *1w \0xFE\0xFE\0x98\0xE0\0x16\0x57\0x01\0xFD

MANUAL NOTCH WIDTH - NAR *1w \0xFE\0xFE\0x98\0xE0\0x16\0x57\0x02\0xFD

MACRO HAMLIB COMMANDS

IC-7610 ON *PS1;

IC-7610 OFF *PS0;

NOISE REDUCTION ON *U NR 1

NOISE REDUCTION OFF *U NR 0
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NOISE REDUCTION LEVEL 2 *L NR .2

NOISE REDUCTION LEVEL 6 *L NR .6

ROTOR !ROTATE

ROTOR STOP !RTR STOP

NOTCH ON *U ANF 1

NOTCH OFF *U ANF 0

COMPRESSION ON *U COMP 1

COMPRESSION OFF *U COMP 0

PREAMP OFF *L PREAMP 0

PREAMP 10 *L PREAMP 10

PREAMP 20 *L PREAMP 20

CHANGE MAIN / SUB

ATTENUATOR OFF *L ATT 0

ATTENUATOR 6 DB *L ATT 6

ATTENUATOR 12 DB *L ATT 12

ATTENUATOR 18 DB *L ATT 18

VFO *V VFO

MEMORY *V MEM

ANTENNA 1 *A 0

ANTENNA 2 *A 1

RF -30% *L RF .26

RF -50% *L RF .51

RF 100% *L RF 1.0

14.300 Mhz *F 14300000*M USB 2500

50.525 Mhz *F 50525000*M USB 2500

MONITOR ON *U MON 1

MONITOR OFF *U MON 0

RESET

RESET IS A LIST OF
COMMANDS (IN ONE MACRO)

*U COMP 0*U NR 0*V VFO*ANF 0*L RF 1.0*U MON 0*A 1*L
PREAMP 0*L ATT 0*Y 1*U NB 0*U DUAL_WATCH 0*L PBT_IN .50*L
PBT_OUT .50*L MICGAIN .51*U MN 0*L RFPOWER 1.0*L AGC 5



147

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Settings

THAT CLOSE THE COMMANDS
THAT I MIGHT HAVE OPENED. 

NOISE BLANKER ON *U NB 1

NOISE BLANKER OFF *U NB 0

DUAL WATCH ON *U DUAL_WATCH 1

DUAL WATCH OFF *U DUAL_WATCH 0

PBT IN +150 *L PBT_IN .60

PBT OUT -150 *L PBT_OUT .60

PBT IN .0 *L PBT_IN .50

PBT OUT .0 *L PBT_OUT .50

COMPRESSION LEVEL 3 *L COMP .3

COMPRESSION LEVEL 5 *L COMP .5

COMPRESSION LEVEL 7 *L COMP .7

COMPRESSION LEVEL 10 *L COMP 1.0

RF POWER 8W *L RFPOWER .08

RF POWER 25W *L RFPOWER .26

RF POWER 50W *L RFPOWER .51

RF POWER 75W *L RFPOWER .76

RF POWER 100W *L RFPOWER 1.0

MIC GAIN 25% *L MICGAIN .26

MIC GAIN 50% *L MICGAIN .51

MIC GAIN 75% *L MICGAIN .76

MIC GAIN 100% *L MICGAIN 1.0

AGC SLOW *L AGC 3
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AGC MID *L AGC 5

AGC FAST *L AGC 2

MANUAL NOTCH - ON *U MN 1

MANUAL NOTCH - OFF *U MN 0

MANUAL NOTCH WIDTH - WID

MANUAL NOTCH WIDTH - MID

MANUAL NOTCH WIDTH - NAR

TUNE TO Macro

Use the TUNE TO macro to set the frequency, mode and bandwidth for your radio.  When you

leave that band and come back later, the frequency, mode and bandwidth you originally set are

restored.  Before using TUNE TO, RigPi uses the defaults for you radio, not necessarily what they

were set to before starting RigPi.

Enter any valid bandwidth in the Passband box or select from the drop-down list.  Some new radios

provide continuous passband setting instead on Narrow, Normal and Wide.  RigPi suggests

bandwidths in the drop-down list, or you can enter a passband manually.  Leave "Current=" and

change the passband.  For example, to change the passband to 3600, you will see "Current=3600"

after adding 3600.

If you enter a bandwidth the radio doesn't support, RigPi reverts to the "Normal" setting.

   

4.12 System

System Settings provides information about system aspects of RSS and buttons to reboot

RigPi or shut it down. System Settings is only available for Access Level 1 accounts.
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Reboot RigPi Restarts RigPi. Any active user accounts must be restarted along with

connecting radios.

Shut Down RigPi Use the Shut Down button before disconnecting power to RigPi. Wait

for the green activity light to stop blinking for proceeding. Not doing

so could damage the RigPi memory card.

Get FCC Database Refreshes the FCC callsign lookup database loaded on RigPi. The

refresh process takes about 15 minutes to complete. Note the entire

FCC database is updated by the FCC once per week.

LAN IP 1 RSS can connect to the Internet through Ethernet and/or Wi-Fi. If only

Ethernet or Wi-Fi is used, LAN IP 1 is the IP address for that

connection. Use LAN IP 1 for the LAN IP if you are setting up port

forwarding in your Internet router.

LAN IP 2 If RSS is connected to the Internet through an Ethernet connection

and through Wi-Fi, the Ethernet connection is shown in LAN IP 1 and

the Wi-Fi address is shown in LAN IP 2.

WAN IP WAN IP is the public IP of your connection to the Internet. This is the

IP you can use to connect to RSS when away from home. You must

set up port forwarding in your router for RSS and Mumble to operate

remotely.

RPi Temp Shows the temperature of the CPU chip on the Raspberry Pi. The core

temperature goes up as the Raspberry Pi gets more heavily loaded.

The maximum operating temperature is rated for 80-deg C. If the
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temperature goes above 85-deg, the CPU is throttled. Normally you

will see the temperature under 50-deg C.  The K1EL RigPi case has a

fan that will keep the CPU cool.

Rigctl Port The port used to control the radio for the current account. Use this

port number if connecting to another application (such as Fldigi) and

you want to have both RSS and the other application control the

radio. You can also use this number to connect a second (or more)

accounts to the current radio. Enter the port number in the Port field

in Basic or Advanced Radio settings.

CCM Port The port used to connect CommCat Mobile or CommCat to RSS to

control the current radio.

RSS Vers The current RSS version number

Update RSS Files Update the RSS files to the most recent version. The update is a two-

step process. The first step checks version numbers. If the version

check shows an update is available, the second step installs the files

from the RigPi web site. See Update RSS Files in Other Programs.

Get RSS Stats Provides a brief summary of RSS Statistics, including time since last

reboot, number of connected users, and system loading.

4.13 Scheduler

RigPi Scheduler is the settings window for RigPi Calendar.  Scheduler provides a way to add

events to Calendar for any day of the year.  Events include reservations for rig use and custom

events such as club meetings or skeds. You can overlay the Scheduler with event lists from

external sources.
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< Go to previous month (or week/day/list delending on selected clanedar

format).

> Go to next month (or week/day/list depending on selected calendar

format).

today Show current month, week, day or list for current day.

month/week/day/lis

t

Select calendar range.

Users A list of users, including radio name, call, and username.  Drag a user bar

to the desired date to schedule.

Add Add custom events.

Yellow day Current day.

The "hamburger" button in the upper right corner of the Scheduler has additional options:

· Add a calendar overlay for ham contests and holidays.

· Remove all events.

· Remove custom events.
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Selecting Digital Contests adds the digital contest overlay to the calendar.  Each digital contest

use a lavender color.  A bar indicates an event lasting all day, while an event occurring at a

specific time in the date has a colored dot.

custom.ics Swedish calendar iCalShare.com

cw.ics Ham CW contests DL2NBY

digital.ics Ham digital contests DL2NBY

phone.ics Ham phone contests DL2NBY

Events_in_Hi

story.ics

Events in US history americanhistorycalendar.com

JapanHolida

ys.ics

Japanese holidays
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SwedishHoli

days.ics

Swedish Holidays (duplicate of

custom)

iCalShare.com

UKHolidays.i

cs

UK Holidays iCalShare.com

us_hol.ics US Holidays https://www.thunderbird.net/en-

US/calendar/holidays

Reserving a time slot

Each user account can be given reservations with start and end times.  The RigPi Log In

window shows current and upcoming reservations.

The video, below, shows a user bar being moved to a day.  Without further action, the radio

associated with that account will be reserved for the full day.

Drag User Bar to Make a 1-day Reservation

To set a specific time slot during the day for an event, open the day view and navigate to the

day you want to edit.  Drag the bar from the top to the starting time, then drag the bottom of

the bar to the ending time.
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5 Other Programs

Additional Ham software provided with RigPi Station Server is accessed through the Raspbian

PIXEL Desktop. Click Pi Menu>Ham Radio to access the added ham programs.

Mumble, WSJT-X and Fldigi use the Raspberry Pi audio system, either through CODECs in the

radio or through the MFJ RigPi Audio board.  Only one program can use the audio system at a

time.  Close Mumble before using WSJT-X or Fldigi.

Using RigPi Station Server with WSJT-X

WSJT-X is designed to provide reliable communications in extreme weak-signal conditions.

WSJT-X, written by Joe Taylor, K1JT, is installed on RigPi Server. Frequency and Mode data are

shared between RigPi and WSJT-X, and QSO information logged in WSJT-X is automatically

transferred to RigPi Log.

To start WSJT-X, from the Raspberry Pi Desktop, open the applications menu and select Ham

Radio>wsjtx. The first time you start WSJT-X you are invited to enter your callsign and Grid

locator.

Connect to a radio from the File>Settings>Radio panel. Start RigPi Station Server and connect

the radio. Use the following values:

1. Rig: Hamlib NET rigctl

2. Network Server: localhost: 4532. The port will be different depending on which RSS account

you are using. Radio 1 uses port 4532, radio 2 uses port 4534, and so on.

3. Audio: If using a radio that has CODECs, choose the alsa_input and alsa_output devices in

the Input and Output drop-down lists in WSJT-X File>Settings>Audio>Soundcard.  (The

CODECs in your radio may have a different name.)

If using the RigPi Audio board (your radio doesn't have CODECs), make the following

selections:

If you use incorrect audio devices, WSJT-X will display a dialog warning of a problem:
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Some selections may not display an error at first, but after clicking Tune, then restarting WSJT-

X, the following error appears:

This issue appears to be present in WSJT-X 2.4.  You must reboot RigPi to clear the error

before resetting the audio device selection.

Some radios do not have a PTT-by-CAT function.  Select Hamlib GPIO in the H/W PTT drop

down list in Advanced Radio settings for PTT.  The CAT PTT setting is not used when you use

Hamlib GPIO for PTT.

WSJT-X Manual: Click to open WSJT-X manual

WSJT-X User Forum:  User Forum

http://physics.princeton.edu/pulsar/k1jt/wsjtx-doc/wsjtx-main-1.7.0.html
https://groups.yahoo.com/neo/groups/wsjtgroup/info
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Using RigPi Station Server with Fldigi

Fldigi is a multi-mode digital communications program, written by Dave Freese, W1HKJ and

team.

1. Rig: Hamlib NET rigctl

2. Audio: Configure>Sound Card>Audio>Devices. use the audio selections as used in WSJT-X,

above.  Check Device supports full duplex.

Fldigi Manual: Fldigi Manual

Fldigi User Forum: User Forum

Logging WSJT-X and Fldigi contacts

When RigPi is controlling your radio, contacts logged in WSJT-X or Fldigi are transferred to

your RigPi log.  In SETTINGS>Accounts>Account Editor, put checks in the Sync boxes as

desired.

Using TQSL for LoTW Uploads

LoTW/TQSL Manual: tQSL Quick Start

LoTW/TQSL User Forum: tQSL Forum

5.1 Overview

Additional ham radio programs are installed on RSS. The Other Programs topic provides

information that relates to RSS and the program. For complete Help for each program, please

refer to the respective program's web site.

Most of these programs are provided on an 'as-is' basis.  Support for configuring, using and

updating these programs is provided by the program authors and their user communities.

§ WSJT-X

§ JS8Call

§ Fldigi

§ Flrig

§ Flarq

§ Message Aggregator

http://www.w1hkj.com/FldigiHelp/
https://linuxham.groups.io
http://www.arrl.org/quick-start-tqsl
https://groups.io/g/ARRL-LoTW
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§ TrustedQSL (TQSL)

§ Motion (Video)

§ Mumble Autostart

§ RSS Updater

§ phpMyAdmin

§ Audacity

§ Alsamixer

§ Nano

5.2 Alsamixer

RigPi Audio doesn't have settings of its own, but a Linux utility named Alsamixer is included

with RSS for that purpose. You can also use the Audio Device Settings window opened from

the Raspberry Pi Desktop applications menu found in the Preferences menu item. The driver

used for RigPi Audio is snd_rpi_proto. 

To start Alsamixer go to RSS Desktop and open the Terminal. Type alsamixer followed by

return.  The screen shot below shows the typical settings for the RigPi Audio board set up for

Mic input.

· Left and right arrow keys select a setting

· M key toggles MM-OO settings

· Tab to change View (Playback, Capture, All)

· Up and Down arrow keys to change levels

RigPi Audio uses the Line or Mic Input depending on settings. The Line Input accommodates

input voltages up to 2-volt peak-to-peak. The Mic input is for input levels up to .2-volt peak-

to-peak.  The Line input uses the left channel, it is not stereo.  Input from the I/Q jack is stereo

as required for Panadapters.
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5.3 Claws Mail

Claws Mail is a light-weight email client providing a way to send and receive email.  Claws Mail

is not installed by default.

To install Claws Mail, go to Application Menu>Preferences>Recommended Software>Internet.

5.4 Connecting to RSS from External Programs

Connecting Multiple Programs to RSS

RSS combined with popular logging programs provides another layer of flexibility. The screen

shot below shows RSS, CommCat (no longer published) and PowerSDR running on Windows. 

All programs are linked together. Not shown is CommCat Mobile running on an iPad also

connected to RSS.  

Important note:  CommSoft's CommCat and CommCat Mobile have been discontinued as of

October, 2020.  If you have CommCat or CommCat Mobile you can continue to use them with

RigPi.  CommCat and CommCat Mobile are not required for RSS.  It is best to connect to RSS

using a browser.

A frequency change in one program is reflected by all programs.

PowerSDR and other programs such as N1MM and HRD are connected to RigPi through a free

Virtual Port program called RigPi Hub. This program is available for download from

https://www.rigpi.net. Here are the details on how this is done.

https://www.rigpi.net
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The Kenwood TS-2000 CAT command set is used to connect CommCat to RSS via a separate

TCP connection through a local network. The use of "TS-2000," below, is used for this purpose

even though you may be controlling a completely different radio through RSS.

1. Open RSS in a Windows browser. RSS is controlling the radio.

2. Start RigPi Hub.

3. Start PowerSDR and connect as a TS-2000 to a RigPi Hub COM port.

RSS, RigPi Hub, and PowerSDR all show the same frequency and mode. Each can control the

radio connected to RSS.

5.5 Contour ShuttleXpress

The Contour ShuttleXpress provides a convenient way to adjust the RigPi frequency and

control PTT using a Windows or Mac computer through a USB port.  (A ShuttleXpress driver is

not available for Linux.)  RigPi Preference files used to assign buttons and controls are

provided for Chrome, Edge and Firefox browsers.

1. Download and install the Windows or Mac Driver program:

https://www.contourdesign.com/shuttle-drivers/

2. Download and unzip the RigPi Shuttle preferences file:

https://rigpi.net/downloads/RigPi-ShuttleXpress.zip

3. Start the Contour Shuttle Configuration Program (Windows)

https://www.contourdesign.com/shuttle-drivers/
https://rigpi.net/downloads/RigPi-ShuttleXpress.zip
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4. Decide which browser you want to use, Chrome, Edge or Firefox.  (If you want to another

browser, you can create your own preferences file using instructions in the ShuttleXpress

manual:

https://mk0uniclone3cn8yi1ru.kinstacdn.com/wp-content/uploads/2019/02/shuttle-

product-manual.zip

5. Browser preferences are already included in the Application setting list.  The one you want

to use must be deleted, and the corresponding RigPi preferences file imported.  For

example, if you want to use Chrome to control RigPi, delete the Google Chrome entry in

the list.

6. Import the RigPi preferences file you want to use from the Options menu.

7. When your selected browser is in front the RigPi buttons and controls can be used.

https://mk0uniclone3cn8yi1ru.kinstacdn.com/wp-content/uploads/2019/02/shuttle-product-manual.zip
https://mk0uniclone3cn8yi1ru.kinstacdn.com/wp-content/uploads/2019/02/shuttle-product-manual.zip
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5.6 Fail2Ban

Fail2ban, included with RigPi is an open-source intrusion prevention software that helps

protect Linux-based systems from malicious attacks by monitoring log files and automatically

taking action against potential threats. It works by detecting patterns of suspicious or

unauthorized activity in log files and then blocking or banning the IP addresses associated with

those activities.

Here's how Fail2ban typically operates:

1. Log File Monitoring: Fail2ban continuously monitors log files (e.g., system logs, web server

logs, SSH logs) for specific patterns or events that indicate malicious activities such as failed

login attempts, brute-force attacks, or other suspicious behavior.

2. Pattern Matching and Filters: Fail2ban uses regular expressions and predefined filters to

analyze log entries and identify patterns of malicious activity. These filters define what

constitutes a security breach or violation.

3. Ban Actions: Once a pattern is detected, Fail2ban takes action by temporarily or

permanently blocking the offending IP address or range of addresses associated with the

suspicious activity. This prevents further access from those sources.

4. Dynamic Ban Duration: Fail2ban typically imposes a temporary ban on the banned IP

address for a configurable period. This dynamic ban duration helps protect against repeated or

prolonged attacks.

5. Ban Actions Configuration: Fail2ban provides flexibility in defining the actions to be taken

upon detection of malicious activity. This can include blocking IP addresses via firewall rules

(e.g., iptables), sending notifications, or executing custom scripts.

6. Monitoring and Unbanning: Fail2ban keeps track of banned IP addresses and can

automatically remove bans after the specified ban duration expires. It also provides tools for

manual management, allowing administrators to unban specific IP addresses if necessary.

Fail2ban is commonly used to enhance the security of Linux servers, protecting services such as

SSH, FTP, web servers, and more. By automatically detecting and responding to malicious

activities, Fail2ban helps mitigate the risk of unauthorized access and potential system

compromise.

Here is a simple guide to using fail2ban:

1. Configure Fail2ban:

   - Open the Fail2ban configuration file using the nano text editor:
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     sudo nano /etc/fail2ban/jail.local

   - Customize the configuration based on your needs. Some important settings to consider:

     - `ignoreip`: Specify IP addresses or ranges to exclude from banning.

     - `bantime`: Set the duration (in seconds) for which an IP address is banned.

     - `maxretry`: Define the maximum number of login attempts allowed before an IP is

banned.

     - Configure jail sections for the services you want to protect (e.g., SSH, Apache, etc.). Each

jail section contains settings specific to that service.

   - Save the configuration file and exit the text editor.

2. Enable and Start Fail2ban:

   - Enable Fail2ban to start automatically on system boot:

     sudo systemctl enable fail2ban

   - Start the Fail2ban service:

     sudo systemctl start fail2ban

3. Monitor Fail2ban:

   - Check the status of Fail2ban to ensure it is running without errors:

     sudo systemctl status fail2ban

   - Monitor the logs for any banned IP addresses or other relevant information:

     sudo tail -f /var/log/fail2ban.log

4. Customize Actions (Optional):

   - Fail2ban provides various actions that can be customized, such as sending email

notifications or executing custom scripts. You can modify these actions in the configuration file

(`jail.local`) or create additional action files in the `action.d` directory.

6. Testing:

   - You can test Fail2ban by intentionally triggering a banned action, such as attempting

multiple failed SSH login attempts. Make sure to do this from a different IP address to avoid

accidentally banning yourself.

That's it! Fail2ban will now monitor your system logs and automatically ban IP addresses that

match the configured patterns. You can further customize Fail2ban's behavior and explore
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advanced options as needed. Remember to periodically review Fail2ban's logs and adjust the

configuration based on your system's requirements.

5.7 Fan Control

RigPi 4 supports temperature sensitive PWM fan control through GPIO physical pin 32.  The

software for Fan Control can be found here:  

 https://github.com/mattrude/raspberrypi-fan-manager/

This is a C program.  The source code is provided in /home/pi/raspberrypi-fan-control.  It is set

to turn the fan on when the temperature reaches 52C and off when the temperature drops

below 45C.  There is an option to set the GPIO pin number.  The PWM pin number must be set

in /boot/config.txt.  Instructions are provided in README.md.

Fan Control starts when the Raspberry Pi boots.

The K1EL RigPi Keyer board has two pins through which a fan is connected,

5.8 Flarq

FLARQ, also known as Fast Light Automatic Repeat reQuest, is a software utility that works in

conjunction with the Fldigi application. FLARQ is designed to enhance the reliability of data

transmissions over radio by implementing an automatic repeat request (ARQ) protocol.

The ARQ protocol is a mechanism used to ensure error-free data transmission in the presence

of noise, interference, or weak signal conditions. It involves the automatic retransmission of

data packets that are either corrupted or lost during transmission. This process continues until

the packets are received correctly or until a predefined number of retransmissions is reached.

FLARQ integrates with Fldigi to provide a robust ARQ capability for digital communication. It

enables reliable exchange of text messages, files, and other data over radio frequencies using

various digital modes supported by Fldigi.

Here's a brief overview of how FLARQ works:

1. Data transmission: Fldigi encodes the data into the chosen digital mode and transmits it

over the radio using the computer's sound card.

2. Reception and verification: FLARQ running in FLdigi's ARQ mode receives the data and

verifies its integrity by performing error checking and correction.

3. Acknowledgment and retransmission: If errors are detected, FLARQ sends an

acknowledgment signal to the sender, requesting retransmission of the corrupted or lost data

https://github.com/mattrude/raspberrypi-fan-manager/
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packets. FLARQ also keeps track of the sequence of packets to ensure proper order upon

reception.

4. Retransmission process: The sender, upon receiving the acknowledgment, retransmits the

requested data packets until they are successfully received by the recipient. The process

continues until all data packets are error-free or the maximum number of retransmissions is

reached.

FLARQ significantly improves the reliability of digital communication by automatically handling

errors and ensuring the successful delivery of data. It is particularly useful in amateur radio

applications where signal conditions may vary, and reliable transmission is essential.

See the Flarq web site for more information.

Flarq Web Site

5.9 Fldigi

Fldigi is a popular open-source software application designed for amateur radio digital

communications. It stands for "Fast Light Digital modem application" and was developed by

Dave Freese (W1HKJ) and his team. Fldigi is available for multiple platforms, including

Windows, macOS, and Linux.

Fldigi offers a comprehensive set of features for transmitting and receiving various digital

modes over radio frequencies. It utilizes a computer's sound card to convert audio signals to

digital data and vice-versa. Some of the digital modes supported by Fldigi include:

1. CW (Morse code): Fldigi can send and receive Morse code signals using the computer's

sound card as a keyer.

2. BPSK and QPSK: These are phase-shift keying modes used for sending data signals.

3. RTTY: Fldigi supports various RTTY (Radio Teletype) modes, including ASCII, Baudot, and

AMTOR.

4. PSK31: A popular digital mode for text-based communication using phase-shift keying.

5. Olivia: A robust digital mode that provides good performance under weak signal conditions.

6. MFSK: Multiple Frequency Shift Keying mode suitable for keyboard-to-keyboard

conversations.

http://www.w1hkj.com/
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Fldigi offers features such as signal decoding, error correction, frequency shifting, and audio

filtering. It also includes tools for signal analysis, logging, and integrating with other software

applications.

Fldigi is widely used by amateur radio operators around the world for various purposes,

including emergency communications, contesting, experimenting with digital modes, and

general communication. It provides a flexible and versatile platform for digital radio

communication enthusiasts.

 Detailed instructions are beyond the scope of this manual, please refer to the Fldigi web site:

Fldigi Web Site

This Help topic covers use of Fldigi in RSS.

Radio Connection

RSS and Fldigi both use the Hamlib radio control library. Using the Hamlib "Net rigctl" radio

selection in Fldigi it is possible to have both RSS and Fldigi control the radio.

Connect RSS to your radio in SETTINGS>Radio. Go to Fldigi Configuration>Rig>Hamlib. Select

Hamlib NET rigctl (Beta) for Rig and localhost:<RSS Port> for Network Server. You can now

control frequency from Fldigi or RSS.

The <RSS port> is determined by the account you wish to use in RSS.. Use the port number

shown in RSS SETTINGS>Radio>Rigctl Port.

Logbook Connection

Contacts logged in Fldigi are automatically transferred to the active log in RSS for the account

specified by the sync option in RSS SETTINGS>Users>Edit>Sync Fldigi Log.

Audio Connection

RigPi Audio or a radio CODEC is used for input and output audio for Fldigi. Since Audio is

limited to one application at a time, make sure the Mumble Client used for VoIP is not running.

Choose the audio capture and output devices in the Capture and Playback drop-down lists in

Fldigi Configuration>Audio associated with your setup.

Use these settings:

http://www.w1hkj.com/
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Using RigPi Keyer with Fldigi

Fldigi supports the K1EL Winkeyer for sending CW.  To configure RigPi Keyer, go to

Configure>Config Dialog>Modem>CW>WinKeyer.  Select /dev/ttyS0 for the Ser Port.   Select

other options as desired,  then click Connect.  The indicator light in the Connect button turns

yellow, and "Connected ti Winkeyer h/w/version 30" is displayed in Fldigi.  You can now use

Fldigi to send CW through the RigPi Keyer.  (Note: Fldigi will report that Winkeyer version 31

or higher is required to use the RigPi Keyer for the Fldigi TTY mode if an older chip is found.)

5.10 Flic Switch and iOS Shortcuts

Flic is a remote control switch that uses Bluetooth for communicating with phones, tablets, and

Mac computers. For purchase a Flic or more information go to: 

https://flic.io

https://flic.io
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The Flic has three modes: single, double, and long tap.  Below are the steps to take to program

a Flic for PTT on, PTT off, Power on and Power off.  You do not need a Flic Hub for RigPi

although using one means you don't have to use a phone or tablet at home.  Four actions are

described below, but the Flic has three modes.  You can use more than one Flic to create

combinations of actions.

1. Download the Flic app from the App store (for Apple devices) and the Play store (for

Android devices.

2. Agree to accept Notifications

3. Agree to the Terms of Service

4. Create an Account

5. Tap the PHONE tab at the top

6. Click Add Flic to Phone

7. Tap and hold the Flic until it connects

8. Tap Finish

You will see "My Flic" on your screen.

1.  Tap My Flic

2.  Change the name to RigPi

PTT On
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1.  Tap the red + button to enter a new Click action for PTT On

2.  Scroll down, open Advanced, and select Internet Request

3.  Add this URL*:

http://rigpi4.local/flic.php?n=1&u=<admin> 

4.  Tap your Flic once to send the PTT On command to your radio

PTT Off

1.  Tap the red + button to enter a new Double Click  action for PTT Off

2.  Scroll down, open Advanced, and select Internet Request

3.  Add this URL*: 

http://rigpi4.local/flic.php?n=2&u=<admin> 

(Substitute your username for admin)

4.  Tap your Flic twice to send the PTT Off command to your radio

Power On

1.  Tap the red + button to enter a new Hold action for Power On

2.  Scroll down, open Advanced, and select Internet Request

3.  Add this URL*:

 

http://rigpi4.local/flic.php?n=3&u=<admin> 

(Substitute your username for admin)

4.   Tap, double-tap, or hold to send the Power On command to your radio

Power Off

1.  Tap the red + button to enter a new Hold action for Power Off

2.  Scroll down, open Advanced, and select Internet Request

3.  Add this URL*: 

http://rigpi4.local/flic.php?n=4&u=<admin> 

(Substitute your username for admin)

4.  Tap, double-tap, or hold to send the Power Off command to your radio

Control Relay (see Relay Switching  )185



171

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Other Programs

1.  Tap the red + button to enter a new Tap action for Toggle Relay

2.  Scroll down, open Advanced, and select Internet Request

3.  Add this URL*:

 

http://rigpi4.local/flic.php?n=5&u=<admin>&p=n

(Substitute your username for <admin>, n is relay parameter x-y. X is the relay

number, y is 1 for relay on and 0 for relay off. 0-0 resets all relays. 9-1 turns on all

relays.)

4.  Tap to send the Toggle Relay command to RigPi

Send CW message

1. Tap the red + button to enter a new Tap action for Toggle Relay

2. Scroll down, open Advanced, and select Internet Request

3. Add this URL*:

http://rigpi4.local/flic.php?n=6&u=<admin>&p=<cw message>

(Substitute your username for admin, <cw message> is the desired CW text.)

4. Tap to send the CW Message command to RigPi

Frequency

1. Tap the red + button to enter a new Tap action for Toggle Relay

2. Scroll down, open Advanced, and select Internet Request

3. Add this URL*:

http://rigpi4.local/flic.php?n=7&u=<admin>&p=<frequency>

(Substitute your username for admin, <frequency> is the desired frequency to the

nearest Hz.)

4. Tap to send the Set Frequency command to RigPi

Set to FT8 on Band

1. Tap the red + button to enter a new Tap action for Toggle Relay

2. Scroll down, open Advanced, and select Internet Request

3. Add this URL*:

http://rigpi4.local/flic.php?n=6&u=<admin>&p=<cw
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/http://rigpi4.local/flic.php?n=8&u=<admin>&p=<band>

(Substitute your username for <admin>, <band> is the desired band, such as 80, 40,

or 20.)

4. Tap to send the Toggle FT8-on-Band command to RigPi

* The URL rigpi4.local is not recognized by Android devices.  Use the IP for RigPi instead.  The

IP can be found in RigPi>SETTINGS>System.

Use rigpi4.local or the RigPi IP when using Flic on the same network as RigPi.  For the Flic to

work when away from home, use the WAN IP shown in SETTINGS>System.  You may want to

use a second Flic for use when away from home.  Port 80 must be opened in your router to use

Flic away from home.

iOS Shortcuts

Apple iOS devices have a feature called Shortcuts.  Shortcuts can be used to trigger actions,

the same as Flic switches.  The same command strings are used.

     

Use iOS shortcuts on your local LAN without port  forwarding.  If you want to use Shortcuts

away from home, use your WAN (Internet) IP and open port 80 for forwarding.
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5.11 Grig

Grig is a simple graphical user interface (GUI) for controlling radios using the Hamlib radio

control library. It provides an easy way to interact with supported transceivers via a computer,

allowing users to adjust frequency, mode, and other settings.

Key Features of Grig:

· Supports Hamlib, which enables control of many different radios.

· Provides a lightweight and easy-to-use GUI.

· Allows basic rig control functions such as frequency tuning, mode selection, and PTT

(Push-to-Talk) control.

Use Cases:

· Digital Modes: Works with software like RigPi FLDigi and WSJT-X.

· Remote Operation: Control your transceiver from a different location.

· Automation & Logging: Helps integrate with logging software for contesting or

general QSO logging.

You can start Grig from the Raspberry Pi Run menu with optional parameters to customize its

behavior. Here are the key parameters:

Basic Usage:

grig [options]

Common Parameters:

Option Description

-m <model> Sets the radio model number (as defined in Hamlib).

-r <device>
Specifies the serial port or IP address (e.g., /dev/ttyUSB0 or

192.168.1.100).

-s <baud> Sets the serial baud rate (e.g., 9600, 115200).

-c <id> Specifies the radio configuration string.
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-d Enables debug output.

-h Displays help information.

Example Commands:

1. Start Grig with an Icom IC-7300 connected via USB:

grig -m 3073 -r /dev/ttyUSB0

2. Enable debugging output:

grig -d

5.12 JS8Call

JS8Call is a derivative of the WSJT-X application, structured and redesigned for message

passing.  It is not supported by, nor endorsed by, the WSJT-X development group.

This Help topic covers use of JS8Call in RSS.

Radio Connection

RSS and JS8Call both use the Hamlib radio control library. Using the Hamlib "Net rigctl" radio

selection in JS8Call it is possible to have both RSS and JS8Call control the radio.

Connect RSS to your radio in SETTINGS>Radio. Go toJS8Call File>Settings>Radio. Select

Hamlib NET rigctl for Rig and localhost:<RSS Port> for Network Server. You can now control

frequency from JS8Call or RSS.

The RSS port is determined by the account you wish to use in RSS. Use the port number shown

in RSS SETTINGS>Radio>Rigctl Port.

Logbook Connection

Contact logged in JS8Call are automatically transferred to the active log in RSS for the account

specified by the sync option in RSS SETTINGS>Users>Edit>Sync WSJTX Log. Log data are

transferred using the N1MM Logger+ Broadcasts options in JS8Call12060

File>Settings>Reporting. RSS expects a connection on N1MM Server port number 12060.

Audio Connection

RigPi Audio or radio CODECs are used for input and output audio for JS8Call. Since Audio is

limited to one application at a time, make sure Mumble used for VoIP is not running. Choose

default in the Input and Output drop-down lists in JS8Call File>Settings>Audio>Soundcard.
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5.13 LibreOffice

LibreOffice is a suite of programs you can use for office tasks.  The programs include:

§ Word Processor

§ Spreadsheet

§ Presentation

§ Drawing

§ Database

§ Equation Editor

LibreOffice is not installed by default.  To install, go to Application

Menu>Preferences>Recommended Software>Office.

5.14 Message Aggregator

Message Aggregator implements the server side of the message protocol used by WSJT-X.

WSJT-X is a client of the protocol. Message Aggregator is not installed by default. Download

and install from https://w1hkj.org.

5.15 Motion (Video)

Motion is an application for creating streaming video.  Motion is installed and configured on

RigPi.  The primary use for RigPi video is to keep an eye on your radio while operating

remotely.
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Motion can use most webcams.  Plug a webcam into one of the USB ports on RigPi and

Motion will find it.

Extensive control over Motion is provided through a configuration file.  To view and edit this

file, use the following command from Terminal:

sudo nano /etc/motion/motion.conf

For example, if you wish to disable Motion if you will not use the video feature, edit the line

'daemon on' to 'daemon off'.  The height of width of the camera image is determined by the

height and width parameters.  This affects the size of the capture image, not the displayed

image.  You can see the captured image in rigpi4.local:8081.   Increasing the frame-rate will

decrease the video lag time, but will increase the computing resources required.

You can change the width and height of the image in the Tuner window by editing the html

in /var/www/html/index.php.  There are three places the size can be changed.

The Motion log is located in /var/log/motion/motion.log
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RigPi RadioCam video can replace the Tuning Knob, S-meter or Frequency panel on the Tuner

window.  See the Advanced Radio  Settings topic for how to set the mode you wish to use.

The view option you choose in Advanced Radio settings will affect the appearance of video on

a mobile device.

No Video: the Frequency Panel and Tuning knob are shown.

Video -> S-meter: The Frequency Panel, Video and Tuning Knob are shown.

111
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Video -> Frequency Panel: Video and Tuning Knob are shown

 

For more help, go to 

https://motion-project.github.io/

https://motion-project.github.io/
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If the frame for the video shows with no contained video, check the ad blocker on

the browser you are using. If using Chrome on iOS, go to Chrome settings and

enable Allow Cross-Website Tracking.

5.16 Mumble

Mumble is an open source VoIP system. A VoIP server called Murmur is installed on RSS along

with a Mumble client. The MFJ RigPi Audio board normally provides an input and output path

for this Mumble client, although USB audio sound devices or radio CODECs can also be used.

One radio can be connected to the Mumble client. Remote Mumble clients can also connect to

the server and receive and send audio. Free Mumble clients are available for all popular

operating systems.

The Murmur Server is named RigPi VoIP Server and the configured Mumble Client is named

Radio1. Mumble can be started manually from the RSS Desktop by selecting Radio 1. A utility

named  Autostart is on RSS Desktop. Run Mumble Autostart to have Mumble start

automatically when RSS is rebooted. 

A second instance of Mumble can be started using Radio 2. Radio 2 uses its own audio device

or radio CODECs.

The Mumble SuperUser account is used to change advanced settings.  The SuperUser account

has access to settings not available for normal accounts, but does not process audio.

When you start Mumble the Mumble window opens on RSS:
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Mumble Settings

If you make any changes to Mumble settings, click Apply at the bottom of the settings window

to test.  When you are satisfied, click OK.  Close Mumble before rebooting RigPi or else you

will see an error message when restarting.

Mumble uses RigPi Audio for input and output audio, audio USB dongles, or CODEC's from

your radio.

Refer to Mumble Help for setting up Mumble. One setting that applies to Mumble in RSS is

found in the Audio Processing group of Mumble Configure>Settings>Audio Input. Set the

Audio Processing to Disabled. If Noise Suppression is enabled the normal background noise on

HF can cause distortion and clicking in the audio output. (See screen shot below.)

Mumble Clients can send audio continuously, by use of a Mumble PTT key, or by detecting

voice activity (VOX).  The screen shots below are shown below to include all audio in and audio

out settings.  The settings shown are typical.  You will have to adjust them to maximize audio

quality with your RigPi.
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In Mumble Configure>Settings>Network enable the 'Reconnect automatically' and 'Reconnect

to last server on startup' options.

Audio Input

System (MFJ RigPi audio board):  Select ALSA from the System drop-down list.  In Device,

[hw: CARD=sndrpiproto, DEV=0] snd_rpi_proto, WM8731 HiFi wm8731-hifi-0 Direct hardware

device without any conversion.

System (Radio CODEC): Select the Microphone and Speaker CODEC settings in the Desktop

Menu bar.  Select PulseAudio from the System drop-down list.  In Device, select Default Device.

Transmit: This lets you change what causes audio from your radio to be sent.  "Continuous" is

recommended, but you can also have Mumble attempt to transmit only when there is active

audio from your remote device. Voice Activity is useful to show an audio level bar graph which

can help when finding the correct settings.

Audio Cue:  This causes a sound to play whenever you press or release the Push-To-Talk key.

Not active when Continuous Transmission is selected.

Quality: This is the quality at which Mumble will encode audio from your radio. It is

recommended that you leave this at 40.0 KB/s. However, if the audio sounds distorted, you

can try raising or lowering this value.
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Audio per packet: This is the amount of audio that Mumble sends at a time. A lower value

means less latency, but might potentially introduce quality loss, if too low. I recommend that

you leave this at 20 ms.

Noise Suppression: Mumble can automatically filter out static background noise. When set to

Speex, RNNoise or Both, a slider adjusts how aggressively noise is filtered. If filtering is too

aggressive, then your voice may become distorted. Leave Noise Suppression Disabled to

remove all noise suppression.

Max. Amplification: This setting controls how loud the receive audio is. 

Audio Output

System (RigPi audio board):  Select ALSA from the System drop-down list.  In Device, select

[hw: CARD=sndrpiproto, DEV=0] snd_rpi_proto, WM8731 HiFi wm8731-hifi-0 Direct hardware

device without any conversion.

System (Radio CODEC): Select PortAudio from the System drop-down. In Device, select

Default.

Default Jitter Buffer: If your mic audio is distorted, metallic, or sounds like a robot, try

increasing this setting a notch or two.

Volume: Output volume. The volume setting for audio sent to the radio's mic/audio input.

Output Delay: If your transmit audio is distorted or is breaking up, try increasing this value.

Attenuate applications by...: This setting determines how much Mumble will reduce other

applications' volume when people talk. A setting of 100% means to mute other applications;

0% means do not do anything to other applications. Additionally, you can select to attenuate

when others talk, and/or when you talk with the "while other users talk" and "when you talk"

check boxes.

Loop back: This is a super handy feature for troubleshooting problems with your transmit

audio settings. You can set Mumble to "loop back" to you, so you hear what you are saying the

way other people will hear you. When troubleshooting, try setting this to "Server", and then

tweak options in Audio Input and Audio Output to get your audio sounding just right.

Remember to set it back to "None" after you're finished, or else nobody will be able to hear

you

Managing Accounts

If you wish to remove clients that have been registered, use the SuperUser account. The

SuperUser can delete registered accounts.
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Using a Remote Server

RSS is can use an external Mumur server. If RSS is connected to the Internet and you expect to

have a large number of users, a remote Murmur server may be attractive.  In addition, port

forwarding is not required when using a remote Mumble server, making the connection easier

to accomplish.

Murmur servers are available for free or low cost. Commercial server companies typically

charge based on the number of "slots" you want to use. A slot is a unique user logged in to the

server. Server fees typically run less that $2 per month per slot. Details for connecting to a

remote server are beyond the scope of this manual, but instructions are usually given on the

server you choose.

One commercial Mumble service is mumble.com.  Up to a 50% discount is available if you

commit to more than one year.  mumble.com also provides a way to connect through a web

browser rather than a Mumble c4043lient.  This can be done by using the URL https://<your

account>.mumble.com:4043

Running more than one Mumble client

Using the Radio2 client makes it possible to simultaneously run audio from more than one

radio through RSS.

There are two requirements.

 

1. You need one (or more) audio IO devices in addition to RigPi Audio. This can be

done with a USB audio dongle. For my tests I used a Griffin dongle, but any

inexpensive USB/Audio device should work well. 

2. The second Mumble client is started with parameters -m and -n. 

https://<your
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Now you can log in. Radio2 is used as the username. With two clients you see both users in the

client lists, radio1 and radio2. The user connected with its primary client is shown in bold.

Assign the audio dongle to the second client. Now you can connect the audio to/from two

rigs.

Since all users hear all other users, you will hear audio from both radios. That has interesting

possibilities, such as monitoring 2 repeaters at once. You may want to control the audio from

the two radios separately using macros.  Sample macros for muting USB and analog audio

levels are provided in macro bank 2.

Install Bonjour

The Mumble server requires that Bonjour be installed on your computer for clients to connect.

 If you are using a Windows computer, follow the instructions here .  Bonjour is included on

Mac computers.

206
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5.17 Mumble Autostart

Mumble Autostart is a program that controls how Mumble is started. Mumble Radio 1 can be

started manually through the Desktop>Mumble option or by having it start automatically

when RSS is started or rebooted.

You must start Mumble Radio 2 manually from the Desktop icon.

The Mumble Autostart program icon is located on the RSS Desktop.

5.18 Panadapter

IQ Panadapter software is not provided with RSS. Here is a link to AA6E's web page that

describes the Tiny Python Panadapter originally published in the April 2014 issue of QST. An

I/Q connection is provided on RigPi Audio to provide wide-band stereo audio to Panadapter

programs. 

AA6NE Panadapter

5.19 Relay Switching

The Sainsmart 8-channel 12V Relay Module is compatible with RigPi.  It is controlled from one

of the Raspberry Pi USB ports using a standard USB A/B cable.  It requires an external 12 V

power supply.

The module can be purchased from Sainsmart, https://sainsmart.com

The relays are able to switch 28 VDC or up to 250 VAC at 10 amps.

https://drive.google.com/file/d/0B9zqwXulH_W3Q0hXSXozRTRWRmc/edit?pli=1&resourcekey=0-vBlf9RPVUfiIWl9outUeSg
https://sainsmart.com
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There are several caveats...

§ When you power up the Raspberry Pi or reboot, the relays are toggled several times. 

According to Sainsmart, this is a characteristic of the FTDI chip used on the board.

§ Be careful when connecting a 12 V power supply to not reverse the polarity.  There is no

protection against reversed voltage on the board.

§ To control the Relay Module, select Macro Decimal or Band BCD in the Slv Cmnd drop

down list.  Set the Slave Port to the long name for the FTDI USB connection.

§ Each relay module can be controlled by any account.

§ You can use several relay modules, one per account.  More than one FTDI USB cable can

used for multiple relay boards or radios.

The relays can be toggled automatically in the BCD Band mode, or individually via macros in

the Macro Decimal mode.  You can also use a Flic switch to toggle relays.  Macros for the

Macro Decimal mode can be stacked, so !SW1-1!SW3-1 turn relays 1 and 3 on. !SW1-0!SW3-1

turns relay1 off and relay 3 on.

See the Advanced Radio  topic for settings and the Flic topic  for Flic programming

instructions.

5.20 TrustedQSL

Open source libraries and utilities to support using digital signatures for Amateur radio QSL

information. It can be used to digitally sign and upload QSOs to the ARRL's Logbook of the

World (LoTW) online service and to manage the Callsign Certificates used when digitally

signing. TQSL accepts QSOs in a log file whose format is either ADIF or Cabrillo, which RSS can

create.

5.21 UFW Firewall

The UFW firewall is included with RigPi as an added security measure.  It can be enabled or

disabled using Terminal.

sudo ufw enable

sudo ufw disable

To see UFW Help from Terminal:

man ufw

UFW stands for Uncomplicated Firewall. It is a user-friendly command-line tool used to

manage firewall rules on Linux systems. UFW provides a simplified interface for configuring

111 168
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and managing the netfilter firewall, which is built into the Linux kernel. It is designed to make

the process of setting up a firewall easier for users who may not be familiar with complex

firewall concepts.

Here are some key features of UFW:

1. Ease of use: UFW aims to provide a straightforward interface for managing firewall rules,

making it accessible to both novice and experienced users.

2. Command-line interface: UFW is primarily used through the command line, where users can

enable or disable the firewall, add or remove rules, and view the status of the firewall.

3. Default policies: UFW follows a default deny incoming rule and a default allow outgoing

rule. This means that incoming connections are blocked by default unless explicitly allowed,

while outgoing connections are permitted.

4. Application profiles: UFW includes predefined application profiles that allow users to enable

firewall rules for commonly used services such as SSH, HTTP, HTTPS, and more. These profiles

simplify the process of allowing or denying access to specific services.

5. Simple syntax: UFW utilizes a straightforward syntax for adding rules. Users can specify

ports, protocols, and IP addresses to define the desired network traffic rules.

6. Integration with iptables: UFW is built on top of the underlying iptables framework, which is

a powerful firewall utility in Linux. UFW simplifies iptables management by providing an easier

syntax and a higher-level interface.

It's important to note that UFW is primarily used on Ubuntu and Debian-based systems, but it

can also be installed and used on other Linux distributions.

To see a list of open port in RigPi, open Terminal on the Raspberry Pi desktop and use the

command:

sudo ufw status

as shown below.

pi @r i gpi 4: ~ $ sudo uf w st at us
St at us:  act i ve

To  Act i on Fr om
- -  - - - - - - - - - -
80/ t cp ALLOW Anywher e
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64738/ t cp ALLOW Anywher e
64738/ udp ALLOW Anywher e
8080/ t cp ALLOW Anywher e
8081/ t cp ALLOW Anywher e
30040/ udp ALLOW Anywher e
5900/ t cp ALLOW Anywher e
23/ t cp ALLOW Anywher e
22/ t cp ALLOW Anywher e
3001/ t cp* ALLOW Anywher e
80/ t cp ( v6) ALLOW Anywher e ( v6)
64738/ t cp ( v6) ALLOW Anywher e ( v6)
64738/ udp ( v6) ALLOW Anywher e ( v6)
8080/ t cp ( v6) ALLOW Anywher e ( v6)
8081/ t cp ( v6) ALLOW Anywher e ( v6)
30040/ udp ( v6) ALLOW Anywher e ( v6)
5900/ t cp ( v6) ALLOW Anywher e ( v6)
23/ t cp ( v6)  ALLOW Anywher e ( v6)
22/ t cp ( v6)  ALLOW Anywher e ( v6)
3001/ t cp ( v6)  ALLOW Anywher e ( v6)

30001 ALLOW OUT Anywher e
30001 ( v6) ALLOW OUT Anywher e ( v6)

*Note: TCP port 30001 will change depending on which RigPi account you are using.  Account

1 uses 30001, account 2 uses 30002, and so on.

5.22 Update RSS Files

Updating the files for RSS is done automatically when a new minor version is detected, or

manually from the SETTINGS>System menu.  Updates provided on the https://rigpi.net server

are downloaded to RSS, unzipped and copied to the correct RSS folders.  Only files newer than

a corresponding file are updated.  The update retains all user settings and databases.

To update manually:

1. In RSS go to SETTINGS>System and click Update RSS Files. If a new version is detected, click

OK to proceed.

2. When the update is done click OK to reboot RigPi to refresh all files.

Updating RSS files does not update any system files or other installed programs. 

https://rigpi.net
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5.23 WSJT-X

WSJT-X is a computer program used by amateur radio operators for weak signal

communication. It is designed to facilitate communication on specific amateur radio bands

using digital modes, particularly for contacts that are difficult or impossible to establish with

traditional voice or Morse code transmissions.

WSJT-X was developed by Dr. Joe Taylor, K1JT, and a team of contributors. It stands for "Weak

Signal Communication, by K1JT" and is named after its creator. The software incorporates

several digital communication modes optimized for weak signal propagation, such as JT65,

JT9, FT8, and FT4. These modes use highly efficient encoding and decoding techniques to allow

for reliable communication even under challenging radio propagation conditions.

The primary use of WSJT-X is in the field of amateur radio, where it enables operators to make

contacts over long distances with low power and inefficient antennas. The software uses a

time-synchronized protocol, allowing for accurate time and frequency calibration, and it

includes features like automatic logging, signal reporting, and advanced error correction

algorithms.

WSJT-X has gained popularity among amateur radio operators worldwide due to its

effectiveness in weak signal communication, making it possible to establish contacts that

would otherwise be difficult or impossible. It has become an essential tool for those interested

in DXing (making long-distance contacts) and conducting scientific experiments related to

radio propagation and space weather.

Detailed instructions are beyond the scope of this manual, please refer to the WSJT-X web site:

WSJT-X Sourceforge

This Help topic covers use of WSJT-X in RSS.

Radio Connection

RSS and WSJT-X both use the Hamlib radio control library. Using the Hamlib "Net rigctl" radio

selection in WSJT-X it is possible to have both RSS and WSJT-X control the radio.  

Connect RSS to your radio in SETTINGS>Radio. Go to WSJT-X File>Settings>Radio. Select

Hamlib NET rigctl for Rig and localhost:<RSS Port> for Network Server. You can now control

frequency from WSJT-X or RSS. 

The RSS port is determined by the account you wish to use in RSS. Use the port number shown

in RSS SETTINGS>Radio>Rigctl Port.

https://wsjt.sourceforge.io/wsjtx.html
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 If your radio requires PTT control on an ACC connector to switch audio routing, use the H/W

PTT Hamlib GPIO option in Advanced Radio settings.

Logbook Connection

Contacts logged in WSJT-X are automatically transferred to the active log in RSS for

the account specified by the sync option in RSS SETTINGS>Users>Edit>Sync WSJTX

Log. Log data are transferred using the Secondary UDP Server options in WSJT-X.

RSS expects a connection on N1MM Server port 2333

Make sure the three following settings are set on WSJT-X Settings Reporting tab are

set:

File>Settings>Reporting. Bottom of page.

1. Enable logged contact ADIF broadcast is checked

2. Server name or IP address = 127.0.0.1

3. Server port number = 2333

Audio Connection

RigPi Audio or a radio CODEC is used for input and output audio for WSJT-X. Since Audio is

limited to one application at a time, make sure the Mumble VoIP client program isn't running..

Select your sound source in the Input and Output drop-down lists in WSJT-X

File>Settings>Audio>Soundcard.

If your radio has internal CODECS, use these settings (may vary depending on your radio):
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5.24 ZeroTier

ZeroTier is a software-defined networking (SDN) platform that enables secure and scalable

connectivity between devices, servers, and applications over the Internet. It is designed to

create virtual local area networks (VLANs) or software-defined networks (SDNs) that can span

across different physical locations, allowing devices to communicate as if they were on the

same local network, regardless of their physical location or the underlying network

infrastructure.

Key features of ZeroTier include:

· Global Reach: ZeroTier allows devices to communicate with each other over the Internet

without the need for complex networking configurations. It can connect devices across

different networks, such as home networks, corporate networks, or public Wi-Fi.

· Security: ZeroTier uses end-to-end encryption to secure the communication between

devices. This ensures that data is protected from eavesdropping and unauthorized access.

· Ease of Use: Setting up ZeroTier is typically straightforward. Users need to install the

ZeroTier client on their devices and join a common network by entering a unique network ID.

Once connected, devices can communicate with each other as if they were on the same local

network.

· Multi-Platform Support: ZeroTier supports a wide range of platforms, including Windows,

macOS, Linux, iOS, Android, and more. This makes it versatile and compatible with various

devices.

· Open Source: ZeroTier is partially open source, which means that the source code for some

components is available for review and modification. This can be beneficial for security-

conscious users and organizations.

ZeroTier is often used in scenarios where traditional networking solutions might be impractical,

such as remote work, multi-cloud environments, or for creating isolated networks for specific

applications. It provides a way to extend network connectivity in a secure and flexible manner.

The ZeroTier client, zerotier-cli, is installed on RigPi.  You must set up a (free) account on

ZeroTier to use the service.

· Create a ZeroTier network

· Join the network from two devices

· ping one device from the other over the ZeroTier network

Instructions for creating a network are here.

You must enable ZeroTier, it is disabled by default. To start:

sudo systemctl enable zerotier-one

Using Terminal, use this command to then start ZeroTier:

https://www.zerotier.com
https://docs.zerotier.com/start


192

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Other Programs

sudo service zerotier-one start

To exit ZeroTier:

sudo service zerotier-one stop

To disable ZeroTier:

sudo systemctl disable zerotier-one

Once you have the connection configured you can use RigPi, Mumble, and Remote Desktop

from anywhere in the world without modifying your router settings.

Important Note

ZeroTier does NOT support a Wi-Fi connection, you must use Ethernet.  If you attempt to

connect to ZeroTier using Wi-Fi, the Wi-Fi will be shut down on the Raspberry Pi.  To reset the

Wi-Fi connection,follow these steps:

Start Terminal on the Raspberry Pi desktop

Enter: sudo systemctl  enable NetworkManager 
Reboot: sudo reboot now
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6 Technical

Information about technical aspects of RSS are contained in this section.

6.1 Glossary

Term Definition

ARRL

The American Radio Relay League (ARRL) is a worldwide organization

of amateur radio operators with its headquarters in Newington,

Connecticut, USA.  

Account
RSS provides user accounts with usernames and passwords. Each

account manages a radio, keyer, and rotor.

Ajax

Asynchronous JavaScript and XML is a method of building interactive

applications for the Web that process user requests immediately. Used

in RigPi.

API Application Programming Interface

Bootstrap
An open source toolkit for developing web content with HTML, CSS,

and JS provided by Twitter. Used in RigPi.

CAT Computer Aided Transceiver. A protocol for controlling radios.

Client A computer or mobile device connected to RSS.

CSS
Cascading style sheets. Cascading style sheets are used to format the

layout of Web pages. Used in RigPi.

CW, Element

Based

Remote CW by sending the timing of CW elements (dits and dahs).

This preserves your keying "personality".

CW, Character

Based

Remote CW by sending ASCII characters (A, B...)

Download Transfer data to a client, such as a PC, to RSS

GPIO
General Purpose Input Output, a connection used by the Raspberry Pi

for controlling external devices.
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Term Definition

Hamlib
A radio and rotor library developed to facilitate control of ham

equipment. Used in RigPi.

JavaScript
An object-oriented computer programming language commonly used

to create interactive effects within web browsers. Used in RigPi.

jQuery
A concise and fast JavaScript library that can be used to simplify event

handling, HTML document traversing. Used in RigPi.

LoTW
Logbook of the World, a service from ARRL that provides secure

electronic QSO confirmations.

MariaDB

A community-developed fork of the MySQL relational database

management system intended to remain free under the GNU GPL.

Used in RigPi.

MOMR Multiple-operator, multiple-radio, supported by RSS

MySQL
An Oracle-backed open source relational database management

system (RDBMS) based on Structured Query Language (SQL)

PHP

PHP is a server scripting language, and a powerful tool for making

dynamic and interactive Web pages. PHP is the acronym for PHP:

Hypertext Preprocessor. (It originally meant "Personal Home Page.")

Used in RigPi.

Port

Forwarding

Providing a data path through a router so devices on a LAN can be

accessed from the Internet.

Raspberry Pi
A small single-board computers developed in the United Kingdom by

the Raspberry Pi Foundation 

RSS RigPi Station Server

Upload Transfer data from a client, such as a PC, to RSS

TQSL
Trusted QSL provides secure transfer of logs to and from the Logbook

of the World
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Term Definition

VoIP

Voice over IP, the technology used to provide 2-way audio to and

from RSS for remote operations. RSS uses the free, open-source

program Mumble to provide VoIP.

6.2 Installing the latest Hamlib

The Hamlib control library is constantly updated by the maintenance team.  Hamlib must be

updated in RigPi manually using these steps:

1. Open the Raspberry Pi Desktop

2. Open the browser by clicking the Globe in the toolbar.

3. Navigate to the Hamlib folder in Github to get the latest Beta version (you can also select

the latest release version):

https://github.com/Hamlib/Hamlib

4. Click the green Code button, then Download ZIP.

5. Right-click over the Hamlib-master.zip button at the bottom of the browser and select

Show in folder.

6. In the Downloads folder right-click Hamlib-master.zip and select Extract here.

7. Close the Downloads folder and the browser.

8. Open Terminal by clicking the >_ black icon at the top of the Desktop.

9. Type these commands:

cd /home/pi/Downloads/Hamlib-master

./bootstrap

./configure

make

sudo make install

Let each command complete before entering the next command.  The make process will take

several minutes.

Once the make install command is complete you are good to go.  Start RigPi and use Connect

Radio.

If you installed the Hamlib to pick up a new radio, you need to add that radio to the RigPi

radio database. To get the values for the list below, open Terminal and type the following:

rigctl -l

https://github.com/Hamlib/Hamlib
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(lower-case L)

Look for the radio you want to add in the resulting list.

1. Start phpMyAdmin from the Raspberry Pi desktop app menu, Programming.

2. Use username mysql-user and password 7388.

3. Expand the station database by clicking the +.

4. Open the Radios table.

5. Click Insert, then add the following values:

OLDNUMBER Hamlib ref number for this radio

NUMBER Hamlib ref number for this radio

SAMEAS Hamlib ref number for this radio

MANUFACTURER Name

MODEL Model number

VERSION Hamlib version for this radio

STATUS Hamlib status

Click Go at the bottom left and close phpMyadmin.  The newly added radio appears in the

Radio list in Advanced Radio settings.

6.3 Panels

The Graphics User Interface (GUI) used in the RSS Tuner window is based on a commercial

product "Perfect Widgets" by Perpetuum Software. The Frequency, S-meter and Tuning Knob

panels use HTML5 JSON technology to provide a modern look.  This is proprietary software.

Perfect Widgets site

It is possible to modify RSS code to set your own values in each panel. By means of an online

inspector, you can see the tree structure of the respective JSON object.

JSON code inspector

The Perfect Widgets development tools are proprietary. The RSS panels are developed using a

"Developer's License." A limited free version of Perfect Wiglets is available on the Perpetuum

web site.

Perfect Widgets 2.0

EULA - End User License Agreement
 

http://perfectwidgets.com/Main
http://perfectwidgets.com/inspector/


198

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

End User License Agreement for Perfect Widgets

Perpetuum Software LLC

Perfect Widgets

SOFTWARE COMPONENT PRODUCT

Copyright (C) 2012 Perpetuum Software LLC

END-USER LICENSE AGREEMENT FOR PERFECT WIDGETS SOFTWARE COMPONENT PRODUCT

IMPORTANT - READ CAREFULLY: This Perpetuum Software LLC End-User License Agreement

("EULA") is a legal agreement between you, a developer of software applications ("Developer

End User") and Perpetuum Software LLC (Vendor) for Perfect Widgets SOFTWARE

COMPONENT PRODUCT, its relevant controls, source code, demos, intermediate files, media,

printed materials, and "online" or electronic documentation ("PRODUCT") contained in the

installation file.

By installing, copying, or otherwise using the PRODUCT, the Developer End User agrees to be

bound by the terms of this EULA. The PRODUCT is in "use" on a computer when it is loaded

into temporary memory (i.e. RAM) or installed into permanent memory (e.g. hard disk, CD-

ROM, or other storage device) of that computer. If the Developer End User does not agree to

any part of the terms of this EULA, THE DEVELOPER END USER CAN NOT INSTALL, USE,

DISTRIBUTE, OR REPLICATE IN ANY MANNER, ANY PART, FILE OR PORTION OF THE

PRODUCT, OR USE THIS PRODUCT FOR ANY OTHER PURPOSES.

The PRODUCT is licensed, not sold.

LICENSE GRANT.

Upon acceptance of this EULA and subject to the payment of the fee required and the terms

and conditions herein the Vendor grants the Developer End User a personal, nonexclusive

license to install and use the PRODUCT on compatible devices for the sole purposes of

designing, developing, testing, and deploying application programs the Developer End User

creates (Final Application). If the Developer End User is an entity, it must designate one

individual within its organization to license the right to use the PRODUCT in the manner

provided herein.
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The Developer End User may install, use the PRODUCT, and distribute final application

programs as permitted by the license type purchased. The license type purchased is specified

in the product receipt.

a) Website License. Under Website license, the Developer End User is hereby granted one (1)

license per one (1) high-level domain name where the Final Application can be deployed and

unlimited number of developer licenses to use the PRODUCT for the purpose of developing

software applications. Developer End User must purchase another separate license to the

PRODUCT for each and any additional domain name where the Developer End User intends to

deploy the Final Application.

b) Developer License. Under Developer License the Developer End User is hereby granted one

(1) license as one (1) designated user to use the PRODUCT for the purpose of developing

software applications and unlimited number of licenses for deploying the Final Application on

high-level domains. Developer End User must purchase another separate license to the

PRODUCT for each and any additional Developer. There is no limit or restriction on the number

of installations of PRODUCT, which may be on different machines; provided, however, that the

PRODUCT may not be used by anyone other than you as a single developer. For example, if a

company has five developers using the PRODUCT, the company needs to purchase five

licenses, irrespective of how the Software is accessed or how many installations are accessed.

c) Enterprise License. Under Enterprise License, the Developer End user is hereby granted with

unlimited number of developer licenses for the purpose of developing software applications

and unlimited number of domain licenses for deploying the Final Application on different

domains.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Not for Resale Software.

If the PRODUCT is labeled and provided as "Not for Resale" or "NFR", then, notwithstanding

other sections of this EULA, the Developer End User may not resell, distribute, or otherwise

transfer for value or benefit in any manner, the PRODUCT or any derivative work using the

PRODUCT. The Developer End User may not transfer, rent, lease, lend, copy, modify, translate,
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sublicense, time-share or electronically transmit the PRODUCT, media or documentation. This

also applies to any and all intermediate files, source code, and compiled executables.

Limitations on Reverse Engineering, Decompilation, and Disassembly.

The Developer End User may not reverse engineer, decompile, create derivative works, modify,

translate, or disassemble the PRODUCT, and only to the extent that such activity is expressly

permitted by applicable law notwithstanding this limitation. The Developer End User agrees to

take all reasonable, legal and appropriate measures to prohibit the illegal dissemination of the

PRODUCT or any of its constituent parts and redistributables to the fullest extent of all

applicable local, federal and international laws and treaties regarding anti-circumvention,

including but not limited to the Geneva and Berne World Intellectual Property Organization

(WIPO) Diplomatic Conferences.

Rental and Transfer.

The Developer End User may NOT permanently or temporarily transfer ANY of his/her rights

under this EULA to any individual or entity. The Developer End User may not rent, lease, or

lend the PRODUCT. Regardless of any modifications which the Developer End User makes and

regardless of how the Developer End User might compile, link, and/or package his/her

programs, under no circumstances may the libraries, redistributables, and/or other files of the

PRODUCT (including any portions thereof) be used for developing programs by anyone other

than the Developer End User

Intellectual Property

All intellectual property rights such as but not limited to patents, trademarks, copyrights or

trade secret rights related to the PRODUCT are property of the Vendor.

Developer End User shall not modify, translate, reverse engineer, decompile or disassemble the

PRODUCT or any portion of it or attempt to derive source code or create derivative works.

Developer End User are not allowed to remove, alter or destroy any proprietary, trademark or

copyright markings or notices related to the PRODUCT. Developer End User must not remove

copyright headers, links and markings from any files included in the PRODUCT. Developer End

User must obtain permission by the Vendor if Developer End User needs to incorporate the

Software or any portions of it open source projects.
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Non-Compete

THE DEVELOPER END USER MAY NOT USE THE PRODUCT TO CREATE ANY TOOL OR

PRODUCT THAT DIRECTLY OR INDIRECTLY COMPETES WITH THE PRODUCT.

WARRANTY

The Vendor represents and warrants that:

(i) The Vendor has all rights, authorizations or licenses to provide the PRODUCT to the

Developer End User;

(ii) The Vendor will use its best efforts to prevent the PRODUCT from being infected with any

"worms", "viruses", "Trojan horses" or other programs or programming devices that might be

used to modify, delete, damage, deactivate or disable the software, computer hardware or

data of the Developer End User;

LIMITATION ON AND EXCLUSION OF DAMAGES.

THE DEVELOPER END USER CAN RECOVER FROM THE VENDOR ONLY DIRECT DAMAGES UP

TO THE AMOUNT THE DEVELOPER END USER PAID FOR THE SOFTWARE. THE DEVELOPER

END USER CANNOT RECOVER ANY OTHER DAMAGES, INCLUDING CONSEQUENTIAL, LOST

PROFITS, SPECIAL, INDIRECT, INCIDENTAL OR ANY OTHER DAMAGES.

This limitation applies to claims for breach of contract, breach of warranty, guarantee or

condition, strict liability, negligence, or other tort to the extent permitted by applicable law. It

also applies even if repair, replacement or a refund for the software does not fully compensate

the Developer End User for any losses; or the Vendor knew or should have known about the

possibility of the damages.

DISCLAIMER.

EXCEPT AS OTHERWISE DEFINED HEREIN, THE VENDOR EXPRESSLY DISCLAIMS ANY

WARRANTY FOR THE PRODUCT. THE PRODUCT AND ANY RELATED DOCUMENTATION IS

PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,

INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY,

FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. THE ENTIRE RISK ARISING

OUT OF USE OR PERFORMANCE OF THE PRODUCT REMAINS WITH THE DEVELOPER END

USER.

NO LIABILITIES.
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To the maximum extent permitted by applicable law, in no event shall the Vendor be liable for

any special, incidental, indirect, or consequential damages whatsoever (including, without

limitation, damages for loss of business profits, business interruption, loss of business

information, or any other pecuniary loss) arising out of the use of or inability to use the

PRODUCT or the provision of or failure to provide Support Services, even if the Vendor has

been advised of the possibility of such damages.

Termination.

Without prejudice to any other rights or remedies, the Vendor will terminate this EULA upon

the failure of the Developer End User to comply with all the terms and conditions of this EULA.

In such events, the Developer End User must destroy all copies of the PRODUCT and all of its

component parts including any related documentation, and must immediately remove ANY

and ALL use of the technology contained in the PRODUCT from any applications developed by

the Developer End User, whether in native, altered or compiled state.

GENERAL PROVISIONS.

This EULA may only be modified in writing signed by you and an authorized officer of the

Vendor. If any provision of this EULA is found void or unenforceable, the remainder will remain

valid and enforceable according to its terms. If any remedy provided is determined to have

failed for its essential purpose, all limitations of liability and exclusions of damages set forth in

the Limited Warranty shall remain in effect.

The Vendor reserves all rights not specifically granted in this EULA.

The Vendor reserves the right to make changes in this EULA at any moment by publishing the

appropriate alterations on http://www.perpetuumsoft.com 20 calendar days prior to the

moment these alternations take effect.

ACKNOWLEDGMENT.

THE DEVELOPER END USER ACKNOWLEDGES THAT IT HAS READ AND UNDERSTANDS THIS

AGREEMENT AND AGREES TO BE BOUND BY ITS TERMS. THE DEVELOPER END USER

FURTHER AGREES THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT

OF THE AGREEMENT BETWEEN THE DEVELOPER END USER AND THE VENDOR, AND

SUPERCEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER

COMMUNICATIONS RELATING TO THE SUBJECT MATER OF THIS AGREEMENT.
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Last modified on September 07, 2012.

6.4 Programming

The following languages and tools were used in the development of RigPi.

Programming Languages

The following languages are used in RSS. They are all free tools with widespread support on

the Internet.

· CSS

· HTML5

· Bootstrap4

· PHP7

· JavaScript/jQuery

· AJAX

· MySQL/MariaDB

· TCP API for controlling RSS

· Python 3

Programming Tools

I used the following tools while developing RigPi. I have no relationship with the authors of

any of these applications.

FileZilla

FileZilla is a free client program for ftp file transfers. It is available for most platforms including

Windows and Mac OS X/macOS.

Here is the link for further information about FileZilla:

FileZilla

phpMyAdmin

https://filezilla-project.org/


204

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

phpMyAdmin is used for editing, modifying, and backing up MySQL databases. It is installed

on RigPi. Access phpMyAdmin through a browser:

http://rigpi4.local/phpmyadmin

Username is mysql-user, password 7388. These must be changed if you open RigPi to the

Internet.

Here is the link for further information about phpMyAdmin:

phpMyAdmin site

Nova

Available for the Mac, Nova (previously named Coda) by Panic Inc. is a powerful text editor,

previewer and file manager. It is a commercial product, not free.

Here is the link for further information about Coda:

Nova site

Perfect Widgets

A tool to create dynamic HTML5 gauges. Designed for Windows. It is a commercial product

although there is a free personal/non-commercial version. 

Here is the link for further information about Perfect Widgets:

Perfect Widgets site

Help+Manual

Help+Manual is a commercial program to write and publish Help files using Windows.

Here is the link for further information about Help+Manual:

Help+Manual site

Safari with Developer extensions

https://www.phpmyadmin.net/
https://panic.com/nova/
http://perfectwidgets.com/Main
https://www.helpandmanual.com/index.html
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Developer tools, especially the JavaScript console, are provided with Safari.

6.5 Raspberry Pi Settings

You may wish to change many Raspberry Pi settings such as screen resolution.  There are two

ways to proceed:

1. From the Raspberry Pi Desktop, click the Menu button (raspberry) at the top left.  Select

Preferences>Raspberry Pi Configuration or >Screen Appearance, or,

2. From Terminal, enter

 sudo raspi-config

It is normal to have items missing in the raspi-config window.  If they no longer apply in the

operating system in use, they are omitted from the list.

6.6 Rebooting RigPi

Occasionally it is necessary to reboot RigPi.  There are several ways to proceed.

RigPi: Go to  Settings->System and click Reboot RigPi.

Desktop: From the App Menu, click Log Out, then Reboot.

Terminal: Enter <sudo reboot> and click Enter.

The login screen opens.  Enter your username/password and click Login after RigPi boots.

If using a Keyer board, the Keyer sends 'R' as it is powered on.

The boot takes less than a minute.  The green status light on RigPi blinks as data are

transferred.

6.7 Resetting RigPi

If you want to sell your RigPi in the future there are a few steps you should take to make it

easier for the new user.

The RigPi login credentials can be reset to the factory defaults by following these steps:

1. Start phpMyAdmin from the Raspberry Pi applications menu>Programming

2. Sign in with username mysql-user and password 7388.

3. Expand the station Table list by clicking the + mark.

4. Select the Users table.

5. Click Edit at the left end of the data line.

6. Enter the following to restore the Admin user account to default:

a. Access_level: 1

b. MyCall: ADMIN
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c. Username: admin

d. Password: delete so field is blank

7. Scroll to the bottom and click Go.

8. Exit phpMyadmin

You should now be able to log in with username admin and no password.

Use the RigPi>SETTINGS>Users window to remove all but the ADMIN account.

In RigPi>SETTINGS>Advanced Radio change the radio to Hamlib Dummy and set all the fields

to "default."

6.8 Rigpi4.local on Windows computers

The domain rigpi4.local can be used as an easy way to connect to RigPi using a browser on

another computer.  Many operating systems automatically support the use of .local addresses

with the exception of Windows.  Bonjour may already be installed on your Windows computer,

especially if you have installed Apple iTunes in the past.

Apple Bonjour, one popular way to add .local support to Windows is available as a free

download from Apple.  Search for Bonjour for Windows and you will find the site providing the

download.  Except for Microsoft Edge, most browsers will open RigPi using rigpi4.local once

Bonjour has been installed.

If you are using Microsoft Edge, a program called Fiddle can be run at the same time as Edge

so the .local addresses will work.  Here is a link to the Fiddler download site:

Fiddler

To start Fiddler, use the Search function in Taskbar to find fiddler.  Then right-click and select

Run as Administrator.  Once Fiddler is running, navigate to rigpi4.local in Edge.

6.9 RigPi Audio Update

Early versions of RigPi used a settings file named audioinjector-wm8731-audio for the RigPi

Audio board.  If you don't have a RigPi Audio board installed in your RigPi, it is not necessary

to proceed with the recommended changes.

If you have one of the early RigPi servers, follow the steps below to update.  Right-click

Speaker icon on the Raspberry Pi Speaker icon.  If the drop down list includes "audioinjector,"

it is strongly recommended you proceed with this change. If the list already includes

snd_rpi_proto, please confirm the audio settings steps below for Audio Device Settings.  Even if

https://www.telerik.com/fiddler
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you are using your radio's CODECs to provide input and output audio, it is best to make these

change for the RigPi Audio board.

This topic also includes information on how to change audio levels and switches in Raspberry

Pi settings for the new overlay. 

This update changes a file called a “device tree overlay” to a new one that is better suited for

the RigPi Audio board.  The new overlay provides significant improvements for the decoding

of FT8 signals in WSJT-X and Mumble audio quality for weak signals.

Because this change requires elevated file access permissions it will be done manually.  A file

will be edited from the Raspberry Pi Desktop.

Open the Raspberry Pi Desktop by:

1. Attaching an HDMI Monitor (micro HDMI for Raspberry Pi 4B), USB mouse and USB

keyboard to RigPi, or….

2. Using VNC Viewer from another computer to open the Raspberry Pi Desktop in a

virtual window.

Start Terminal by single-clicking the black icon in the Desktop toolbar. Enter the following

commands:
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cd / boot <Ent er >
sudo nano conf i g. t xt <Ent er >

Scroll to the end of the config.txt file using the down arrow key.

Replace the second to last line (containing audioinjector-wm8731-audio) with this:  

dt over l ay=r pi - pr ot o 

Save and exit

Ct r l +o<Ent er >
Ct r l +x<Ent er >

Reboot using

sudo r eboot  now<Ent er >

to have the change recognized.
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After rebooting, Right-click on the Speaker icon at the top right-hand end of the Desktop and

select snd_rpi_proto for the following steps.

We will now use the Raspberry Pi Audio Device Settings to set levels and input/output

connections.

Click the Raspberry Applications Menu icon in the top left corner of the Raspberry Pi Desktop,

then select Preferences>Audio Device Settings.

· Confirm that Card: snd_rpi_proto (Alsa mixer) is the selected card.

· Use these settings for using the Mic or Line Input and Line Output.  If the audio levels are

too low, use the Mic settings in the Options tab.

Audio Device Settings, Selections:

Click the Select Controls... button at the bottom. Put checks in the following options:

1. Master

2. Line In

3. Microphone

4. Mic Boost

5. Capture

6. Input MUX

7. Output Mixer HiFi

Audio Device Settings, Levels and options:

Control Value Notes

Playback

Master 2/3 maximum change to suit

Mic Boost Maximum change to suit

Capture

Capture 2/3 maximum change to suit

Switches
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Control Value Notes

Line-in checked

Microphone Checked

Output Mixer HiFi Checked

Options

Input Mux Line In Select Mic for low level audio input

Finally, click the Make Default button at the bottom and close the Audio Devices Settings.

After testing with your transceiver you may find it necessary to change some of the Audio

Device Settings window options and levels.

Other settings

Any program that uses audio from RigPi Audio, a radio CODEC, or an external USB sound card

should be set to [default] for input and output devices except for Mumble.  The default is set

by using the Speaker right-click menu.

If you wish to use a digital mode program (Fldigi, JT8Call, WSJT-X) use [default] for all audio

input and output devices.

In Mumble client, use [sysdefault:CARD=sndrpiproto] snd_rpi_proto, Default Audio Device if

using the RigPi Audio board.  If using a radio CODEC, use [default].

6.10 RigPi Keyer PTT

The WinKeyer IC used for CW keying has an independent PTT capability that can control the

PTT output from RigPi Keyer. This special Keyer PTT operates in parallel with the normal RigPi

PTT.  To use RigPi Keyer PTT, the Keyer must be assigned to the account for which you want to

use it.
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RigPi PTT, configured in Radio settings, controls the PTT jacks on both boards, RigPi Keyer and

RigPi Audio.  Keyer PTT also controls the PTT line on RigPi Keyer, no matter whether RigPi PTT

is on or not.  Keyer PTT can be used to control an external device, such as a remote power

switch or an antenna bypass switch.

Keyer PTT is controlled by custom macros. Two macros are pre-programmed in the RigPi

Macro bank to accomplish this: SWITCH ON ($<18><01>) and SWITCH OFF ($<18><00>).  In

SETTINGS>Keyer, remove the check from Enable Keyer PTT to switch to independent control

using Macros.

RigPi PTT Macro Switch Audio PTT Out Keyer PTT Out

On On On On

On Off On On (Off with jumper

201 removed)

Off On Off On

Off Off Off Off

RigPi PTT (Radio Settings) has 3 options: None, ON when transmitting, and ON when radio

connected.  This third option overrides Key PTT since it is on whenever the radio is connected. 

Keyer PTT and Audio PTT are both on continuously.  If RigPi PTT is set to None, Audio PTT

never turns On, and Keyer PTT is controlled by the Macros. By removing jumper 201 on the

RigPi Keyer board, RigPi PTT has no control over the Keyer PTT.

The Keyer PTT can be used to control an external power switch.  Candidate power switches

include:

MFJ-1172 (discontinued)
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Digital Loggers IoT Control Relay

6.11 RigPi Login Code

RigPi requires a unique username for each account.  Passwords are optional, but are

recommended if you wish to use RigPi through the Internet.  The diagram below shows the

logic flow as you log in.  

      +-----------------------+

      |  User enters                |

      |  username/password |

      +-----------+----------+

                         |

                         v

  +----------------- --------------+

  | Membership->check_user()   |

  +-------------------------------+

                      |

https://www.amazon.com/Iot-Relay-Enclosed-High-Power-Raspberry/dp/B00WV7GMA2/ref=sr_1_3?crid=1JV9F6ACP917L&keywords=digital+loggers+iot+relay+2&qid=1693922434&sprefix=digital+logger+iot%2Caps%2C122&sr=8-3
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                      v

      [ Validate user input ]

                      |

                      v

  +----------------------------+

  | Connect to MySQL 'Users'  |

  | via MysqliDb                      |

  +----------------------------+

                      |

                      v

  [ Check for username match ]

                  |

     +-------+-------+

     |                          |

     v                         v

[ Found ]        [ Not Found ]

     |                         |

     v                        v

[ Check system     Return "NG"

  startup time ]

     |

     v

[ Call User->validate_user() ]

     |

     v

[ Capture client IP address ]

                |

                v

  [ Credentials OK? ]

                    |

     +---------------------+

     |                                  |

    Yes                           No

     |                                 |

     v                                v

[ Load Access_Level,      Log failed

  MyCall info ]                 attempt,

                                       return "NG"

          |

          v

[ Update 'Users' table

  (LastVisit, Active=1) ]

          |



214

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

          v

[ Add new record in

  'LoggedIn' table ]

             |

             v

[ Set session variables ]

             |

             v

[ Write success to rigpi-access.log ]

                     |

                     v

[ Redirect: 

 

 

 

6.12 RigPi Remote Keyer

See also: Keyer  Advanced Radio

The RigPi Remote Keyer feature allows you to operate CW from a remote location using a

paddle, bug or straight key.   A RigPi with a modified Keyer board is required for early RigPi's)

at both ends (see schematic, below).  One of several keying options can be used at the remote

end:

At radio end:

1. Radio RigPi1-4

A. RigPi 4 software

82 116
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B. Raspberry Pi 3B+ or 4B

C. Audio Board or CODEC (for VoIP) and CW Board

At remote key end (2 options):

1. RigPi 1-4 (same as radio end)

Or

2. RigPi Hub Windows program

A. RigPi Hub 2.4.0 or later

B. Control the radio through RigPi Hub with your favorite logging program

C. Send CW from most logging programs, straight key, keyboard key or mouse

button, or electronic key

D. Requires Windows Mumble client for VoIP

A RigPi Keyer can serve one of four functions as determined by the Keyer Fn in SETTINGS-

>Keyer.  See below the table for examples.

Keyer

Function

Keying Note

Normal

One RigPi with

keying

capability.

Key your transmitter from any browser using Tuner

macros, the Keyer window, or from RigPi Hub. 

A Windows keying

program using RigPi

Hub 2.4 (or later) for

keying. In RigPi Hub,

set the RigPi IP, RigPi

Control Port to 3000n,

and CW Port to 3000n

where n is the account

number.

Remote/Radio

Keyer Manual

Keying

Two RigPi's,

each with

modified Keyer

board

Requires two RigPi's, each with a Keyer board. 

Connect your paddle, bug, straight key, or RigPi

Hub to the Remote RigPi .  The Remote RigPi

controls the Radio RigPi. See Getting Started with

Two RigPi's, below.

A Windows keying

program can be

connected to the

Radio RigPi using

RigPi Hub 2.4 for

keying in lieu of a

Remote RigPi.

Set the CW port,

30039 + n, when n is

the account number.

which is used for

Radio Keyer data. Set

the IP address for the
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Radio Keyer RigPi in

Remote Keyer

settings.  Use the

RigPi Radio LAN IP

(when at home) or the

RigPi Radio WAN IP

(when away).  If using

a bug or straight key,

connect the key using

the tip and sleeve of

the PADDLE

connector. 

Use Vibrobug in the

Radio RigPi

SETTINGS->Keyer-

>Paddle Md.

Use Remote Keyer at

the Remote end and

Radio Keyer at the

Radio end in

SETTINGS->Keyer-

>Keyer Fn.

External CTS,

Manual Keying

One Radio

RigPi with

Keyer board.

No Remote.

Key CW from an external keying source connected

to the CTS connection on a serial-to-USB adapter.

Connect the RTS pin to the transmitter keying jack

(through an appropriate interface circuit). See

below for more about adapters. Remote keying is

not supported.

Set External CTS in

RigPi Advanced

(Keyer) and Keyer

settings (Keyer Fn). 

Select the USB

adapter in  SETTINGS-

>Advanced  Settings-

>Keyer Port.

Use Radio Keyer in

SETTINGS->Keyer-

>Keyer Fn.

Direct IP

Connection

(not needed as

a separate

Requires two RigPi's, or RigPi Hub at Remote, with

a Keyer at the radio end. Enter the <Radio RigPi

LAN>:<port> or <WAN IP>:<port> in the Remote

Advanced Settings->Keyer Port OR Remote RigPi

SETTINGS->Keyer Settings->Rad  Port and Radio IP

RigPi Hub running

under Windows can

be used in place of a

second RigPi.  For that

option you can use



217

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

function in the

Keyer Fn list)

Keyer required

at Radio end,

optional at

Remote end.

boxes. If a Windows logging program you are using

supports using an IP for WinKeyer keying, you can

use that program rather than a Remote RigPi or

RigPi Hub.

If you have a Keyer at the remote end, the Keyer

Settings option provides a sidetone.  You will not

get a sidetone if you use the Advanced Radio

option.

the RigPi Hub

sidetone or the radio's

Mon function (if

supported in your

radio) to provide a

sidetone.

Getting Started with Two RigPi's

Confirm that the RigPi Keyer is working correctly in each RigPi using the Normal Keyer

function. If using two RigPi's on the same local network, use the IP address for each RigPi

rather than the domain name.  You can change the domain name in one RigPi using sudo

raspi-config in a terminal on that RigPi.  Change it to something like "radio.local' or

'remote.local'.

Radio Keyer

§ Start the Radio RigPi in any browser.

§ In Settings>Advanced Radio enter the settings for your radio.  

§ Select RigPi Keyer in the Key list. 

§ In Settings>Keyer, set the Keyer Fn to Normal and put a check in the Enable Sidetone

check box.

§ Connect a cable from the RigPi KEY connector to the CW keying jack on your radio.  

§ Click Connect Radio on the Tuner window. The frequency shown should be the same as

shown on the radio.

§ Click Test Keyer in the Keyer Settings window.  You will hear two Morse V characters

indicating the Keyer is functioning correctly.

§ Connect a Keyer paddle to the PADDLE connector, open the Keyer window and send a

few characters.  If you wish to use a Bug or straight key, connect it between tip and

sleeve on the connector and set the Paddle Md to Vibrobug.

§ The Radio Keyer is now set for the Normal mode.

Remote Keyer

§ RigPi is running using rigpi4.local on the Radio and Remote RigPi's.  This will cause a

conflict when both are connected to the same LAN. To resolve this conflict, open the

Raspberry Pi desktop.  Go to Menu>Preferences>Raspberry Pi Configuration.  Enter

rigpi4R.local in the Hostname, click OK, and give permission to reboot.  From now on

you can access the Remote RigPi by using rigpi4R.local.
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§ Start the Remote RigPi in any browser.

§ In Settings>Advanced Radio select the Hamlib>Dummy radio.  

§ Select RigPi Keyer in the Key list.

§ In Settings>Keyer, set the Keyer Fn to Normal and put a check in the Enable Sidetone

check box.  

§ Click Connect Radio in the Tuner window. The frequency shown should be 145.000.000

MHz. 

§ Click Test Keyer in Settings>Keyer.  You will hear two Morse V characters indicating the

Keyer is functioning correctly.   

§ Connect a Keyer paddle to the PADDLE connector, open the Keyer window and send a

few characters.  If you wish to use a Bug or straight key, connect it between tip and

sleeve on the connector and set the Paddle Md to Vibrobug.

Setting up Remote Keying with Two RigPi's

Once both keyers are working using the Normal function, we will set up the remote keyer

connection through your local network.  A dedicated port 30040 (default, use 30039 + account

number) is used for the CW data.

Radio RigPi Keyer

§ In Settings>Keyer select Radio Keyer in the Keyer Fn list.

§ Settings>Keyer, enter a port in the Port box (30040 is recommended, must be the same

as used in Remote Keyer).

§ Click Test Keyer to register the new settings.

§ In Tuner, click Disconnect Radio and Connect Radio to start the Radio Keyer function

with the new settings.

Remote RigPi Keyer

§ In Settings>Keyer select Remote Keyer in the Keyer Fn list.

§ In Settings>Keyer, enter a port in the Port box (30040 is recommended).

§ Enter the Radio RigPi LAN (or WAN) IP in the IP box.

§ Click Test Keyer to register the new settings.

§ In Tuner, click Disconnect Radio and Connect Radio to start the Remote Keyer function

with the new settings.

You are all set for Remote CW.  Tune your radio to the CW portion of a band and turn on VOX.

 With the Keyer window open on the Remote Keyer RigPi, try sending some characters.  You

will hear the sidetone on both keyers and your radio should transmit.

Note the following:
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§ If running Remote and Radio RigPi near each other, turn off the Radio Sidetone to hear

the Remote RigPi Sidetone more easily.

§ When using Remote RigPi away from home you must set up UDP port forwarding for

the port you have assigned (30040).

§ When using Remote RigPi away from home you must use the WAN IP instead of the

Radio RigPi LAN IP.

§ To control your radio, open any browser at the remote location and connect to

rigpi4.local.  Port 80 must be forwarded to connect through your router if you are away

from home.  Use the WAN IP address of your Internet connection to connect.

RigPi Keyer Board Modifications

Two jumpers must be added to the RigPi Keyer board to allow remote keying, see below. This

only applies to early production RigPi 1 Keyer boards.  The jumpers have been added to later

boards.

Remote Keying from a Windows Computer

Remote CW can be keyed from most Windows logging programs through a RTS or DTR keying

input to RigPi Hub, or through WinKeyer compatibility.  RigPi Hub 2+ is a Windows Virtual

Port program that can control RigPi from up to 4 Windows programs.  It is available for free

from the RigPi web site:  https://rigpi.net

https://rigpi.net
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Morse Keyer is a Windows programs that can connect to RigPi Hub.  Using Morse Keyer you

can send CW through RigPi Hub to a radio using a straight key, paddle, bug or even mouse

buttons.  A sidetone is provided in RigPi Hub.  Select a free port in RigPi Hub, open it, then

connect Morse Keyer to that port.

You can use a decommissioned mouse to connect to a physical key using Morse Keyer.  It is

possible to connect two mice to a computer although they control the same mouse pointer. 

The downside to this approach is that you must move the mouse pointer over the "keypad" on

the Morse Keyer window to send  using a key using the re-purposed mouse.  Select a free port

in RigPi Hub, open it, then connect Morse Keyer to that port.

Using two USB-to-serial adapter cables you can key Morse Keyer through a USB port and

thence key RigPi Hub.  See the Morse Keyer web Help page for details on connecting your key

to Morse Keyer using a USB/serial connection.

https://morse-rss-news.sourceforge.net/

RigPi Hub can use a physical serial port in addition to virtual ports.  Jumper the keying output

from Morse Keyer (pin 4 on a DB-9 connector) to the CTS input on the second cable.  See RigPi

Hub Help for details.

Using remote CW with RigPi Hub

RigPi Hub 2+ can be used with RigPi to send CW from a Windows program through a virtual

port.  Two ways to send CW are provided with RigPi Hub: element based (key-down and key

up times for each element are sent); character based (ASCII characters are sent to RigPi where

they are converted to CW).  

Element based keying

Element based keying requires a second port (in addition to a radio control port) for keying

purposes.   Note there is a delay keying the radio.  This delay allows the key-down lengths to

be faithfully produced for each character.  RigPi Hub uses adaptive timing to watch for word

spaces.  When a word space is recognized, RigPi Hub sends the keying data to RigPi for that

character. 

The default port for element based keying in 30040 (for account 1, use 30041 for account 2,

and so on).  You must use a RigPi Keyer board at the radio end, set up for Radio Keyer in

SETTINGS->Keyer->Keyer Fn.  Open port 30040 for UDP in your router when operating away

from home.

In addition to a manual keyer or logging program, here are additional ways you can key using

RigPi Hub:

https://morse-rss-news.sourceforge.net/
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· Click the Key button on RigPi Hub with your mouse

· Press the "=" key on your keyboard (upper right on the keyboard)

· Press the "`" key on your keyboard (upper left on the keyboard)

Configure your program to use DTR or CTS for transmitting CW.  Assign a RigPi Hub virtual

port to the CW keying function of the external program.

The following programs have been tested using element based CW:

CommCat (discontinued)

Ham Radio Deluxe/Digital Master

N1MM

DXLog

Morse Keyer

RigPi Hub can connect to a physical port for keying from an external device such as an

electronic keyer, straight key or bug.  Select the serial port you want to use in the CW group

and click Connect.

You can use a USB-to-serial adapter to gain access to the RTS, DTR and CTS control lines.  

The CWMorse MY-KEY-SERIAL2 USB to key interface contains the interface circuits to transmit and

key Morse code.

KC9ON Order Link

Because of its width, use a short extension cable so other USB ports won't be blocked.  Here is

one I use:

https://kc9on.com/product/my-key-serial2/
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Amazon link

Here is another adapter I have tested. It works well by grounding the CTS line using an

external key.

Amazon link

Character based keying

Character based keying does not require a separate port, it uses the standard RigPi Hub CAT

port 30001.  Port 3001 assumes you are using RigPi Account 1.  Use port 30002 for account 2

and so on.

Send CW from one of several popular logging programs.  The program must support

Winkeyer-compatible keying.  Set up a RigPi virtual port for this purpose at 1200 Baud. 

Connect to this port from the Winkeyer interface in the program you are using.

The following programs have been tested using character based CW:

CommCat (discontinued)

Ham Radio Deluxe/Digital Master

N1MM

https://www.amazon.com/dp/B00CJG2ZYM?ref=ppx_yo2ov_dt_b_product_details&th=1
https://www.amazon.com/gp/product/B07TXVRQ7V/ref=ppx_yo_dt_b_asin_title_o01_s00?ie=UTF8&psc=1


223

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

WK3 Demo by K1EL

Ham Radio Deluxe (character mode)

Confirm that CW is working in RigPi.  No special RigPi settings are required to use character

mode remote CW.  

Start RigPi Hub and set up one virtual port for radio control at 38400 Baud and a second

virtual port for CW at 1200 Baud.  

Start Ham Radio Deluxe using a Kenwood TS-2000 radio selection. Start DM780.

In DM780 Modes, select CW (WinKey). 

In Winkey->Keyer settings, select the port you configured for 1200 Baud.  Click Connect.

In DM780->Winkeyer->Speeds, remove the check in Track Changes, if there. 

In DM780->Winkeyer->Keyer, click Test.  The RigPi Keyer should send TEST DE DM.  Close

Winkeyer settings.

Use the CW functions in DM780 as you normally would.  There is no sidetone when operating

in this way.  You can turn on your radio's sidetone and hear it through Mumble. The RigPi CW

indicator in the lower right hand corner of the RigPi Hub window shows when CW is being

sent. 

N1MM (character mode)

Confirm that CW is working in RigPi.  No special RigPi settings are required to use character

mode remote CW.  

Start RigPi Hub and set up one virtual port for radio control at 38400 Baud and a second

virtual port for CW at 1200 Baud.  

Start N1MM using a Kenwood TS-2000 radio selection.

In Config->Configure Ports, set up a separate port for WinKeyer.  Put a check in the WinKey

box.

In Config->Winkey, select Ignore Winkey Speed Pot.

In Winkey->Keyer settings, select the port you configured for 1200 Baud.  Click Connect..
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Use the CW functions in N1MM as you normally would.  There is no sidetone when operating

in this way.  You can turn on your radio's sidetone and hear it through Mumble. The RigPi CW

indicator in the lower right hand corner of the RigPi Hub window shows when CW is being

sent. 

K1EL WK3 Demo (character mode)

Confirm that CW is working in RigPi.  No special RigPi settings are required to use character

mode remote CW.  

Start RigPi Hub and set up a virtual port for CW at 1200 Baud.  

Start WK3 Demo..

In Setup->Com Port Settings, select the virtual port you set up for 1200 Baud.  Click Done.

Click the Open button to initialize the keyer.

Use the CW functions in WK3 Demo as you normally would.  There is no sidetone when

operating in this way.  You can turn on your radio's sidetone and hear it through Mumble. The

RigPi CW indicator in the lower right hand corner of the RigPi Hub window shows when CW is

being sent. 

CommCat (character mode)

(Note: CommCat has been discontinued.)

Confirm that CW is working in RigPi.  No special RigPi settings are required to use character

mode remote CW.  

Start RigPi Hub and set up one virtual port for radio control at 38400 Baud and a second

virtual port for CW at 1200 Baud.  

Start CommCat using a Kenwood TS-2000 radio selection.

In File->Settings->Radio/Ant->CW, select Winkeyer and the port you set up for 1200 Baud.

Use the CW functions in CommCat as you normally would.  There is no sidetone when

operating in this way.  You can turn on your radio's sidetone and hear it through Mumble. The

RigPi CW indicator in the lower right hand corner of the RigPi Hub window shows when CW is

being sent. 

Using the Radio Sidetone with Remote CW
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Many radios provide a sidetone while sending CW.  It may be possible to send the sidetone

from the radio to the remote Mumble.  For example, the Icom IC-7300 provides this capability.

 To enable sidetone through the audio CODEC, go to MENU->SET->Connectors->ACC/USB

AF Beep/Speech... Output and set the option to ON.  You will want to set the option to OFF for

speech operation.  For other radios, check your manual and menu settings to see if this is

possible.

Examples

Connect Remote RigPi (rigpi4.local) Keyer to Radio RigPi (radio4.local) Keyer, local

network, character keying.

If you are using the Remote RigPi on the same LAN as the Radio RigPi, to prevent conflicts

change the Hostname for the Remote RigPi to something else such as remote.local.  Do this by

using the RaspBerry Pi desktop and opening Terminal.  In Terminal type sudo raspi-config.  Go

to System Options->Hostname and follow the instructions.

Remote RigPi (account 1) (note you can use any accounts you wish by adjusting the Rad Port

numbers): 

Advanced Settings:

Keyer RigPi Keyer

Keyer Port /dev/ttyS0

Keyer Settings:

Keyer Fn Remote Keyer

Rad Port 30003 port for third account (30003)

Radio IP 172.16.0.62 Radio4.local Radio IP

Radio RigPi (account 3)

Advanced Settings:

Keyer RigPi Keyer

Keyer Port /dev/ttyS0

Keyer Settings:

Keyer Fn Radio Keyer

Rad Port 30003

Connect USB CTS device, local network, element keying.

Radio RigPi (account 1): 
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Advanced Settings:

Keyer Externl CTS

Keyer Port /dev/serial/by-id/usb_USB_Serial-if00-port0 USB device

Keyer Settings:

Paddle Md Vibrobug

Keyer Fn Radio Keyer

Rad Port Empty (Ignore)

Remote RigPi 

Advanced Settings:

Keyer N/A No remote

Keyer Port N/A No remote

Keyer Settings:

Keyer Fn N/A No remote

Rad Port N/A No remote

Connect two RigPi's, local network, element keying.

Remote RigPi (account 1)

Advanced Settings:

Keyer RigPi Keyer

Keyer Port /dev/ttyS0

Keyer Settings:

Paddle Md Vibrobug

Keyer Fn Remote Keyer

Rad Port 30040 (acct 1) 30041 (acct2) ...

Radio RigPi (account 1): 

Advanced Settings:

Keyer RigPi Keyer

Keyer Port /dev/ttyS0

Keyer Settings:

Paddle Md Vibrobug

Keyer Fn Radio Keyer

Rad Port 30040 (acct 1) 30041 (acct2) ...
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6.13 Schematics

Schematics and additional information for the K1EL Winkeyer 2 are here .

Schematics for the MFJ RigPi Audio and RigPi Keyer boards can be downloaded through the

following link:

MFJ RigPi Schematics

RigPi Audio Circuit Description

The MFJ RigPi Audio board is based on the Cirrus Logic WM8731 (U1) low power stereo

Codec.  It supports a stereo input and mono output.  The left input and output channels are

transformer isolated for hum reduction.  Both stereo input channels are available for I/Q signal

processing.  This input path is not transformer isolated.

The WM8731 is controlled through the Raspberry Pi GPIO connector.

GPIO 1 (Pin  12) BCLK: Digital Au00io Bit Clock, Pull Down,

GPIO 19 (Pin 35) LRC: DAC Sample Rate Left/Right Clock

GPIO 20 (Pin 38) ADCDAT: Digital data out

GPIO  21 (Pin 40) DACDAT: Digital data in

SDA (Pin 3) SDIN: 3-Wire MPU Data Input / 2-Wire MPU Data Input

SCL (pin 5) SCLK: 3-Wire MPU Clock Input / 2-Wire MPU Clock Input

The WM8731 can convert input data with up to a 96kb sample rate.

Additional GPIO pins used for RigPi Audio:

GPIO 17 (Pin 11): PTT

Connectors:

J1: Raspberry Pi GPIO connector

J2: 3.5 mm jack for I/Q  input (stereo, unisolated)

J3: 3.5 mm jack for left channel audio input (tip, transformer isolated)

J4: 3.5 mm jack for audio (tip), PTT (ring), and KX3 (ring) power on signal

J5: Connector to route audio to the RigPi jumper board

 

52

https://rigpi.net/downloads/RigPi_Schematics.pdf
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Jumpers:

JP2: Audio In selection (1-2 for stereo -no transformer isolation-, 2-3 for left mono -

transformer isolated- input)

RigPi Keyer Circuit Description

The K1EL WinKeyer3 CW Keyer IC provides all of the programming for its many features.  The

keyer is controlled through the internal serial port on the Raspberry Pi, ttyS0.

RXD (Pin 8): Receive data (from keyer)

TXD (Pin 10): Transmit data (to keyer)

Connectors:

J201: Raspberry Pi GPIO connector

J202: 3.5 mm jack, PTT out (tip is PTT, ring is 5V pull-up)

J203: 3.5 mm jack, Paddle input (tip is DOT, ring is DASH)

J204: 3.5 mm keying output (tip keys, ring not used)

J205: speaker connection

J206: PB-NET (allows external switches to play back internal memory, not used)

J207: Programming connector, not used

Jumpers:

JP201: PTT enable (1-2 enables GPIO PTT, otherwise, GPIO PTT not used)

GPIO pins used for RigPi Keyer:

GPIO 9 (Pin 21): Data to radio keyer (only used at remote end)

GPIO 10 (Pin 19): Data from remote keyer (only used at radio end)

GPIO 17 (Pin 11): PTT

RXD (Pin 8): Receive data from keyer chip

TXD: (Pin 10): Transmit data to keyer chip
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6.14 Sharing Radios, Rotors and Keyers

Radio

RSS allows multiple radios to be connected, controlled and shared. Each radio is connected

through a unique USB port on the Raspberry Pi. One rig can be assigned to each account.

Another account can share the same radio, but the connection is slightly different.  One RigPi

can be linked  to another RigPi.

There are two ways to share a radio in use in another account.

1. Open a new browser window and sign in using the radio-controlling account's username

and password. The keyer and rotor assigned to the main account are available in newly

opened browsers connected to the same account.  See Account 3, above. 

Note there are two connections, long and short, listed for each radio in R Port.  The long

form is best since it does not change when you reboot.  You can't use the long form and

short form at the same time for different accounts or programs or they will conflict.

2. Instead of a physical radio and USB port as with option 1, above, (ttyUSBn), in

Settings>Basic or Advanced Radio for the second account, select Hamlib and Net rigctl as

the manufacturer and radio. In R Port, select the port number for the account's Radio you

want to use. Port numbers start with 4532 for Radio 1, and go up 2 for each Radio number.

Radio 2 will be 4534, etc. So if account 2 wants to use the radio already connected in

account 1, select 4534 from the port number list. You can also see the rigctl port to use in

SETTINGS>System>Rigctl Port for the account connected to the physical radio. When you

select Net rigctl, the R Port list shows the valid ports for all connected radios.

60
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The radio in Account 1 must be turned on and connected.  See figure above. Account 2 taps

into the control data stream used for Account 1.  Account 2 can control the radio, but it

can't turn the Account 1 radio on or off.  You can add additional accounts for other users so

each user has his/her own settings and log in credentials.. 

Use option 2, above, if you wish to use Hamlib in another program, and connect RSS to the

same radio. Fldigi and WSJT-X, provided with RSS, can be the primary rig control program.

Once Fldigi/WSJT-X are running and in control of the radio, connect RSS to Hamlib Net rigctl

with the same port, usually 4532, used by the other program.

You can do it the other way around with RSS being the radio-controlling program. Set up

Fldigi or WSJT-X so they follow RSS by using Hamlib Net rigctl in the other program with the

port number as above.

Rotors

Each account has a unique rotor. If you have more than one rotor but only one radio, you can

set up a second account using Option 2, above, and assign the second rotor to that account.

Rotors use a port one above the radio port. If the radio port is 4532, the rotor port is 4533.

Keyers

RSS supports the internal RigPi Keyer, keying through radio CAT commands, and external K1EL

WinKeyers.

Only one account can use RigPi Keyer. If you log into that account with a second or third

browser (option 1, above), the assigned keyer will do fine. If you have an account for a second

or third radio, use CW keying via CAT, or use an external WinKeyer connected through a USB

port.

CAT CW Keying does not echo characters back to RSS so the Transmitted CW box in the Keyer

window will remain blank. Not all prosign CW characters are accepted by CAT Keying.

6.15 Supported Radio Features

Hamlib supports over 200 radios. Not all controllable features are supported. Custom macros

can be created using Hamlib commands, but only if that particular feature is supported. You

can also use the special "w" Hamlib command in a macro to send native commands directly to

a radio, but even this approach may not be supported for a particular command.
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Go to RigPi SETTINGS>Radio>Advanced and use the Radio Capabilities button to show a list

of all features for the selected radio supported by Hamlib.
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The Hamlib library is in a constant state of improvement and enhancement. New radios are

frequently added. Here is a link to the Hamlib forum where these developments are discussed:

Hamlib Forum

6.16 System

Swap Space

Swap space is memory used when the system runs out of RAM.  Usually the Linux Swap Space

is not used in RSS. Many programs requiring compiling (such as Fldigi) require at least a 512

MB swap space. Using swap space when not necessary can reduce the life of an SD card. See

this link for further details on managing Swap Space:

Swap info

Backing up and Upgrading the RigPi Memory Card

The Micro SD memory card for the Raspberry Pi has a limited lifetime.  Write cycles are usually

more critical in determining the life of an memory card because the space to be taken by a

write must be cleared first. 'Wear leveling' is used to distribute write cycles so one portion of

the memory space is not used constantly. It is suggested that you use a memory card having

at least two times the space needed to leave room for wear leveling.

  

To provide insurance against a corrupted memory card, it is wise to back it up to a second

card, a USB memory stick, or as an image to a fixed drive. The simplest way to back up the SD

Card is by using the SD Card Copier program available through the Accessories menu on the

RSS Desktop.

The SD Card can be backed up to a USB memory stick or to another SD Card.  The latter

requires a spare card and SD Card USB adapter. Plug the USB stick or adapter into a spare USB

connector on RSS.

Select the Raspberry icon to open the Applications Menu.  Select Accessories, then SD Card

Copier.  Follow the instructions given in SD Card Copier Help.

Minimum microSD Card specifications:

Type: Micro SD

Size: 32GB (or larger)

Class: 10

https://sourceforge.net/p/hamlib/mailman/hamlib-developer/
http://www.kalitut.com/2017/11/raspberry-pi-swapping.html


233

RigPi Station Server Version 4 
 
                                                                                                                                                                                   © 2025 Howard Nurse, W6HN

Technical

Speed: 80MB/s or faster

RigPi makes intensive use of the memory card.  Cards designed for video applications are able

to handle large amount of data with continuous recording.  Manufacturers claim up 43,800

hours (5 years) endurance.  The Samsung PRO Endurance 32 GB card is one recommended

upgrade for RigPi.

Optimal microSD Card specifications:

Type: microSDXC

Size: 32 GB (or larger)

Class: --

Speed: 100/30 MB/s

External SSD (Solid State Drive)

RigPi performance can be significantly improved by using an external SSD rather than a

memory card.  Users report up to 3-4 times improvement using this option.  Here is an article

on the QSO Shack web site that describes how to install and use an SSD with RigPi:

https://www.qsoshack.com/upgrade-the-mfj1234-rigpi-with-an-ssd-and-pi4/

Providing more space on the Memory Card

Here are some suggestions for increasing the free space on your memory card.

§ Make sure all of your memory card is being used.  This is especially important if you are

moving to a larger memory card.

1. Open Terminal from the Raspberry Pi desktop

2. sudo raspi-config

3. Select the Advanced option

4. Expand memory space

§ Transfer RigPi to a larger microSD card.  See the previous section, Backing Up and

Upgrading the RigPi Memory Card.  Be sure to expand the memory space as described

above.

§ Logs are rotated and deleted by the Logrotate utility.  Logrotate is configured in the

file /etc/logrotate.conf.

Updating the Raspberry Pi Operating System

https://www.qsoshack.com/upgrade-the-mfj1234-rigpi-with-an-ssd-and-pi4/
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Updates to the Raspbian operating system occur often.  To keep current, RigPi has an

automatic update feature that updates your system in the background once per week.  You

can also update manually using these commands in Terminal:

Update system package list cache:  sudo apt update

Upgrade software: sudo apt full-upgrade

Reboot RSS to apply the changes: sudo reboot

6.17 Troubleshooting

Radio won't connect

When you try to connect a radio by using the Connect Radio button and the connection fails,

take a close look at the error message to get clues. The normal failure is "Connection Refused"

with a suggestion to check settings.

First verify that the radio is on and the USB cable associated with that radio is plugged in to

RSS. Check the Port option in SETTINGS>Radio to make sure the radio com port is in the drop-

down list.

Try rebooting RSS from SETTINGS>System>Reboot RigPi to see if that fixes it.

The Connect Radio and Disconnect Radio buttons on the Tuner window require the radio to be

set up in SETTINGS>Radio first. If it hasn't been set up, RSS won't be able to connect. (RigPi is

initially configured with a "dummy" radio simulation so you can use Connect Radio with no

further setting changes required.)

If you have more than one USB device connected to RSS (several radios, rotor controls or an

external WinKeyer), the port assigned to each cable can change when you reboot. What

was /dev/ttyUSB0 connected to radio A may now be connected to radio B, and radio A

is /dev/ttyUSB1 after a reboot. In SETTINGS>Radio>Port it is best to use the long port name

form each device.  The long port names do not change after a reboot.

Next try starting the rig connection manually. This requires the use of the Raspberry Pi Desktop

Terminal. The manual connection uses the Hamlib model number for your radio. In

SETTINGS>Advanced Radio click the Radio Capabilities button. 
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At the top you will see 'Caps dump for model: xxx,' where xxx is the model number. Make note

of this number.

To clear any radio control remnants, reboot RSS from the System Settings window.

Open Terminal by double-clicking the black prompt icon in the Raspberry Pi Task Bar and type

the following (3073 happens to be the model number for the Icom IC-7300):

rigctl -m 3073 -r /dev/ttyUSB0

This command assumes you have made no changes to the default settings in the radio.  If you

have changed Baud rate to 115,200, use this command:

rigctl -m 373 -r /dev/ttyUSB0 -s 115200

The resultant report should give more clues, which might simply be "Timed out." More

diagnostic information can be obtained by using the "v" parameter such as below:

rigctl -m 214 -r /dev/ttyUSB0 -vvvvv
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 If nothing is learned, we need to check that the port is correct. Get a list of available ports by

typing (lower-case L):

ls /dev/ttyU*

If more than one USB port is listed, try the rigctl commands with the other ports.

Once you are able to get rigctl started, a prompt "Rig command:" is shown. Type f followed by

Enter and see if the reported frequency is correct. Type Ctrl+C to exit and stop the rigctl

process.

If you are able to connect to and control the radio, we can start the RigPi using a test mode

with the Test Radio button in Advanced Radio Settings. 

Near the top you will see a line that reads "$tUser=$argv[1];" which we need to modify. Use

the cursor arrow keys to move the insertion point to the front of $argv, then enter the

characters 1;//.

Slightly further down, after "}else{," you need to change the variable $tUsername='admin'; so

that is shows your username.

Type Ctrl+O to save the file and Ctrl+X to exit Nano.

Start hamlibDo by typing this line:

php hamlibDo.php

See if there are any error reported. If there don't appear to be any errors, open a RigPi browser

and see if you can control the radio.

The report shown in Terminal includes the command to start rigctld. Try entering the complete

line in Terminal and press Enter. See if there are any error reported.

If none of these steps gets the radio connected, it is time to check the USB cable and radio for

problems. This can be done running a control program on another computer by moving the

USB cable to that computer.

For a helpful guide providing additional information, here is a link to the Hamlib FAQ:

Hamlib FAQ

Frequency Display Flickers

https://github.com/Hamlib/Hamlib/wiki/FAQ
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The RigPi frequency readouts may flicker if radio control drops out intermittently.  If using an

Icom radio, put a check in Disable Split Polling in SETTINGS->Advanced Radio Settings. 

Restart the radio connection.

If your radio does not support CAT setting and reading of AF Gain, RF Gain, Power, or Mic

Level, go to SETTINGS->Slider Overrides.  Set the level for each slider to 0 to disable and hide

that function on the Tuner and Keyer windows..

Radio Control Logging

The Test Radio function in Advanced Radio settings also starts a log for recording radio status

and commands.  You will find this log in /var/log/rigpi-radio.log.  It is cleared each time you

use the Test Radio function so only the most recent session is kept.   You can use the edit

program nano from the Raspberry Pi terminal to view the log.

sudo nano /var/log/rigpi-radio.log

Rotor Control Logging

The Test Radio function in Advanced Radio settings also starts a log for recording rotor status

and commands.  You will find this log in /var/log/rigpi-rotor.log.  It is cleared each time you

use the Test Radio function so only the most recent session is kept.   You can use the edit

program nano from the Raspberry Pi terminal to view the log.

sudo nano /var/log/rigpi-rotor.log

User Access Logging

A log of all users accessing RigPi can be found here:

sudo nano /var/log/rigpi-access.log

RigPi Audio Issues

No Audio

RigPi uses the optional MFJ RigPi Audio board for VoIP, digital modes, or even for a spectrum

analyzer (panadapter). If RigPi Audio doesn't appear to be working, a number of tests can be

use to isolate the problem.

RigPi Audio can receive/send audio through the RJ-45 connector on the USB end of the RigPi

unit or from the 3.5 mm jack end. We will use the 3.5 mm jack end. If using the RJ-45

connection, remove that cable for now.
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RigPi Audio uses a Linux device driver named snd_rpi_proto. All drivers and settings required

for RigPi Audio are initially set and do not require changes.

Right-click the Speaker icon at the top of RSS Desktop to make sure snd_rpi_proto is shown as

the selected device. If it isn't in the list, try rebooting RSS from the RigPi SETTINGS>System

menu. If it fails to appear, the RigPi Audio board may have a problem.

To look for errors on booting, open RSS Terminal and type the following:

dmesg | grep audio

You will see a list of possible errors. The last line should say 

[  4.xxxxx] snd-rpi-proto soc:sound: wm8731-hifi <-> 3f203000.i2s mapping ok

which says the board is connected. If not, the RigPi Audio board probably needs repair.

Next we will try some audio tests using Linux programs through RSS Terminal.

Plug in a high impedance set of ear buds to the TX OUT connector. Type the following

command (c2 says 2 channels):

speaker-test -c2

You should hear pink noise in the left ear bud, then silence, followed by pink noise.

Here is a tone test:

speaker-test -t sine -f 2000 -c2

You will hear a 2000 Hz tone in the left ear bud.

Finally, a voice test:

speaker-test -t wave -c2

You will hear a woman's voice in the left ear bud.

If any of these test fail, we can use the Linux program named Alsamixer from RSS Terminal to

check the settings. Type

alsamixer
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The following settings are used for RigPi Audio:

Master Gain 86<>86 (adjust to suit)

Master Playback OFF (MM)

Sidetone (not radio

sidetone)

0

Mic Boost 0

Playback De emphasis OFF (MM)

ADC High Pass Filter ON (OO)

Input Mux Line In

Output Mixer HiFi ON (OO)
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Line L R Capture

Mic Boost 0

Capture 18<>18 (adjust to suit)

Can't connect to Mumble server

Mumble server starts automatically when RigPi boots. First we can make sure Mumble server is

actually running, then we'll check the Mumble log.

To confirm the Mumble is running:

In Terminal, type: 

ps -ef | grep mumble-server

The command should show:

mumble-+  582   1 0 12:22 ?    00:00:00 /usr/sbin/murmurd -ini /etc/mumble-server.ini

The results confirm that the murmur (mumble server) daemon is running, using the mumble-

server.ini initialization file.

To make sure we can connect to the default Mumble port, type: 

nc -vz rigpi4.local 64738
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You should see this response:

Connection to rigp4.local 64738 port [tcp/*] succeeded!

If these tests are successful, we can check the Mumble server log. Type:

sudo cat /var/log/mumble-server.log

Here is the response:

...

<W>2019-01-23 12:22:25.792 Initializing settings from /etc/mumble-server.ini (basepath /etc)

<W>2019-01-23 12:22:25.815 Meta: TLS cipher preference is "ECDHE-ECDSA-AES256-GCM-

SHA384:ECDHE-RSA-AES256-GCM-SHA384:ECDHE-ECDSA-AES128-GCM-SHA256:ECDHE-

RSA-AES128-GCM-SHA256:AES256-SHA:AES128-SHA"

<W>2019-01-23 12:22:25.815 OpenSSL: OpenSSL 1.1.0j 20 Nov 2018

<C>2019-01-23 12:22:25.850 Successfully switched to uid 116

<W>2019-01-23 12:22:28.784 ServerDB: Opened SQLite database /var/lib/mumble-

server/mumble-server.sqlite

<W>2019-01-23 12:22:28.814 Resource limits were 0 0

<W>2019-01-23 12:22:28.814 Successfully dropped capabilities

<W>2019-01-23 12:22:33.835 OSInfo: Failed to execute lsb_release

<W>2019-01-23 12:22:37.123 Murmur 1.2.18 (1.2.18-1) running on X11: Linux 4.14.79-v7+:

Booting servers

<W>2019-01-23 12:22:45.343 1 => Server listening on [::]:64738

<W>2019-01-23 12:23:32.814 1 => Announcing server via bonjour

<W>2019-01-23 12:23:33.002 1 => Registration needs nonempty 'registername',

'registerpassword' and 'registerurl', must have an empty 'password' and allowed pings.

<W>2019-01-23 12:23:33.003 Object::connect: No such slot

MurmurDBus::userTextMessage(const User *, const TextMessage &)

If connection attempts have been made they are included at the end of the log. Check these

lines for an indication of why the connection was not made.

If you see "Connection refused" in the Mumble status column, try logging in with a different

user name.  User names must be unique.  You can't use names like W6HN two times, but you

can use W6HN and W6HN-1 to make them unique.

Mumble gives access to more settings through an account named SuperUser. Try logging in

using that username with password 7388.
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Finally, visit the Mumble Help pages to additional help. Here is a link to the instructions for

logging into a Mumble server:

Mumble Help

RigPi Audio Input Level Too Low

RigPi audio can be high level line-input of up to 2-volts peak-to-peak, or low level microphone

input (200-mV peak-to-peak). In addition, the input levels can be adjusted. These settings are

done through Alsamixer. See the Alsamixer topic in Other Programs.

Audio Feedback when Transmitting

A second audio path can cause transmit feedback.  Turn off the Mon function in your radio. 

There may be a hidden menu item for Line Out Mon or USB Audio Mon, depending on your

radio.  Make sure your Mic isn't picking up audio.  Turn the Mic Gain on your radio to 0.  Menu

settings can also be used to mute the microphone.

Remote RigPi Won't Connect to Radio RigPi

If a remote RigPi fails to connect to the radio RigPi, here are some things to try.

In remote RigPi, check the R Port and Keyer Port in Advanced Settings.  You should see the

<ip>:<port> for the radio RigPi.  The remote radio should be your physical radio, such as Icom

7300.  The Keyer should be via CAT.

If operating from a remote location, use the WAN IP for the network the radio RigPi is using. 

Open port 453x in your home Router.  The port to open will depend on which account you are

trying to connect to.  For account 1, use 4532.  If it is account 2, <port> will be 4534.

Use Terminal in the remote RigPi Desktop and attempt to connect from there using the

command:

rigtcl -m 2 -r <IP>:<port>

Once connected you will see a Command prompt. Enter f (to get frequency) followed by the

Enter key.

If that fails, try through Terminal on the radio RigPi.

These steps should give you an indication of where the problem lies.

https://www.mumble.com/support/how-to-connect-to-a-mumble-server.php
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